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Foreword 
 
This Application and Installation Guide describes the EMCP 3.1, 3.2, and 3.3 series electrical 
power generator set controls. 
 
Some data used in this guide is generalized and is provided only for the purpose of comparison 
or illustration.  Also, PC application screenshots and EMCP 3 GSC screen images may be 
actual screens or simulated and are shown for illustrative purposes only. These images may not 
be identical to those seen by the user.  Screen images of the EMCP 3 GSC may differ from the 
actual screens depending on flash file language, setpoint configuration, or series of the GSC 
(3.1 versus 3.2 versus 3.3). 
 
In various places throughout this document, reference is made to the release date of the EMCP 
3 software.  This information can be found by connecting to the subject module using the 
Caterpillar® Service Tool, and viewing the ECM Summary (this is the default startup screen).  
The release date is found in the field entitled Software Group Release Date.  See the sample 
screenshot below, showing the release date for a Thermocouple module. 
 

 
 
 
 
Other product specific information and data is available from a variety of sources. For more 
information contact to the Caterpillar dealer or dealer TC nearest you. 
 

To visit the Cat® Electronics website: www.catelectronics.com 
 
The information in this document is the property of Caterpillar Inc. and/or its subsidiaries. Any 
copying, distribution, transmission to others, and any use except that for which it is loaned is 
prohibited without written permission.  
 
CAT®, CATERPILLAR®, ADEM™A4, their respective logos, “Caterpillar Yellow” and the 
POWER EDGE trade dress, as well as corporate and product identity used herein, are 
trademarks of Caterpillar and may not be used without permission. 
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1 GENERAL INFORMATION 

1.1 COMPANION MEDIA NUMBER 
This document has media number, LEBE5255.  
It also has a companion media number, 
LERE5255.  If only one of the media numbers 
is ordered, the other is shipped automatically, 
but separately. LERE5255 is a mini-CD that 
contains printable files of schematics found in 
this document on pages 112,13,14 1, APPENDIX 
H (page 250).  

1.2 INTRODUCTION 
Caterpillar® has developed a product line of Generator Set Controls for use in the Electronic 
Modular Control Panel 3 (EMCP 3). They are available in three versions based on Generator 
Set Control feature sets.   

The EMCP 3 Generator Set Control, or GSC, is the primary controller within the Generator Set 
Control system. It contains the primary operator and service interface. The inset photo shows an 
up-close view of the EMCP 3.3. The EMCP 3 line of Generator Set Controllers includes EMCP 
3.1, 3.2, and 3.3.  APPENDIX I shows a full view of the EMCP 3.3.  

This Application and Installation Guide is intended to cover the EMCP 3 Generator Set Control 
and its application in generator set systems.  The intended audience for this guide includes 
Caterpillar generator set system designers, Caterpillar service support personnel, Caterpillar 
Dealers and Service Technicians, contractors, and customers. 

1.3 APPLICATIONS 
The EMCP 3 GSC product line of generator set controllers is designed for use in a wide range 
of applications.  They can be used on standby and prime power diesel generator sets including 
Caterpillar®, FG Wilson®, and Olympian® brands.  The configurability of the controllers allows 
them to be used, in some cases, on other applications such as Marine auxiliary generators, 
switchgear applications, industrial engines and generator sets, and gas generator sets. 

Most of the information in this document applies to all applications. However, the document was 
written with Caterpillar brand diesel generator sets in mind. Please contact your Caterpillar 
support representative for questions regarding different applications. 

1.4 REFERENCES 
The following list of literature is available for EMCP 3 Generator Sets. 

RENR7902 EMCP 3 Systems Operation Troubleshooting Testing and Adjusting 
SEBU7898 C18 Generator Set Operation and Maintenance Manual 
SEBU7509 3500 Generator Sets Operation and Maintenance Manual 
SEBU7508 3500B Generator Sets Operation and Maintenance Manual 
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 2 SAFETY Information 

2 SAFETY INFORMATION 

2.1 ELECTRICAL SAFETY 

DO NOT operate or work on a generator set unless you 
have read and understand the instructions and warnings in 
the Operation and Maintenance Manual.  Failure to follow 
the instructions or heed the warnings could result in injury or 
death.  Contact any Caterpillar dealer for replacement 
manuals.  Proper care is your responsibility. 

 
 

 

2.2 ELECTROSTATIC DISCHARGE AWARENESS 
EMCP 3 GSC control contains components that are sensitive 
to ELECTROSTATIC DISCHARGE (ESD). An electrostatic charge 
can damage the control resulting in EMCP 3 GSC breakdown 
or improper operation. 

Take the following precautions while installing/removing/handling the control: 

• Handle equipment correctly. Use ESD protective packaging and material 
handling containers that are anti-static and provide discharge protection and 
electric field suppression. 

• Use protective devices: ESD-protective workstations and/or work surfaces 
(grounding mat, anti-static wrist strap, etc). 

• Keep all plastic items away from the devices. Any plastic item is a potential 
static generator. This includes candy wrappers, foam cups, synthetic carpet, 
foam cushions, etc. 

• The anti-static bag cannot function as a static dissipating mat.  

• DO NOT use an anti-static bag for any other purpose than to enclose a product. 

CAUTION: The 70-pin connector on the back of the control is the most vulnerable area to 
ELECTROSTATIC DISCHARGE (ESD).  While handling the EMCP 3 GSC, extra 
attention is required to the back of the control.  The control may become 
damaged or inoperable if extra care is not taken.  

 
Consult the Electrostatic Discharge Association for proper procedure during particular 
situations: http://www.esda.org 
 

http://www.esda.org/
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3 INSTALLATION 

3 INSTALLATION 

3.1 MOUNTING LOCATION  
When selecting a mounting location for the EMCP 3 GSC, consider the following:  

• Protection from high-voltage and high-current devices. 

• Protection from devices which may produce electromagnetic interference. 

• Protection from excessive vibration.  The controls are designed to withstand 
normal generator set vibrations.  The controls should not be mounted directly to 
the engine block. 

• Protection from direct exposure to water.  Once installed, the EMCP 3.1, 3.2, 
and 3.3 are sealed to a level of IP Level 22 for resistance to moisture. 

3.2 OPERATING TEMPERATURE RANGE 
EMCP 3 GSC has a continuous operating temperature range of  –20°C to +70 °C 
ambient. 

3.3 POWER REQUIREMENTS 
The EMCP 3 GSC requires a nominal voltage of 12 V  DC or 24 V DC.  If batteries are used for 
operating power, a charging source such as an alternator or dual-mode battery charger is 
necessary to maintain a stable supply voltage.  Under steady state operation, the EMCP 3 GSC 
will draw approximately 0.5 A to 1.5 A current draw (not including any relay loads). 

Regional electrical codes must be followed.  In the case of standby operation, follow the 
regional requirements for installing standby power systems.  An example of this is the National 
Fire Protection Association (NFPA) guidelines for emergency power systems. 

When connecting the EMCP 3 GSC to the DC power source, make sure that there is only one 
common connection to the negative potential of the power source.  Make extra effort to avoid 
any ground loops in the DC electrical system.  A single point common ground for sensitive 
electronics is recommended at the negative battery terminal or Power Distribution Box.   

Avoid daisy-chaining power supply connections from one device to another.  This builds 
resistance from one (-)Battery point to the next, effectively building a potential difference 
between two different reference points.  Each electronics subsystem and major engine 
subsystem should have its own DC network so that they do not interfere with each other (see 
FIGURE 1).   

As shown in FIGURE 1, all sensitive electronics are electrically isolated from higher current loads, 
such as the starter motor.  All electronics have a COMMON POWER BUS and SINGLE POINT 
REFERENCE.  The CHASSIS GROUND is a common POWER AND TRANSIENT GROUND. 

The sensitive electronics, such as sensors and control modules, have isolated power source 
paths.  High current loads such as starters and solenoids can cause interference and possibly 
damage to low current loads, such as controllers and sensors.   

CAUTION: Extra effort must be made to keep the high current and low current loads 
electrically separated.   
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 3 INSTALLATION 

 

 
FIGURE 1: GENERATOR SET NETWORK ISOLATION 

The two types of loads may share common Battery (+) and Battery (–) connections but, they 
should not be electrically connected at any other point. This strategy ensures maximum isolation 
between high current and low current loads.  

The battery DISCONNECT SWITCH is located on the negative leg of the battery supply.   

3.4 BATTERY CHARGER 
If a battery charger is to be used, it should be connected on the battery side of the disconnect 
switch, so as not to power the electronics.  Most battery chargers are not to be used as power 
supplies.  Proper battery charger operation requires that the actual battery load is present. 

3.5 ELECTRICAL CONNECTIONS 
The EMCP 3 GSC has one 70-pin connector on the back of the control and not all of the 70 pins 
are used.   

FIGURE 2, FIGURE 3, and FIGURE 4 show: 

• All possible connections 

• What pins are used for connections 

• How each pin is connected for each control version 
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3 INSTALLATION 

3.6 EUI ENGINES 
For EUI engines, the PASSIVE ANALOG INPUTS #1 and #2 will NOT be used.  These are for 
discrete oil pressure and coolant temperature sensors, respectively.  These sensors will be 
wired to the engine ECM and the EMCP 3 GSC will get that information from the engine ECM 
via the Primary J1939 Data Link.   

For more information about the passive inputs, see Chapter 9, ANALOG INPUTS. 

ANALOG CONNECTIONS 
The 70-pin connector wiring diagrams below, also, show two different ways to connect the 
analog inputs.   

• Connections for 2-wire sensors are shown (including all of the other 
connections).   

• Connections for 1-wire sensors are shown at the bottom right hand side of the 
figures. 

DISCRETE INPUTS 
The discrete inputs are shown connected through NORMALLY OPEN contacts to battery negative.   

These inputs can also be connected through NORMALLY CLOSED contacts to battery negative. To 
do this the ACTIVE STATE of the input will need to be set to ACTIVE HIGH.   

For information on software configuration of the digital inputs see Chapter 8,  Digital Inputs. 
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 3 INSTALLATION 

3.7 EMCP 3.1, 3.2, 3.3  ELECTRICAL DIAGRAMS 

 
FIGURE 2: EMCP 3.1  ELECTRICAL DIAGRAM 

(Refer to APPENDIX H EMCP 3 GSC  for printable image) 
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3 INSTALLATION 

 

 
FIGURE 3: EMCP 3.2  ELECTRICAL DIAGRAM  

(Refer to APPENDIX H EMCP 3 GSC  for printable image) 
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 3 INSTALLATION 

 

 
FIGURE 4: EMCP 3.3 ELECTRICAL DIAGRAM 

(Refer to APPENDIX H EMCP 3 GSC  for printable image) 
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3 INSTALLATION 

3.8 WINDING CONNECTIONS 
The connections between the generator and the EMCP 3 GSC depend on the winding 
configuration as shown in the connection diagrams below. 

 

 
FIGURE  5: THREE PHASE FOUR WIRE (SERIES OR PARALLEL) WYE (STAR) 

 
 

 
FIGURE  6: THREE PHASE FOUR WIRE DELTA 

 
 

 
FIGURE  7: THREE PHASE THREE WIRE DELTA 
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 3 INSTALLATION 

 
FIGURE  8: SINGLE PHASE THREE WIRE (DOUBLE DELTA) 

 
FIGURE  9: SINGLE PHASE TWO WIRE (DOUBLE DELTA) 

3.9 TRANSFORMER CONNECTIONS 
In order to monitor generator output voltages greater than 600 Volts, external potential 
transformers must be used. 

NOTE: The EMCP 3 GSC must be programmed for the correct winding ratios when 
connecting external potential transformers. See Chapter 7, Setpoints for 
more information on how to program the winding ratios. 

CAUTION: The WYE configuration of external potential transformers is preferred for 4-wire 
wye generators because of the greater accuracy when loads are unbalanced. 
With the open delta configuration, some power parameters can not be 
determined. These parameters are real power phase A, B, C and power factor 
phase A, B, C. For maximum accuracy, the open delta configuration of external 
potential transformers should be used only for 3-wire delta generators.  Refer to 
Table 1: Power Values Valid by Generator Configuration, page 17. 

  

FIGURE  10: WYE CONFIGURATION OF EXTERNAL POTENTIAL TRANSFORMERS  

(PT) on the 4-Wire Wye Connected Generator 
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3 INSTALLATION 

 

 
FIGURE  11: OPEN DELTA CONFIGURATION OF EXTERNAL POTENTIAL TRANSFORMERS 

(PT) on the 3-Wire Delta Connected Generator 

 

 
FIGURE  12: OPEN DELTA CONFIGURATION OF EXTERNAL POTENTIAL TRANSFORMERS  

(PT) on the 4-Wire Wye Connected Generator 

 

TABLE 1: POWER VALUES VALID BY GENERATOR CONFIGURATION 

TRANSFORMER CONNECTIONS 

Parameter Modbus 
Register STAR 3-WIRE 

DELTA 
4-WIRE 
DELTA 

2-WIRE 
1-PHASE 

3-WIRE 
1-PHASE 

Gen Freq  102 OK OK OK OK OK 
VL-L AVG  100 OK OK OK OK OK 
VA-B 108 OK OK OK OK OK 
VB-C  109 OK OK OK Invalid Invalid 
VC-A  110 OK OK OK Invalid Invalid 
VL-N AVG 148 OK Invalid OK Invalid OK 
VA  114 OK Invalid OK Invalid OK 
VB  115 OK Invalid OK Invalid OK 
VC  116 OK Invalid OK Invalid Invalid 
IAVG  101 OK OK OK OK OK 
IA  111 OK OK OK OK OK 
IB  112 OK OK OK OK OK 
IC  113 OK OK OK Invalid Invalid 
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 3 INSTALLATION 

3.10 WIRING REQUIREMENTS 
Use the tables below for wiring requirements at 50 and 300 foot lengths. 

TABLE 2: 50 FOOT REQUIREMENTS 

50 FOOT REQUIREMENTS 

Component 
Wire 
Size 

(AWG) 
Type of Wire Connections (1) 

Three-Wire Sensors 
(when applicable.  
Not used on all 
systems) 
 

16 

Shielded twisted triad cable is recommended. 
For conduits inside facilities, use Belden 
8618. For the engine harness, use the 4G-
2556 Shielded Cable. The cable must be 
resistant to fuel and oil. The cable must have 
a temperature range from -40ºC (-40ºF)  to 
plus 125ºC (257ºF). 

Two-Wire 
Components 
(Magnetic Speed 
Sensors) 
 

16 
or 
18 

Shielded twisted pair cable is recommended. 
For conduits inside facilities, use the 123-
2376 Electrical Cable or the 3E-4594 
Electrical Cable. For the engine harness, use 
the 6V-2744 Wire. The cable must be 
resistant to fuel and oil. The cable must have 
a temperature range of -40ºC (-40ºF) to plus 
125ºC (257ºF). 

Deutsch DT type 
of connectors are 
recommended. If 
Spring Spade or 
Ring Terminals are used, 
the connection 
between the terminals 
and the wire should be 
crimped and soldered. 
 

Engine Solenoids 
(Air Shutoff) 
 
Power 10 

Stranded wire normally used on engine 
harnesses. The cable must be resistant to 
fuel and oil. The cable must have a 
temperature range of -40ºC (-40ºF)  to plus 
125ºC (257ºF). 

The leads of the cable 
should have Spring 
Spade Terminals or Ring  
Terminals. The 
Connection between the 
wire and the 
terminal should be 
crimped and soldered. 

(1) The number of connections must be kept to a minimum. 
 

TABLE 3: 300 FOOT REQUIREMENTS 

300 FOOT REQUIREMENTS 

Component 
Wire 
Size 

(AWG) 
Type of Wire Connections (1) 

Three-Wire 
Sensors 
(when applicable.  
Not used on all 
systems) 

16 

Shielded twisted triad cable is recommended. 
For conduits inside facilities, use Belden 8618. 
For the engine harness, use the 4G-2556 
Shielded Cable.  The cable must be resistant 
to fuel and oil. The cable must have a 
temperature range from -40ºC (-40ºF) to plus 
125ºC (257ºF). 

Deutsch DT type 
of connectors are 
recommended. If 
Spring Spade or 
Ring Terminals are used, 
the connection 
between the terminals 
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3 INSTALLATION 

300 FOOT REQUIREMENTS 

Component 
Wire 
Size 

(AWG) 
Type of Wire Connections (1) 

Two-Wire 
Components 
(Magnetic Speed 
Sensors) 
 

16 
or 
18 

Shielded twisted pair cable is recommended. 
For conduits inside facilities, use the 123-2376 
Electrical Cable or the 3E-4594 Electrical 
Cable.  For the engine harness, use the 6V-
2744 Wire.  The cable must be resistant to fuel 
and oil.  The cable must have a temperature 
range of 
-40ºC (-40ºF) to plus 125ºC (257ºF). 

and the wire should be 
crimped and soldered. 
 

J1939 Data Link 
cable 

16  
or 
 18 

Part number 153-2707 is available for lengths 
of up to 200ft.  The cable has a temperature 
range of -40ºC (-40ºF) to plus 125ºC (257ºF).  
For longer runs, select a cable that meets SAE 
J1939-11 requirements. 

Deutsch DT type 
of connectors are 
recommended. If 
Spring Spade or 
Ring Terminals are used, 
the connection 
between the terminals 
and the wire should be 
crimped and soldered. 

Engine Solenoids 
(Air Shutoff) 

Power 
8 

Stranded wire normally used on engine 
harnesses. The cable must be resistant to fuel 
and oil.  The cable must have a temperature 
range of -40ºC (-40ºF) to plus 125ºC (257ºF). 

The leads of the cable 
should have Spring 
Spade Terminals or Ring 
Terminals. The 
Connection between the 
wire and the 
terminal should be 
crimped and soldered. 

(1) The number of connections must be kept to a minimum. 

3.11 SHIELDED WIRING 
Shielded twisted pair cable is required for the J1939 datalink and the magnetic speed sensor. 
This cable is used for maximum protection against inductive noise, electromagnetic 
interference, and radio frequency interference. The shield greatly reduces the amplitude of any 
unwanted voltages on the signal wire. If the shields are connected to sheet metal, the 
connections are susceptible to loose bolts, corrosion, etc. The faulty connections increase the 
resistance of the shield. Faulty connections also reduce the effectiveness of the shield. 

All the shields of the shielded cable must be connected to the common battery negative terminal 
of the generator set only. The shields should not be connected to the sheet metal. Sheet Metal 
connections corrode over time, increasing the resistance on the shield.  When the cable 
terminates at junction boxes, the shields must be connected to each other in order to maintain a 
continuous path.  Wire exposed beyond the shield should be as short as possible and not 
exceeding two inches.  To avoid ground loops, shields should be grounded at one point only. 

To avoid electromagnetic interference, do not run shielded signal wires near other wires 
carrying large currents.  In installations with unavoidable risk of electromagnetic interference 
(EMI), shielded wire run in conduit, extra shielding, or other precautions may be necessary. 
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4 INITIAL OPERATION AND USER ORIENTATION 

4.1 VIEWING SYSTEM PARAMETERS 
 
Many generator and engine parameters are accessible from both from the Caterpillar® Service 
Tool, and the EMCP 3 display. 

 
FROM THE CATERPILLAR® SERVICE TOOL 
Parameters are accessed by selecting Information > Status from the menu, or by clicking on the 
STATUS TOOL  icon in the toolbar.  Refer to the Caterpillar® Service Tool help from the Help 
> Contents menu for more information on the Status Tool. 

 
FROM THE EMCP 3 DISPLAY 
Parameters are accessed (irrespective of the current screen position) by pressing the AC 

OVERVIEW  or ENGINE OVERVIEW  buttons located below the screen.  Detail screens 

provide even more information by pressing the SCROLL DOWN  button from each of the 
overview screens. 

SUPPORTED PARAMETERS 
Different revisions of the EMCP 3 support different numbers of parameters. EMCP 3.3 supports 
several parameters not supported on the EMCP 3.2, which supports several parameters not 
supported on the EMCP 3.1.  Some parameters are only available in certain configurations, for 
example, electronic engine ECMs provide more engine data than what is available from 
mechanical engines.  The sections below list all of the parameters available, and on which level 
of EMCP 3 they may be available. 

Parameters are displayed with units, some of which are configurable.  For changing units or 
setting other user preferences see Chapter 4.2, Setting User Preferences. 

Parameters that are not available to the EMCP 3 are shown as  (four asterisks).  This 
may indicate an incorrect software configuration, a wiring problem, or a problem with the sensor. 

ENGINE PARAMETERS 
 

ENGINE OVERVIEW SCREEN   
• Engine Oil Pressure 
• Engine Coolant Temperature  
• Battery Voltage, as measured at the 70-pin 

connector entering the EMCP 3 GSC  
• Engine Speed 
• Engine Operating Hours 
• Engine Operating State (Initialization, Pre-Crank, Starting, Running, Pre-Cooldown, 

Cooldown, Stopping, Stopped, Idling; many states are transient and only briefly active, 
and some states may not occur in some configurations) 

ENGINE SCREEN 1 
• Engine Oil Pressure (same as in Engine Overview Screen) 
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• Engine Coolant Temperature (same as in Engine Overview Screen) 
• Engine Speed (same as in Engine Overview Screen) 

ENGINE SCREEN 2 
• Battery Voltage (same as in Engine Overview Screen) 
• Engine Operating Hours (same as in Engine Overview Screen) 
• Spare Analog Input parameter (configurable using the Spare Analog Input Suspect 

Parameter Number; for configuration, see Chapter 9.1, Spare Analog Input) 
 

ENGINE SCREEN 3   
• Engine Hours remaining until Service 

Maintenance Interval expires  
• Calendar Days remaining until Service 

Maintenance Interval expires 
 

 

(option to reset the Service Maintenance Interval countdown timer) 
 

ENGINE SCREEN 4   
• Total engine Cranks since last reset (a 

crank is defined as the number of times 
the starter motor switches on)  

• Total engine Starts since last reset (a start 
is defined as the number of times the 
engine transitions from below the Crank 
Terminate speed setpoint to above it) 

 

(option to reset the crank and start counters) 

ENGINE SCREEN 5 † 
• Cylinder #1 Temperature 

UP TO 
• Cylinder #20 Temperature 

ENGINE SCREEN 6 † 
• Left Exhaust Manifold Temperature 
• Right Exhaust Manifold Temperature 
• Intake Manifold Temperature 
• Exhaust Temperature 
• Turbocharger #1 Compressor Inlet Temperature 

UP TO 
• Turbocharger #4 Compressor Inlet Temperature 
• Turbocharger #1 Turbine Inlet Temperature 

UP TO 
• Turbocharger #4 Turbine Inlet Temperature 
• Turbocharger #1 Turbine Outlet Temperature 

UP TO 
• Turbocharger #4 Turbine Outlet Temperature 

ENGINE SCREEN 7 † 
                                                 
† Only shown if these parameters are supported by the engine ECM, and if the EMCP 3 setpoint Engine 
J1939 Support is set to Enhanced J1939. 
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• Engine Oil Temperature 
• Engine Fuel Temperature 

ENGINE SCREEN 8 † 
• Fuel Pressure 
• Crankcase Pressure 
• Boost Pressure 

ENGINE SCREEN 9 † 
• Oil Filter Differential Pressure 
• Fuel Filter Differential Pressure 

ENGINE SCREEN 10 † 
• Air Filter Differential Pressure 

ENGINE SCREEN 11 † 
• Total Fuel Consumption 
• Instantaneous Fuel Consumption 

AC PARAMETERS 
AC OVERVIEW SCREEN  

• Average Line-Line AC Voltage 
• Average Current 
• AC Frequency 
• Power Factor (EMCP 3.2-3.3 only) 

 
• Power Factor Lead/Lag status (EMCP 3.2-3.3 only) 
• Total Generator Real Power – kW – (EMCP 3.2-3.3 only) 
• Percent Real Power – as a percent of Generator Rated Power setpoint – (EMCP 3.2-

3.3 only) 

AC SCREEN 1 
• Line-Line Voltages: A-B, B-C, C-A 
• Phase Currents: A, B, C 
• AC Frequency 

AC SCREEN 2 
• Line-Neutral Voltages: A-N, B-N, C-N 
• Phase Currents: A, B, C (same as AC Screen 1) 
• AC Frequency (same as AC Screen 1) 

AC SCREEN 3 (EMCP 3.2-3.3 ONLY) 
• Per Phase Generator Real Power: A, B, C 
• Per Phase Generator Apparent Power: A, B, C 
• Per Phase Generator Reactive Power: A, B, C 

AC SCREEN 4 (EMCP 3.2-3.3 ONLY) 
• Per Phase Generator Real Power: A, B, C (same as AC Screen 3) 
• Per Phase Generator Apparent Power: A, B, C (same as AC Screen 3) 

                                                 
† Only shown if these parameters are supported by the engine ECM, and if the EMCP 3 setpoint Engine 
J1939 Support is set to Enhanced J1939. 
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• Per Phase Power Factor: A, B, C 

AC SCREEN 5 (EMCP 3.2-3.3 ONLY) 
• Total Generator Real Power (same as AC 

Overview Screen) 
• Percent Real Power (as a percent of 

Generator Rated Power setpoint) 
• Total Generator Apparent Power 

 

• Percent Apparent Power (as a percent of Generator Rated Apparent Power setpoint) 
• Total Generator Reactive Power 
• Percent Reactive Power (as a percent of the rated reactive power, as calculated by 

using the other two rated power setpoints and the power triangle: 
22 )()( kWkVAkVAr −= ) 

AC SCREEN 6 (EMCP 3.2-3.3 ONLY)  
• Generator Real Energy produced since 

last meter reset 
• Generator Reactive Energy produced 

since last meter reset 
• (option to reset energy meters) 

 

AC SCREEN 7  
• Average Line-Line AC Voltage (same as 

AC Overview Screen) 
• Average Line-Neutral AC Voltage 
• Power Factor (EMCP 3.2-3.3 only) (same 

as AC Overview Screen) 
 

• Power Factor Lead/Lag status (EMCP 3.2-3.3 only) (same as AC Overview Screen) 

AC SCREEN 8 (EMCP 3.3 ONLY) ‡ 
• Generator Front Bearing Temperature 
• Generator Rear Bearing Temperature 

AC SCREEN 9 (EMCP 3.3 ONLY) ‡ 
• Generator Phase A Winding Temperature 
• Generator Phase B Winding Temperature 
• Generator Phase C Winding Temperature 

AC SCREEN 10 (EMCP 3.3 ONLY) ‡ 
• Generator Excitation Field Voltage 
• Generator Excitation Field Current 

4.2 SETTING USER PREFERENCES 
The EMCP 3 GSC display can be used for monitoring the generator status, viewing and 
resetting events, and configuring setpoints.  There are several preferences to alter how you 
view the data on the display. These include: display contrast, units used to display pressure, 
units used to display temperature, units used to display volume (EMCP 3.3 only), and display 

                                                 
‡ Only shown on the EMCP 3.3, and only if an optional Thermocouple or RTD module is connected and 
configured for one of these parameters. 
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language (to select between the customer language and Technician English).   

NOTE: These preferences do not affect operation of the EMCP 3 or the data as 
viewed in the Caterpillar® Service Tool.  They only affect how the text and 
data is converted and displayed on the EMCP 3 GSC display. 

SETTING THE PREFERENCES USING THE EMCP 3 DISPLAY 
On the EMCP 3 display, the Preferences menu is 
located at the bottom of the Main Menu. 

 
The preferences are listed, with the current 
settings shown to the right (except language, 
whose current setting is usually obvious).  

For any preference, press ENTER KEY  to 
accept the change (or ESCAPE KEY  to reject 
the change) and return to the Preferences menu. 

 

PREFERENCES 
CONTRAST This determines the darkness of the pixels on the display.  A contrast setting 

of zero (reached by pressing and holding the down or left arrow) effectively 
blanks the screen, and a contrast setting of 100 (reached by pressing and 
holding the up or right arrow) effectively darkens the entire screen. 

PRESSURE This allows pressure parameters (such as Engine Oil Pressure) and 
setpoints (such as Low Engine Oil Pressure Event Threshold) to be shown in 
either kPa, psi, or bar.  Select the desired unit with the left or right arrows. 

TEMPERATURE This allows temperature parameters (such as Engine Coolant Temperature) 
and setpoints (such High Engine Coolant Temperature Event Threshold) to 
be shown in either Celsius (Centigrade) or degrees Fahrenheit. 

VOLUME 
 (EMCP 3.3 only) 

This allows volume parameters (such as Fuel Volume) to be shown in either 
Liters, Imperial Gallons, or US Gallons. 

LANGUAGE This allows the display to be switched between Technician English (always 
listed first) and the customer language (always listed second, and written in 
the font of the customer language).  The below example shows the language 
selection in the German language flash file. 

The LANGUAGE setting has been conveniently 
located at the bottom of the Preferences menu, 
which is at the bottom of the Main Menu. 

 
 
If an EMCP 3 which is set to display an unknown language, the following steps will change the 
language to Technician English, regardless of the current screen, and without needing to read 
the text. 
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CHANGING TO TECHNICIAN ENGLISH 

Press the ENGINE OVERVIEW   key 

Press the ESCAPE KEY  (this will take you to the top of the Main Menu) 

SCROLL DOWN  until the scrolling stops 

Press the ENTER KEY   (this will take you into the Preferences Menu) 

SCROLL DOWN  until the scrolling stops 

Press the ENTER KEY   (this will take you into the language selection) 

Press the ENTER KEY  to select TECHNICIAN ENGLISH (shows as TECH ENGLISH on 
the EMCP 3.1 or 3.2) 

The EMCP 3 language setting is changed back to TECHNICIAN ENGLISH.   

 
Similar steps can be followed by a customer who is unfamiliar with English, to change the 
language setting back to their primary language: 

CHANGING TO PRIMARY LANGUAGE 

Press the ENGINE OVERVIEW   key 

Press the ESCAPE KEY  (this will take you to the top of the Main Menu) 

SCROLL DOWN  until the scrolling stops 

Press the ENTER KEY   (this will take you into the Preferences Menu) 

SCROLL DOWN  until the scrolling stops 
Press the ENTER KEY   (this will take you into the language selection) 

Press the SCROLL DOWN  arrow to select the customer language 

Press ENTER KEY  to change to the customer language 

The EMCP 3 language setting is changed back to the customer language. 

SETTING THE PREFERENCES USING THE SERVICE TOOL 
Only the preferences for units configuration can be configured using the Caterpillar® Service 
Tool.  They are located in the Configuration Tool.  Select Display Preferences from the left 
pane. 
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FIGURE 13: DISPLAY PREFERENCES 

The display units can be changed the same way other setpoints are changed with the Service 
Tool. 

PRESSURE 

 

This allows pressure parameters (such as Engine Oil Pressure) and setpoints 
(such as Low Engine Oil Pressure Event Threshold) to be shown in either kPa, 
psi, or bar.  Select the desired unit with the left or right arrows. 

TEMPERATURE This allows temperature parameters (such as Engine Coolant Temperature) 
and setpoints (such High Engine Coolant Temperature Event Threshold) to be 
shown in either Celsius (Centigrade) or degrees Fahrenheit. 

VOLUME This allows volume parameters (such as Fuel Volume) to be shown in either 
Liters, Imperial Gallons, or US Gallons. 

4.3 CONFIGURING TIME/DATE (EMCP 3.2 AND 3.3) 
The EMCP 3.2 and 3.3 have an internal clock that is used for time-stamping events.  The 
timestamps for the first date and time an event has occurred and the last date and time the 
event has occurred are viewed by selecting an Event and pressing Enter, then scrolling down.  
See FIGURE 14 below. 
 

 
FIGURE 14: EVENT DETAILS SCREENS – LAST OCCURRENCE (LEFT) AND FIRST OCCURRENCE (RIGHT) 

CHANGING DATE FORMAT 
The data format can be set to either display in the form Month/Day/Year or the form 
Day/Month/Year.  This procedure must be performed on the EMCP 3 GSC display; it cannot be 
done using the Caterpillar® Service Tool. 

NOTE: This preference does not affect operation of the EMCP 3 or the data as 
viewed in the Caterpillar® Service Tool.  It only affects how the date is 
displayed on the EMCP 3 GSC display. 

To change the date format, do the following: 
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At MAIN MENU  

ENTER KEY   
 

SCROLL DOWN    
to CONFIGURE  

ENTER KEY   
 

 

SCROLL DOWN    
to TIME/DATE  

ENTER KEY   
 
Highlight FORMAT MM/DD/YY  

 
(or FORMAT DD/MM/YY, depending on the current setting) 

ENTER KEY    
Select the format using the 

LEFT ARROW  or RIGHT 

ARROW  
  

ENTER KEY   
 

 

CHANGING THE TIME / DATE 
The EMCP 3 clock allows the time/date to be modified.  Changing the time/date will change the 
timestamp on all future events, but not for existing events.  (For example, an event that has 
occurred previously will still show the same FIRST time/date, but if it occurs again after the 
time/date has been adjusted, the LAST time/date will reflect the change.) 
 
This procedure must be performed on the EMCP 3 GSC display; it cannot be done using the 
Caterpillar® Service Tool.  In order to update time/date, LEVEL 1 ACCESS is required.  Refer to  
Chapter 6, Security for information on obtaining LEVEL 1 ACCESS. 

To change the time/date, do the following: 

TO CHANGE THE TIME 
At MAIN MENU  

ENTER KEY   

 

SCROLL DOWN   
to CONFIGURE  

ENTER KEY   

 

SCROLL DOWN   
to TIME/DATE  

ENTER KEY   
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With the box around the time, 
press  

ENTER KEY   

 
(if the time cannot be selected, and a padlock is shown on the 

screen, then Level 1 access has not been obtained) 

To begin editing the time press 

 ENTER KEY   

 
 

Select a digit using the 

LEFT ARROW  or RIGHT 

ARROW   
 
To change the selected digit 
use the 

UP ARROW  or DOWN ARROW 

  

 

To accept change: 

Press ENTER KEY   

To reject, change: 

 ESCAPE KEY   

 

TO CHANGE THE DATE 
Press ESCAPE KEY   again to return to the SET TIME/DATE screen. 

Press the RIGHT ARROW  key to put the box around the date ENTER KEY  . 

Press ENTER KEY   again to begin editing the date. 

Use the LEFT ARROW  or RIGHT ARROW  keys to select a digit and the  

UP ARROW  or DOWN ARROW  keys to change it. 
Press ENTER KEY   to accept, or ESCAPE KEY    to reject, your change. 

Press ESCAPE KEY    again to return to the SET TIME/DATE screen. 

4.4 ADJUSTING GENERATOR SET PARAMETERS 
On some gensets, the engine speed, generator output voltage, and idle/rated status can be 
adjusted from the display of the EMCP 3 GSC. 
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ENGINE SPEED  
To program the Engine Speed of a genset it must have an electronic engine controlled by an 
ADEM III or newer ECM. The Primary Desired Speed Input Configuration Setpoint in the ADEM 

is programmed to CAN INPUT, then the engine speed can be adjusted from the display of the 
EMCP 3 GSC.  The Engine Type Configuration setpoint must be programmed to ELECTRONIC. 

PROGRAMMING THE ENGINE SPEED 
 

From the MAIN MENU  
select CONTROL 
 
 

Once in that screen the first option will be highlighted 
and it will display one of the following: SPEED, 
VOLTAGE, or SPEED & VOLTAGE.  The engine 
speed can only be controlled if SPEED or SPEED & 
VOLTAGE is displayed.  If the EMCP 3 GSC is not 
programmed for an electronic engine, speed will not 
show up as an option. 

Press the ENTER KEY   The speed and voltage adjust screen will be 
displayed.  To adjust the engine speed from this 
screen 

Adjust Engine Speed:   

Press RIGHT ARROW KEY  To INCREASE the engine speed 

Press LEFT ARROW KEY   To DECREASE the engine speed 
 
The EMCP 3 GSC will broadcast an engine speed bias based on the adjustment that is made.  
If the engine speed is adjusted, that value will remain until either it is adjusted again or until the 
control is power-cycled. 

GENERATOR OUTPUT VOLTAGE 
If the genset is equipped with a Caterpillar Digital Voltage Regulator (CDVR), then the generator 
output voltage can be adjusted from the display of the EMCP 3 GSC.   

PROGRAMMING THE GENERATOR OUTPUT VOLTAGE 
  

From the MAIN MENU  
select CONTROL 

Once in that screen the first option will be highlighted 
and it will display one of the following: SPEED, 
VOLTAGE, or SPEED & VOLTAGE.  The generator 
output voltage can only be controlled if VOLTAGE or 
SPEED & VOLTAGE is displayed.  

Press the ENTER KEY   The speed and voltage adjust screen will be 
displayed.  To adjust the generator output voltage 
from this screen 

Adjust Output Voltage:  

Press  UP ARROW KEY  To INCREASE the generator output voltage. 

Press DOWN ARROW KEY  To DECREASE the generator output voltage. 
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NOTE: In order for the VOLTAGE ADJUST to work, the AVR VOLTAGE CONTROL 
DESIRED INPUT CONFIGURATION setpoint in the CDVR must be programmed 
for CAN INPUT. If that setpoint is set to SWITCH, the VOLTAGE CONTROL from 
the EMCP 3 GSC will NOT WORK. 

 

IDLE/RATED 
The engine speed can be toggled between LOW IDLE and RATED SPEED from the display of the 
control. 

From the MAIN MENU  
select CONTROL 

 

Press DOWN ARROW  Highlight IDLE/RATED.  

Press ENTER KEY  
The IDLE/RATED screen will be displayed and the 
current state will be shown. 

To change the state,  

Press UP ARROW  or DOWN 

ARROW  Then select the value. 

Press ENTER KEY   

4.5 STARTING AND STOPPING THE GENERATOR SET 

STARTING THE ENGINE 
Once the control is configured correctly, the control panel is powered up, and the generator set 
is ready to be operated, the generator set can be started.  Refer to FIGURE 15, Stopping The 
Engine. There are several ways the generator set can be started from the control panel. 

To START the engine in MANUAL OPERATION: 

1. Press the RUN KEY   

or 

2. Place the control in AUTO mode  

then 

3. The engine can be started THREE  DIFFERENT WAYS.  

a: Activate DIGITAL INPUT #2, which is the REMOTE INITIATE INPUT.  

b: Activate a REMOTE INITIATE over the MODBUS data link. 

c: Configure a PROGRAMMABLE CYCLE TIMER. 
When the control panel initiates a start command on a diesel engine, the control checks to make 
sure there are no SHUTDOWN EVENTS present (labeled PRESENT) or that there are no latched 
SHUTDOWN EVENTS (labeled ACTIVE).   
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If there are no shutdown events that are active or present, and after any pre-crank or start-aid 
activities have completed, the starter motor and fuel control will be activated.  The EMCP 3 GSC 
will activate Relay Output #1 to activate the starter motor magnetic switch, and Relay Output #2 
to activate the fuel enable circuit.   

On electronic engines with ADEM™ A3 or newer engine ECM, the start command and fuel 
enable signals will be sent from the EMCP 3 GSC to the engine ECM via the J1939 data link.  
After receiving the signals, the engine ECM will operate the fuel control relay and starter motor 
magnetic switch.  Relay outputs #1 and #2 will not be used on those engines.  

Relay Output #1 will remain active until the programmed ENGINE CRANK TIME has been reached, 
or until the engine speed has reached the programmed CRANK TERMINATE SPEED setpoint 
value.   

NOTE: the EMCP 3 GSC Crank setpoints: number of cranks, crank duration, and 
crank terminate speed are not used on engines using the ADEM™ A4 with 
the Common Engine Interface option or newer engine ECM. These values 
must be adjusted in the engine ECM. 

CAUTION: To determine the exact starting sequence for your engine, consult your engine’s 
Operation and Maintenance Manual. 

STOPPING THE ENGINE 

Once the engine is started, the engine can be stopped by pressing the STOP KEY  on the 
control panel.  If the control is in AUTO, the engine can also be stopped by DEACTIVATING  all of 
the remote initiate commands. There are three possible sources for this command: 

1. The remote initiate input (digital input #2) 

2. The remote initial command over the Modbus datalink (register number 1055) 

3. The Programmable Cycle Timer 

Once the STOP command is issued, the control will go into COOLDOWN MODE.  Cooldown mode 
will run for the duration of time that it is programmed in the COOLDOWN DURATION setpoint. If the 
cooldown time is set for zero minutes, the engine will stop immediately.   

On engines with ADEM™ A4 or newer engine ECM, the cooldown timer in the EMCP 3 GSC 
should be set to 0 (Zero) minutes because the cooldown time is controlled from the engine ECM 
(if this is not done, both cooldown timers will run in sequence).  Also, the ENGINE OPERATING 
STATE INPUT CONFIGURATION parameter must be set to CAN INPUT. 

The cooldown timer can be overridden by pressing and holding the STOP KEY  for 5 
seconds.  The display will show a splash screen that will ask if you want to BYPASS COOLDOWN? 
or continue with the cooldown cycle.  

If the ENTER KEY   is pressed from the splash screen, the cooldown timer will be 
bypassed.   

If the ESCAPE KEY  is pressed from the splash screen, the cooldown cycle will 
continue until the programmed cooldown time has elapsed. 



32 

 4 INITIAL Operation and User Orientation 

When the cooldown timer has elapsed or has been bypassed, Relay Output #2 will open.  The 
STOP command will also be sent over the J1939 data link for those engines that require it.  At 
that point, the fuel injection will be DISABLED and the engine will stop. 

Any time, while the engine is RUNNING:  

The EMCP 3 GSC detects a condition where an engine or generator parameter is ABOVE 
or BELOW programmed thresholds for a programmed amount of time or another 
SHUTDOWN EVENT occurs, then the EMCP 3 GSC will attempt to shut the engine down 

Depending on how a specific EVENT RESPONSE configuration is programmed, the EMCP 3 GSC 
will either put the engine in COOLDOWN, followed by a soft shutdown or shut the engine down 
immediately (a HARD SHUTDOWN). 

 
FIGURE 15: STOPPING THE  ENGINE 

4.6 ENGINE SETPOINT VERIFICATION 
The engine setpoint verification procedure verifies that the EMCP 3 GSC operates correctly 
when OIL PRESSURE, HIGH COOLANT TEMPERATURE, LOW OR ENGINE OVERSPEED events occur.   

On an ENGINE OVERSPEED EVENT, the EMCP 3 GSC will shut the engine down.  

LOW OIL PRESSURE and HIGH COOLANT TEMPERATURE each have two events, WARNING and 
SHUTDOWN.  The EMCP 3 GSC will issue a WARNING whenever the warning threshold is 
reached and a SHUTDOWN whenever the shutdown threshold is reached. The configuration 
setpoints used in normal operation will be modified. 

During this procedure 
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 Each configuration setpoint should be recorded prior to adjustment. 

 Returned back to the original setting after the setpoint has been verified. 

The following conditions are required before the ENGINE SETPOINTS are verified: 

 

REQUIRED CONDITIONS 
 The setpoints must be correct for the engine application. 

 No shutdown events should be present. If necessary, troubleshoot, correct, and 
reset any and all shutdown events. 

PROCEDURE FOR OVERSPEED VERIFICATION 

NOTE: Adjustment of ENGINE OVER SPEED SHUTDOWN THRESHOLD setpoint requires a 
level 3 password. For details on changing security levels refer to Chapter 6, 
Security.  

The Security Level only affects changing parameters from the EMCP 3 GSC. Changing 
parameters with the Caterpillar® Service Tool does not require passwords. 

1. Start the engine and run the engine at rated speed.   

2. Adjust the setpoint value for Engine Over Speed Shutdown Threshold to a value that is 
below the speed that the engine is running at.  An Engine Overspeed Shutdown event 
will occur immediately after the setpoint is changed, and the engine will shut down.   

3. View the event by going to the Genset Control event log.  Reset the event.  For more 
information about how to view and reset the event, refer to Chapter 5, Handling Events. 

4. Return setpoint value for Engine Over Speed Shutdown Threshold to the original value. 

PROCEDURE FOR LOW OIL PRESSURE VERIFICATION 

NOTE:  Low oil pressure shutdown is disabled during start-up and while the engine is 
not running by the Fault Protection Timer (FPT).  The fault protection timer 
starts timing when the crank terminate RPM is reached during the starting 
sequence.  The fault protection timer will then run for a programmed time             
which is determined by the Engine Start Fault Protection Activation Delay 
Time setpoint.  Make sure the fault protection timer has elapsed before 
starting the Low Oil Pressure Verification. 

1. Start the engine and run the engine at rated speed. 

2. Adjust the setpoint value for Low Engine Oil Pressure Shutdown Event Threshold to a 
value that is above the oil pressure that the engine is operating at.  The shutdown event 
will occur after the programmable time delay (the Low Engine Oil Pressure Shutdown 
Delay Time setpoint).   

3. View the event by going to the Genset Control event log.  Reset the event.  For more 
information about how to view and reset the event, refer to Chapter 5, Handling Events. 

4. Return setpoint value for Low Engine Oil Pressure Shutdown Event Threshold to the 
original value. 
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PROCEDURE FOR HIGH COOLANT TEMPERATURE VERIFICATION 

NOTE:  High Coolant Temperature shutdown is disabled during start-up and while the 
engine is not running by the Fault Protection Timer (FPT).  The fault 
protection timer starts timing when the crank terminate RPM is reached 
during the starting sequence.  The fault protection timer will then run for a 
programmed time (the Engine Start Fault Protection Activation Delay Time 
setpoint).  Make sure the fault protection timer has elapsed before starting 
the High Coolant Temperature Verification. 

1: Start the engine and run the engine at rated speed.   

2: Adjust setpoint value for High Engine Coolant Temperature Shutdown Event 
Threshold to a value that is below the engine coolant temperature that the engine is 
operating at.  The minimum value for this setpoint is 49ºC (120ºF), so you may have 
to run the engine for a few minutes to get the temperature above the minimum value.  
The shutdown event will occur after the programmable time delay (the High Engine 
Coolant Temperature Shutdown Event Notification Delay Time setpoint).  

3: View the event by going to the Genset Control event log.   

4: Reset the event.  Refer to Handling Events for more information about how to view 
and reset the event. 

5: Return setpoint value for  High Engine Coolant Temperature Shutdown Event 
Threshold to the original value. 

4.7 ENGINE SPEED TIMING CALIBRATION -  PREPARATION 
The following procedure describes the required steps before an ENGINE SPEED TIMING 
CALIBRATION procedure is performed. After this procedure has been completed, the engine can 
be started and the engine can be run at rated speed. 

NOTE: This procedure does NOT include the instructions for performing the actual 
calibration. For instructions on performing the calibration procedure, refer to 
the Testing and Adjusting Manual for your engine. 

NOTE:  Before changing any value per this procedure, RECORD THE ORIGINAL VALUE! 

1: Stop the engine. 

2: In the main menu scroll down until CONTROL is highlighted.  Press the ENTER KEY  
.  Scroll through the options in the control menu.  If there is an option called 

IDLE/RATED, go to Step 3.  If not go to Step 5. 

3: Make sure the IDLE/RATED option is highlighted and press ENTER KEY  .  If the 
display shows RUN AT IDLE in the IDLE/RATED screen, go to Step 10.  If the 
display shows RUN AT RATED in the IDLE/RATED screen, go to Step 4. 

4: Press the ENTER KEY   and then use the UP ARROW  and DOWN ARROW  
keys in order to select RUN AT IDLE.  Press ENTER KEY   to accept the new 
value.  Go to step 10. 
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5: Set the ENGINE START FAULT PROTECTION ACTIVATION DELAY TIME setpoint (under 
Control > Auto Start/Stop) in the EMCP 3 GSC to 300 seconds. 

6: If a device such as a load share module is supplying a PWM signal in order to bias 
the engine speed, then disconnect the PWM signal wires from the device.  Go to 
Step 7.  If there is not a device supplying a PWM signal and the engine speed bias is 
controlled from the EMCP 3 GSC, go to Step 9. 

7: Set the PRIMARY DESIRED SPEED setpoint in the Engine ECM to PWM. 

8: Set the SECONDARY DESIRED SPEED setpoint in the Engine ECM to DISABLED. 

9: Start the engine and run the engine at idle speed. 

10: Perform the Engine Speed Timing Calibration.  See the Systems Operation, Testing 
and Adjusting manual for your engine for more information on how to perform the 
calibration procedure. 

11: Stop the engine. 

12: Return any modified setpoints to the original values. 

13: Reconnect any wires that were disconnected in Step 6. 

14: If steps 3 and 4 were performed, set the idle/rated status back to RUN AT RATED. 

4.8 ENGINE OPERATING HOURS 

 

One of the features of the EMCP 3 is the ability 
to maintain the ENGINE OPERATING HOURS, 
which is the cumulative amount of time that the 
engine has run above the Crank Terminate 
speed.  This time is displayed on the Engine 
Overview screen, just below Battery Voltages 
shown in FIGURE 16. 

UPDATING ENGINE OPERATING HOURS 
For applications where a new EMCP 3 GSC is 
fitted to a generator set that was previously in 
operation, the EMCP 3 allows the user to 
increment the engine hours to match the 
engine. 

FIGURE 16: ENGINE OVERVIEW SCREEN 

NOTE: Engine Hours can only be increased.  They cannot be decreased. 

This procedure must be performed on the EMCP 3 GSC display; it cannot be done using the 
Caterpillar® Service Tool.  In order to update engine hours, LEVEL 3 ACCESS is required.  Refer 
to Chapter 6, Security for information on obtaining LEVEL 3 ACCESS. 

UPDATING ENGINE HOURS 
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At MAIN MENU 

SCROLL DOWN   to: 

ENG OPERATE HRS 

ENTER KEY    
 

 
(if pressing Enter on this menu item has no effect, then 

Level 3 access has not been obtained) 

To edit the ENGINE HOURS: 
Select a digit using the 

LEFT ARROW  or  

RIGHT ARROW   
 
To change the selected digit 
use the 

UP ARROW  or  

DOWN ARROW   

 

 
To accept change: 

Press ENTER KEY   
To reject, change: 

Press ESCAPE KEY    

Again, press ENTER KEY   
to confirm, or   
ESCAPE KEY  to reject the 
change. 
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5 HANDLING EVENTS  
The EMCP 3 shows previous and current events.  These events are organized into logs for 
each physical EMCP 3 module.   

The logs include: 

EMCP 3.1, 3.2, AND 3.3 
GENSET CONTROL Events for the EMCP 3 GSC 
ENGINE CONTROL Events for a J1939-compatible engine ECM 
DIGITAL AVR  Events for the Caterpillar Digital Voltage Regulator (CDVR) 

EMCP 3.2 AND 3.3 ONLY 
EXTERNAL I/O Events for an Auxiliary Input/Output module (DIO) 

EMCP 3.3 ONLY 
THERMOCOUPLE Events for the thermocouple module 
RTD MODULE Events for the Resistive Temperature Device (RTD) module 

 

Each log is visible only if the module is connected to the appropriate EMCP 3 J1939 data link, 
and is communicating with the EMCP 3 GSC.   

The EMCP 3 supports more than one instance of some of the above modules.  (See Chapter 
17, Optional Modules, for the number of modules supported by each of the EMCP 3.1, 3.2, or 
3.3 systems).  Those modules are uniquely identified with a number at the end of the log name, 
such as EXTERNAL I/O #2.   

The number is software-configured, and is called the module’s ECU INSTANCE NUMBER.  The 
ECU Instance Number can be viewed and modified by the Caterpillar® Service Tool.  See the 
appropriate sub section of Chapter 17, Optional Modules, for the expansion module in question, 
to see how to program the Instance Number. 

Events for the EMCP 3 GSC can be in three states; PRESENT, ACTIVE, or INACTIVE. 

PRESENT The condition that caused the event is still present.  The condition needs to 
be addressed before the event can be reset. 

ACTIVE The condition that caused the event is no longer present, but the event must 
be manually reset in order to return to normal operation.  (See Chapter 5.3, 
5.4, and 5.5 on how to Reset Events). 

INACTIVE The event has happened at some time in the past but is no longer affecting 
the system. Inactive events are stored for historical purposes only. 

Events for the other modules are only shown as ACTIVE or INACTIVE, in other words, there is 
no indication on whether the condition that caused the event is still present. 

There are three categories of events that can occur; ACTIVE ONLY events, WARNINGS, and 
SHUTDOWNS. 

ACTIVE ONLY Active Only events merely show up in the event log for information purposes, 
and are not logged after the condition goes away. 

WARNING If a Warning occurs, the amber LED on the control will flash and the warning 
will appear in the event log.  The engine will not shut down.  In most cases, a 
Warning will reset itself as soon as the condition that caused it goes away. 
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However, if the setpoint Event Warning Condition Response Auto Reset 
Enable Status is set to False, then all Warnings will remain in the Active state, 
with the amber LED on, until they are manually reset. 

SHUTDOWN If a shutdown event occurs, the engine will shutdown, and the red LED will 
flash on the control.  A shutdown event is a latched event and will not reset 
itself.  The condition that caused the shutdown must first be fixed, only then 
can the event be reset. 

NOTE: Information on how to reset events is given further on in this Chapter. 

5.1 CONFIGURING EVENT RESPONSES 
The category of event, as well as other behavior when an event occurs, can be configured via a 
group of EMCP 3 GSC setpoints called EVENT RESPONSE CONFIGURATION.  An example 
of an event response configuration is ENGINE LOW OIL PRESSURE WARNING EVENT RESPONSE 
CONFIGURATION.  This setpoint configures the system response to a low engine oil pressure 
warning event. 

The following is a list of all the possible options for an event response configuration: 

WARNING   Creates a Warning event in the event log and lights the amber LED. 

AUDIBLE ALERT Activates any relays that are programmed for horn control.  Without 
programming a relay, no action will be taken. Audible Alert can only be 
programmed if: either Warning or Shutdown is also programmed. 

SOFT SHUTDOWN Creates a Shutdown event in the event log, lights the red LED, and shuts 
the engine down after the cooldown period (Note: the control must be 
configured to have control of the generator breaker in order to be able to 
cool down the set offload). 

HARD SHUTDOWN Creates a Shutdown event in the event log, shuts the engine down 
immediately and lights the red LED. 

UTILITY FAILURE Indicates a Utility Failure, which can be used by internal logic or to trigger 
outputs. 

BREAKER #1 TRIP Activates a Breaker #1 Trip, which can be used by internal logic or to 
trigger outputs.  

BREAKER #2 TRIP   
 

Activates a Breaker #2 Trip, which can be used by internal logic or to 
trigger outputs. 

FAULT PROTECTION 
TIMER ENABLED 

Suppresses the event until the engine is running and the Fault Protection 
Timer has expired (this prevents nuisance events during startup).  The fault 
protection timer starts when the engine speed goes above crank terminate 
speed. 

ACTIVE ONLY Creates an Active Only event in the event log. 
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NOTE: Not all options are available for all setpoints.  For example, the Engine Low Oil 
Pressure Warning event cannot be configured as a shutdown, because there 
is a separate event (Engine Low Oil Pressure Shutdown) dedicated for that 
purpose. 

5.2 CHANGING AN EVENT RESPONSE CONFIGURATION 
To change an event response configuration, the control must be in STOP mode.  

Here are the steps to access event response configurations on the EMCP 3 GSC display. 

 

START AT: 
MAIN MENU 

 

scroll down   to: 

CONFIGURE  

ENTER KEY    

scroll down   to:  

SETPOINTS  

ENTER KEY    

scroll down   to:  

EVENTS  

ENTER KEY    

scroll down   to:  

EVENT RESPONSE CFG  

ENTER KEY    
Now, choose the group for the event to configure.   

The group name should help find the setpoint.  However, a list of setpoints in each group (also 
called a Block) is given in APPENDIX D.  Block numbers are given in APPENDIX C.   

FOR EXAMPLE: 
To see the list of all event response configurations that are part of DIAGNOSTIC CONFIGURATION, 
notice in APPENDIX C that it is Block 17.  Then in APPENDIX D, find the list of setpoints in 
Block 17.  Notice that there are 31 setpoints in that particular Block. 
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EXAMPLE: 
Select 

DIAGNOSTICS CONFIG  

ENTER KEY    
In this group of event response configurations, there are 
four types of events, grouped by the type of data: 
Pressures, Temperatures, Levels, and Others (such as 
status). 

EXAMPLE: 
Select  

PRESSURES  

Press ENTER KEY    

To edit a setpoint, 

Press RIGHT ARROW   

key to highlight EDIT.   

 
This brings up a list of event response configuration 
setpoints.   

NOTE: This will only work if the control is in 
STOP mode.  Some setpoints cannot 
be configured, or require a minimum 
security level.  Those setpoints will 
display a lock icon to the right of the 
EDIT text. 

 
Here you can edit individual responses, as described 
above.   

Then, 

 Press ENTER KEY   

 to edit the setpoint. 

Use the LEFT ARROW  and 

RIGHT ARROW  to toggle 
between checked and 
unchecked, and use the UP 

ARROW  and DOWN ARROW 

 to move between the 
responses.  

Some responses are fixed and cannot be disabled.  For 
those responses, a lock will be displayed instead of a 
checkbox. 

5.3 RESETTING INDIVIDUAL EVENTS FOR THE EMCP 3 GSC 
There are three ways to reset events.  One way, described in this Chapter, which applies to the 
EMCP 3 GSC only, is to reset individual events by navigating to the desired event in the event 
log.   
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The second way, which applies to all modules other than the EMCP 3 GSC, is to reset all 
events in that modules event log by navigating to one of the active events in the event log.   

The third way is a shortcut to reset all events for all modules.  With any method, you must be in 
STOP mode. 

To reset individual events on the EMCP 3 GSC, start by navigating to the event log: 

From the top of the Main Menu, enter Event Logs by pressing the Enter key. 

FROM: 
         MAIN MENU 
Select   

EVENT LOGS  
by pressing the  

ENTER KEY  . 

 
Next, select the log that contains the event that needs to be 
RESET. 

Scroll up  or down  to 
select the desired log and   

Press ENTER KEY  . 
 

In this example image, there are only two PRESENT or ACTIVE 
events, and they are both in the GENSET CONTROL log.   

Scroll up  or down   
through the list of events and 
find the ACTIVE event that 
requires resetting. 

 
Events are ordered by the status of the event; PRESENT 
events are listed first, followed by ACTIVE events, and finally 
the INACTIVE events. 

Press ENTER KEY    

to view the event details. 

 
If the control is in STOP mode, RESET will be shown and 
highlighted.  

Pressing the 

ENTER KEY   

will RESET the event. 

  NOTE: If the event status is present, the RESET 
text will not be visible and the event 
cannot be reset until the condition that 
caused the event has been addressed. 
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5.4 RESETTING ALL EVENTS FOR A SINGLE MODULE 
The second way to reset events, described in this Chapter, which applies to all modules other 
than the EMCP 3 GSC, is to reset all of the module’s events by navigating to one of the active 
events in the event log.   

With any method, you must be in STOP mode. A key difference between the EMCP 3 GSC and 
all other modules is that the other modules don’t display a PRESENT status for events.   

Events are shown as ACTIVE if they are currently affecting the system, or as INACTIVE if they 
are not. 

To reset all of a modules events on any individual module except the EMCP 3 GSC (listed as 
GENSET CONTROL in the event log), start by navigating to the event log.   

FROM: 
MAIN MENU 
Select   

EVENT LOGS  
by pressing the  

ENTER KEY  . 

  
Next, select the log which contains the event that needs to be 
reset.  In this example image, there is only one ACTIVE 
event, and it is in the ENGINE CONTROL log. 

Scroll up  or down  to 
select the desired log and 

Press ENTER KEY   
 

Events are ordered by the status of the event; ACTIVE events 
are listed first, followed by the INACTIVE events.  Scroll up or 
down through the list of events and find the ACTIVE event that 
requires resetting.  

Press ENTER KEY    

to view the event details. 

  
If the control is in STOP mode, and engine speed is zero, 
RESET ALL will be shown and highlighted. 

Pressing the 

ENTER KEY   

will RESET all events. 
 

Pressing the enter key will reset all of the ACTIVE events in 
that module’s event log that can be reset. 
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NOTE: Modules other than the EMCP 3 GSC cannot display events as PRESENT.  
So if pressing ENTER KEY   at RESET ALL doesn’t reset all of the events, 
the condition causing the event being viewed may still be present.  For 
example, if the engine shut down on high coolant temperature, then the 
events will not reset until the coolant temperature drops below the shutdown 
threshold. 

5.5 RESETTING ALL EVENTS FOR ALL MODULES 
The third way to reset events, described in this Chapter, is a shortcut to reset all events for all 
modules.  With any method, you must be in STOP mode. 

Once all of the events have been viewed and the condition(s) that are causing the events have 
been corrected, all active events (those for which the condition is not present) on all modules 
can be reset using the RESET ALL EVENTS feature.   

In order to do this, the control must be in STOP mode and engine speed should be zero.   

FROM ANY SCREEN: 
Press the and hold the 

 ACKNOWLEDGE   

for approximately 5 seconds.  
  

A confirmation prompt will appear. 

Pressing the 
 ENTER KEY   

 

will continue and RESET all events on all modules. 

Pressing the  
  ESCAPE KEY  

 

will CANCEL the reset operation. 

NOTE: Reset All Events will not reset Present events!  For example, if the E-Stop 
switch is pressed and an EMERGENCY STOP SWITCH ACTIVATED 
SHUTDOWN is present, it cannot be reset until the E-Stop is pulled out and 
the event status changes from PRESENT to ACTIVE. 

5.6 RESETTING EVENTS FOR ENGINE ECMS WITHOUT J1939 SUPPORT 
The EMCP 3 GSC support for engine events depends on the type of engine ECM.  This is 
configured with the setpoints ENGINE TYPE CONFIGURATION and ENGINE CONTROL J1939 DATA 
LINK SUPPORT CONFIGURATION.   

The functionality available for the different types of engine ECM is shown in Table 4: ECM 
Functionality. 

TABLE 4: ECM FUNCTIONALITY 

ECM FUNCTIONALITY 
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Engine Type 
Configuration 

Engine Control 
J1939 Data Link Support 

Configuration 
Engine Events Functionality 

Mechanical  None 
Electronic No J1939 Support Can reset all events only 
Electronic Basic J1939 Support Can view and reset all events 
Electronic Enhanced J1939 Support Can view and reset all and view additional event info

 

The EMCP 3 GSC has the ability to reset all events for electronic engines with no J1939 support 
by means of a relay output.  A number of conditions must be satisfied in order for this to work.  

FIRST: One of the Digital Selectors must be configured for ECU FAULT RESET.  Refer 
to Digital Selector Options, in Chapter 10.1 for a list of options for Digital 
Selectors. 

SECOND: The corresponding relay output must be wired to a corresponding Fault Reset 
I/O pin on the engine ECM or it must be setup to power cycle the ECM. 

THIRD: The EMCP 3 GSC setpoints given in the table above must be set properly.  
Engine Type Configuration must be set to ELECTRONIC and Engine Control 
J1939 Data Link Support must be set to NO J1939 SUPPORT. 

In that case, the Engine Control will not be listed in the EMCP 3 GSC display 
event log.  However, there will be an option to RESET ALL ENGINE EVENTS.   

Pressing the ENTER KEY  with this option selected will activate the ECU 
FAULT RESET, which will activate the corresponding relay output and trigger the 
engine ECU to reset its faults or will power cycle the ECU. 

5.7 TROUBLESHOOTING RESETTING EVENTS 
There are common reasons for the EMCP 3 GSC not allowing events to be reset.  First of all, in 
order to reset any event, the EMCP 3 GSC must be in STOP mode.  In order to reset engine 
ECM events, the engine speed must also be zero. 

One common confusion about events is the SERVICE MAINTENANCE INTERVAL WARNING.  
This event is explained in the following Chapter. 

NOT IN AUTO 
Another event that can cause confusion is NOT IN AUTO. This event is Present whenever the 
control is in either RUN or STOP. As a result, it can not be reset in STOP (as the event is 
present). The event will reset when the control is returned to AUTO . 

 If Event Warning Condition Response Auto Reset Enable Status is set to Disabled (so that 
warning events do not auto-reset) and the event response configuration for NOT IN AUTO is set 
to a Warning then it will not be possible to reset the NOT IN AUTO event. 

It will be Active when the control is in Auto and Present when the control is in STOP. If it is a 
requirement for Event Warning Condition Response Auto Reset Enable Status to be Disabled 
then it is strongly recommended to make the event response configuration of Not in Auto ACTIVE 
ONLY rather than Warning. 
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SERVICE MAINTENANCE INTERVAL 
If a SERVICE MAINTENANCE INTERVAL WARNING is PRESENT, it cannot be reset.  The 
warning is PRESENT because the countdown timer has reached zero.  To clear the warning, 
the timer must be reset, rather than the event.  When the timer is reset, it returns to the 
programmed interval (default is 180 calendar days or 500 engine hours).  This timer must be 
reset from the display; it cannot be reset by using the Service Tool alone. 

 
 
TO RESET THIS TIMER: 
Start by pressing  

ENGINE OVERVIEW  
Accessible by pressing the  ENGINE OVERVIEW   shortcut 
key which is just below the display, on the right: see 0. 

SCROLL DOWN    

until you reach  

SERVICE MAINTENANCE INTERVAL  
screen  

The security level required is level 3 but, the required security 
level can be changed by using the Service Tool. 

 On the Service Tool, enter the Configuration screen, and 
select the group on the left called SERVICE MAINTENANCE 
INTERVAL. The third setpoint in that block is: 

Change that to a lower level.   PASSWORD LEVEL REQUIRED TO RESET SERVICE 
MAINTENANCE INTERVAL.   

To RESET the service interval 

Press ENTER KEY    

 
Then the service maintenance interval can be reset from the 
display. Once at this screen, RESET SERV  INTVL is 
highlighted 

 Going back into the event log should show that the SERVICE 
MAINTENANCE INTERVAL WARNING has become INACTIVE. 

CAUTION: Be sure to change the password level (using the Service Tool) back to 
LEVEL 3 after the reset, to prevent inadvertently resetting the timer at 
other times! 
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6 SECURITY 
There are five levels of security access on EMCP 3 GSC display.  LEVEL 0, LEVEL 1, LEVEL 2, 
LEVEL 3, and SERVICE TOOL are the five levels.  Any configurable parameter or function that is 
set to Level 0 can be accessed by anyone at any time, and there will never be any security 
information on the display screen.   

LEVEL 1 ACCESS and LEVEL 2 ACCESS represent increasing levels of access to the setpoints and 
functions of the controller.  Both levels 1 and 2 can be password protected with separate user-
defined passwords.   

LEVEL 3 ACCESS is password protected at the factory, and requires contacting the Caterpillar 
DEALER TC to obtain a password.   

If the present security level of the controller is below the level needed to perform a 
desired function, a padlock and a number will be displayed at the bottom right hand 
corner of the display.  The number represents the level of security that is required in 
order to perform the desired function; 1, 2, or 3.   

If there is a padlock but no number, then the Caterpillar® Service Tool is required in 
order to perform the desired function; or the setpoint may be read only and cannot be 
changed. 

 
All of the adjustable parameters are associated with a specific level of security required to make 
an adjustment to the parameter.  Certain functions, such as resetting the number of crank 
attempts, are also associated with a specific level of security. The passwords only affect  
actions taken at the EMCP 3 GSC. Access of the EMCP 3 GSC remotely via the Caterpillar® 
Service Tool or via the SCADA data link is not affected by the security level on the EMCP 3 
GSC display.  

Changing parameters with the Caterpillar® Service Tool does not require passwords, since the 
Service Tool is already at the Service Tool security level.   

When connecting via the SCADA DATA LINK, passwords can also be used. The levels of access 
granted via SCADA are identical to the levels of access granted at the EMCP 3 GSC.  However, 
the passwords themselves may differ.  Further more, the EMCP 3 GSC and the SCADA data 
link may be at different levels of access at any given time.  For more information about SCADA 
security see Chapter 21.1 DATA LINK SECURITY. 

Level 1 and Level 2 passwords are DISABLED when shipped from the factory. Level 1 and Level 
2 passwords can be user defined if desired.  If the Level 1 and Level 2 passwords are not user 
defined, the Level 2 will be the MINIMUM LEVEL.  All parameters that require Level 0, Level 1, or 
Level 2 security will be able to be changed by anyone at any time.   
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NOTE: The EMCP 3 GSC will always move up in security level to the highest level of 
access that is not password protected when a certain level of access is 
requested. For example, if a Level 1 password has been defined, but a Level 
2 password has not, the GSC will start at Level 0 on power up. When the 
Level 1 password is entered, the GSC will move up to Level 2 access. 

THE SECURITY MENU 
To get to the security menu: 

At the MAIN MENU screen 

SCROLL DOWN   to:  
 

 
 
 

CONFIGURE 

 
Press ENTER KEY   

 
At SECURITY 

 
Press ENTER KEY    

 
The SECURITY MENU will show the current level of security at the top of the screen.   

There are six options on the security menu: 
  

DROP TO MIN LEVEL CHANGE LVL 1 PSWD 
ENTER LEVEL 1 or 2 CHANGE LVL 2 PSWD 
ENTER LEVEL 3 CHANGE SCADA PSWD 

 
Selecting DROP TO MIN LEVEL will make the control go to the minimum level of security. As 
previously discussed, if the level 1 and level 2 passwords are not defined by the user, the 
minimum level of security will be level 2. If a level 2 password is defined by the user, but not a 
level 1 password, then the minimum level of security will be level 1. 

In contrast, if a level 1 password is defined by the user, but not a level 2 password, then the 
minimum level of security will be level 0.  

Selecting ENTER LEVEL 1 OR 2 will open up a password entry screen. The password entry 
screen will have 16 spaces.  In each space a numbers from 0 through 9 can be entered.  The 
password can be from 1 to 16 digits and is entirely user defined.  Enter the password for either 
level 1 or level 2 if either of those passwords have been defined. 
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Selecting ENTER LEVEL 3 will cause the display to say PHONE IN WITH and a 16 digit number 
will be displayed.  Under that, ENTER RESPONSE will be highlighted.  Record the 16 digit number 
and call the Caterpillar Dealer TC with this number.  The TC will reply with another 16 digit 
number.   

Press ENTER   from the PHONE IN WITH screen, and a password entry screen will be 
displayed. Enter the password that was supplied by the TC.   

Press ENTER  after entering the number and the current level should be 3.  The 
control will remain in level 3 security level until no key presses have been made for 10 
minutes.  After 10 minutes of inactivity the control will revert back to the minimum level of 
security. 

NOTE: To change a level 3 parameter requires either a level 3 password from the TC 
or a PC connection using a Service Tool.  Therefore, if you have a Service 
Tool, try to change the parameter using the Service Tool rather than calling 
the TC. 

Selecting CHANGE LVL 1 PSWD will allow for the level 1 password to be changed.  The control 
must be at level 1 security in order to select CHANGE LVL 1 PSWD.  The CHANGE LVL 1 PSWD 
screen looks just like the password entry screen.  It has 16 blank spaces that can each be set to 
a number from 0 to 9.  The password can use as few as one digit and can use as many as 16 
digits.  It is entirely up to the user.  If a password has been set but, it is now desired to not have 
level 1 password protection, the level 1 password can be disabled by setting the password to be 
a single 0.   

Once the desired password is entered, press the ENTER KEY  and the control will go 
back to the security screen and the level 1 password will be set. 

Selecting CHANGE LVL 2 PSWD will allow for the level 2 password to be changed.  The control 
must be at level 2 security in order to select CHANGE LVL 2 PSWD.  The CHANGE LVL 2 PSWD 
screen looks just like the password entry screen.  It has 16 blank spaces that can each be set to 
a number from 0 to 9.  Selecting a password is entirely up to the user and can use as few as 
one digit or as many as 16 digits.  

The level 2 password can be disabled by setting the password to be a single 0.  

Once the desired password is entered, press the ENTER KEY  and the control will go 
back to the SECURITY SCREEN and the level 2 password will be set. 

Selecting CHANGE SCADA PSWD will allow for the SCADA password to be changed.  

This password, if ENABLED, will require a SCADA system to first enter the password into the 
WRITE ACCESS PASSWORD register prior to conducting any other reads and writes.  The control 
must be at level 2 security in order to select CHANGE SCADA PSWD.  The CHANGE SCADA PSWD 
screen looks just like the password entry screen. It has 8 blank spaces that can each be set to a 
number from 0 to 9. The password can use as few as one digit and can use as many as 8 digits. 

Just as with level 1 and level 2 passwords, entering a single 0 will DISABLE the SCADA 
password.  See Chapter 21.1 Data Link Security for more information. 
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7 SETPOINTS 
The EMCP 3.1, 3.2, and 3.3 have a variety of setpoints (for example: there are over 500 
setpoints on EMCP 3 GSC) that can be programmed or adjusted.  These setpoints can be 
adjusted via the display, the Caterpillar® Service Tool, or over the SCADA data link (not 
available on EMCP 3.1).  For more information about programming setpoints over the SCADA 
data link, see EMCP 3 GSC SETPOINTS Chapter 21.10.  In order to program the setpoints via the 
display, go through the following menu options. 

MAIN MENU  

SCROLL DOWN   to: 

 

CONFIGURE 

Press ENTER KEY   

 

SCROLL DOWN   to: 

SETPOINTS 

Press ENTER KEY   
 

7.1 THREE TYPES OF SETPOINTS 
Setpoints can be three different types; NUMERICAL ENTRY, MENU, or EVENT RESPONSE. In the 
case of the event response configurations there are OPTIONS with check boxes next to them. 

NUMERICAL ENTRY setpoints are parameters like time delays, thresholds, etc.  For these 
setpoints the display will show the current value.  If that value is to be changed, first the control 
must be in the proper level of security.  See SECURITY Chapter 6 for more information about the 
level of security.   

1. To change the value of a setpoint, press the ENTER KEY  .  The current value of the 
setpoint will be shown with the rightmost digit highlighted.   

2. Use the UP  and DOWN  arrow keys to adjust that digit to the desired value.   

3. Once that digit is set to the desired value, use the LEFT  arrow key to move the 
cursor to the next digit.   

4. Then use the UP  and DOWN  arrow keys to adjust that digit to the desired value.   

5. Continue this process until the desired value for the setpoint is set.   

6. Then press the ENTER KEY  to save the value. 
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MENU type setpoints, such as generator configuration, have options that are not numerical.  For 
these setpoints, the display will show the current setting.   

If that setpoint is to be changed: 

1. The control must be in the proper level of security.  See Chapter 6 SECURITY for more 
information about the level of security.   

2. Then, to change the value of the setpoint, press the ENTER KEY .   

3. The current setting will be highlighted.  Use the UP  and DOWN  arrow keys to 
scroll through the options that are available for that setpoint.   

4. When the desired option is displayed, press the ENTER KEY  to save the setting. 

 

EVENT RESPONSE setpoints configurations are a little different from the previously discussed 
setpoints.  Selecting EVENT RESPONSE CONFIG will display four more submenus.   

Those four submenus contain all of the possible events that can be generated by the EMCP 3 
GSC. Two of the submenus, DIAGNOSTICS CONFIG, and ENG PROTECT CONFIG, each 
have four more submenus. 

DIAGNOSTICS CONFIG 
PRESSURES 
TEMPERATURES 
LEVELS 
OTHERS 
 

GEN PROTECT CONFIG 

ENG PROTECT CONFIG 
PRESSURES 
TEMPERATURES 
LEVELS 
OTHERS 
 

OTHER EVENTS CONFIG 
OTHERS 
CUSTOM EVENT #1 - #6 

 

Inside the submenus are the EVENTS.  Use the UP  and DOWN  arrow keys to scroll 
through the events.  For each event the display will have VIEW and EDIT at the bottom of the 
display.  VIEW will be highlighted at first.   

1. To view the RESPONSE CONFIGURATION for that event, press the ENTER KEY  .  All of 
the possible event response options will be shown.  There will be check boxes to the left 
of the options.  The boxes with checkmarks in them are the options that are selected. 

2. To edit the configurations, press the ESCAPE KEY    once if the event is being viewed.   

3. Then use the RIGHT   arrow key in order to select EDIT.  The edit screen looks just 
like the view screen, but the highlighted option can be checked or unchecked by using 

the RIGHT   arrow or LEFT  arrow keys.  

 If the response configuration is changed, press the ENTER KEY    to save the settings.  

NOTE:   The control must be in STOP to edit any of the event response configurations.  
This applies when programming setpoints over SCADA also. 
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For a detailed example of changing an Event Response Configuration, see Chapter 5.2.  For 
more information on the names, ranges, and descriptions of all of the setpoints, see APPENDIX 
C or use the RENR7902: Systems Operation, Troubleshooting, Testing and Adjusting manual 
for the EMCP 3.1 through 3.3. 

7.2 SETPOINT SUB-MENUS 
In the setpoints menu there are seven submenus to choose from: 

• CONTROL 

• ENG MONITOR/PROTECT 

• EVENTS  

• GEN MONITOR/PROTECT 

• I/O 

• NETWORK  

• OTHER 

Each of these submenus have additional submenus which contain setpoints. The list shown 
below is for all available menus under any configuration, for an EMCP 3.3. Menus may not 
contain all submenus shown here. 

CONTROL 
AUTOMATIC START/STOP  
AVR DESIRED VOLTAGE  
GOV DESIRED  
ENG SPEED    
SHUTDOWN OVERRIDE 

GEN MONITOR/PROTECT 
ENHANCED GEN MONITOR 
GEN AC MONITOR 
GEN AC POWER MONITOR 
GEN OVERCURRENT 
GEN OVER/UNDER FREQ 
GEN OVER/UNDER VOLT 
GEN REVERSE POWER 

I/O 
DIGITAL INPUTS 
DIGITAL OUTPUTS 
RELAY OUTPUTS 
SPARE ANALOG INPUT 

ENG MONITOR/PROTECT 
BATTERY VOLT MONITOR 
CRANK/START COUNTERS 
ENG COOLANT TEMP MON 
ENG OIL PRES MONITOR 
ENG SPEED MONITOR 
ENHANCE ENG MONITOR 
SERV MAINT INTERVAL 

NETWORK 
DATA LINK – SCADA 

EVENTS 
EVENT I/P FUNCTIONS 
EVENT O/P FUNCTIONS 
EVENT RESPONSE CONFIG 
EVENT SYSTEM 

OTHER  
DIGITAL SELECTORS 
REDUCED POWER MODE 
PROGRAMMABLE TRIP POINT 

 

7.3 SETPOINTS ON THE CATERPILLAR® SERVICE TOOL 
EMCP 3 setpoints can also be configured using the Caterpillar® Service Tool (ET).  To access 
setpoints, enter the Configuration Tool by connecting to the EMCP 3 GSC and selecting Service 
> Configuration from the menu, FIGURE 17.  
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FIGURE 17 SELECTING CONFIGURATION   

Categories of setpoints are listed along the left pane, and clicking on one of them will bring up 
that list in the right pane. 

The EMCP 3.1, 3.2, and 3.3 have different numbers of setpoints.  The EMCP 3.3 has more 
setpoints than the 3.2, which has more than the EMCP 3.1.  The categories shown here match 
those in ET version 2006B-v1.0.  Older versions may have less, and newer versions may have 
more. 

NOTE:  Any setpoint with a value given as Disabled or Not Installed or Unavailable is 
not applicable to that level of EMCP 3. 

SETPOINT CATEGORIES 
Here are the categories of setpoints as found in the left pane of the ET Configuration Tool: 

AUTOMATIC START/STOP 3.1, 3.2, 3.3

 
Setpoints related to starting and stopping the generator set, as well as engine 
configuration. 

AVR DESIRED VOLTAGE REQUEST 3.1, 3.2, 3.3

 
Setpoints related to voltage regulation (for EMCP 3 calculation and reporting only, 
not for voltage control). 

BATTERY VOLTAGE MONITOR 3.1, 3.2, 3.3

 
Setpoints related to monitoring battery voltage from the battery power input to the 
EMCP 3 GSC. 

CRANK ATTEMPT/SUCCESSFUL START COUNTER 3.2, 3.3
 Setpoints related to crank/start counters.   
SCADA DATA LINK 3.2, 3.3
 Setpoints related to SCADA (Modbus) data link communications.  See Chapter 18. 
DIGITAL INPUTS 3.1, 3.2, 3.3
 Setpoints related to the polarity of digital inputs.  See Chapter 8. 
DIGITAL OUTPUTS 3.2, 3.3
 Setpoints related to the polarity of digital outputs.  See Chapter 10. 
DIGITAL SELECTORS 3.1, 3.2, 3.3

 
Setpoints related to selecting conditions that control the behavior of relay outputs or 
digital outputs using digital selectors.  See Chapter 10.1. 

ENGINE COOLANT TEMPERATURE MONITOR 3.1, 3.2, 3.3
 Setpoints related to monitoring engine coolant temperature using Analog Input 2. 
ENGINE OIL PRESSURE MONITOR 3.1, 3.2, 3.3
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 Setpoints related to monitoring engine oil pressure using Analog Input 1. 
ENGINE SPEED MONITOR 3.1, 3.2, 3.3

 
Setpoints related to monitoring engine speed using the Magnetic Pick-Up (MPU) 
input. 

EVENT INPUT FUNCTIONS 3.1, 3.2, 3.3

 
Setpoints related to configuring digital inputs to trigger different events.  See 
Chapter 8. 

EVENT OUTPUT FUNCTIONS 3.1, 3.2, 3.3

 
Setpoints related to configuring events to trigger relay outputs or digital outputs via 
digital selectors.  Chapter 10.1. 

EVENT CONFIGURATION - DIAGNOSTIC EVENT CONFIGURATION 3.1, 3.2, 3.3

 
Setpoints used to configure the EMCP 3 response to diagnostic events.  See 
Chapter 5.7. 

EVENT CONFIGURATION - ENGINE PROTECTION EVENT RESPONSE 
CONFIGURATION 3.1, 3.2, 3.3

 
Setpoints used to configure the EMCP 3 response to engine protection events.  See 
Chapter 5. 

EVENT CONFIGURATION - GENERATOR PROTECTION EVENT RESPONSE 
CONFIGURATION 3.1, 3.2, 3.3

 
Setpoints used to configure the EMCP 3 response to generator protection events.  
See Chapter 5. 

EVENT CONFIGURATION - OTHER SYSTEM EVENT RESPONSE CONFIGURATION 3.1, 3.2, 3.3

 
Setpoints used to configure the EMCP 3 response to events that do not fit into the 
category of diagnostics, engine protection, or generator protection.  See Chapter 5. 

GENERATOR AC MONITOR 3.1, 3.2, 3.3
 Setpoints related to generator configuration (for EMCP 3 calculation and reporting). 
GENERATOR AC POWER MONITOR 3.2, 3.3
 Setpoints related to generator power monitoring. 
GENERATOR BREAKER CONTROL 3.2, 3.3
 Setpoints related to the configuration and monitoring of the generator circuit breaker. 
GENERATOR OVERCURRENT 3.2, 3.3
 Setpoints related to generator AC overcurrent monitoring. 
GENERATOR OVER/UNDER FREQUENCY 3.2, 3.3
 Setpoints related to generator overfrequency and underfrequency monitoring. 
GENERATOR OVER/UNDER VOLTAGE 3.2, 3.3
 Setpoints related to generator AC overvoltage and undervoltage monitoring. 
GOVERNOR DESIRED ENGINE SPEED REQUEST 3.1, 3.2, 3.3
 Setpoints related to adjusting the governor speed from the EMCP 3. 
PROGRAMMABLE CYCLE TIMER 3.2, 3.3
 Setpoints related to configuring Programmable Cycle Timers.  See Chapter 13. 
ELECTRONIC CONTROL MODULE REDUCED POWER MODE 3.1, 3.2, 3.3

 
Setpoints related to a power-saving mode of the EMCP 3 called Reduced Power 
Mode.  See Chapter 14. 
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RELAY OUTPUTS 3.1, 3.2, 3.3

 
Setpoints related to the polarity of relay outputs.  These are read-only.  See Chapter 
10. 

REMOTE CALLBACK 3.2, 3.3
 This feature is not available.  The setpoints will appear as “Unavailable”. 
SERVICE MAINTENANCE INTERVAL 3.2, 3.3

 
Setpoints related to configuring and resetting the timers used to indicate a service 
needed warning.  See Chapter 21.7. 

SPARE ANALOG INPUT 3.2, 3.3

 
Setpoints related to configuring the spare analog input and monitoring the 
associated parameter.  See Chapter 21.2. 

PROGRAMMABLE TRIP POINT FUNCTION 3.1, 3.2, 3.3

 
Setpoints related to configuring the behavior of the Trip Point function, which is used 
to indicate that the generator is approaching overload. 

TRANSFER SWITCH 3.2, 3.3

 
This feature is not available in standard software.  The setpoints will appear as 
“Disabled or Not Installed”. 

UTILITY BREAKER CONTROL 3.2, 3.3

 
This feature is not available in standard software.  The setpoints will appear as 
“Disabled or Not Installed”. 

CONFIGURATION DATA 3.1, 3.2, 3.3
 Contains the Engine Serial Number setpoint, which is read-only. 
DISPLAY PREFERENCES 3.1, 3.2, 3.3

 
Setpoints determining the units used on the EMCP 3 display.  Note that this does 
not affect the data as viewed on the Caterpillar® Service Tool.  See Chapter 4.2 
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8 DIGITAL INPUTS 
The EMCP 3.1 has 6 digital inputs. 

The EMCP 3.2 and EMCP 3.3 both have 8 
digital inputs.  The first and second digital 
inputs are dedicated and cannot be 
programmed on all three levels of controls. 

 

Digital input #1 is dedicated for EMERGENCY 
STOP  

Digital input #2 is dedicated for REMOTE 
INITIATE.   

 

The other inputs are linked to functions that 
are called EVENT INPUT FUNCTIONS and 
can be configured to trigger warnings or 
shutdowns in the EMCP 3. Event Response 
Configurations determine the EMCP 3 
response to any supported event.  For more 
information on Event Response 
Configurations, Chapter 5.1 - 5.2. 

 

Because digital inputs #1 and #2 are 
dedicated inputs: 

• digital input #3 is linked to 
event input function #1 

• digital input #4 is linked to 
event input function #2 

• and so on.   

This is illustrated in the figure at the right. 

 

Figure 18: Digital Inputs And Event Input Functions 
 

The digital inputs of the EMCP 3 GSC are tied to an internal pull-up resistor inside the control. 
Therefore, if a digital input is UNCONNECTED, the digital input will sit at a LOGICAL HIGH state.  

A ground or battery negative input should be wired to each EMCP 3 GSC Digital Input.  

If an ACTIVE HIGH configuration is desired, the ground or battery negative input should 
be wired through a normally-closed switch.  
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If an ACTIVE LOW configuration is desired, the ground or battery negative input should be 
wired through a normally-open switch. 

8.1 PROGRAMMING THE DIGITAL INPUTS 
There are three parts to programming the Digital Inputs. The first part involves programming the 
DIGITAL INPUT ACTIVE STATE (which can be ACTIVE HIGH or ACTIVE LOW).  The second involves 
programming the EVENT INPUT FUNCTIONS.  The third involves checking or programming Event 
Response Configurations.  The first two parts are described below.  For information on 
programming Events Response Configurations, Chapter 5.1 - 5.2. 

PROGRAMMING DIGITAL INPUT ACTIVE STATE 
To program the ACTIVE STATE of the Digital Input, go through the following menu options: 

MAIN MENU 

SCROLL DOWN   to: 

    
 

CONFIGURE   

Press ENTER KEY   

 

SCROLL DOWN   to: 

SETPOINTS   

Press ENTER KEY   
 

SCROLL DOWN   to: 

I/O   

Press ENTER KEY   
 

DIGITAL INPUTS   

Press ENTER KEY   

  
Select the DIGITAL INPUT that you want to program and 

Press ENTER KEY    The current configuration will be highlighted 
(ACTIVE HIGH or ACTIVE LOW). 

Press ENTER KEY     

To SAVE the setting 
Press ENTER KEY    

 



57 

8 DIGITAL Inputs 

PROGRAMMING EVENT INPUT FUNCTIONS 
To program the EVENT INPUT functions go through the following menu options: 

MAIN MENU 

SCROLL DOWN   to:
 

 

CONFIGURE   

Press ENTER KEY  

 

SCROLL DOWN   to:

SETPOINTS   

Press ENTER KEY   

SCROLL DOWN   to:

EVENTS  

Press ENTER KEY   

EVENT I/P FUNCTIONS   

Press ENTER KEY  

 
Once in the EVENT INPUT FUNCTION menu, the first setting is the ACTIVE STATE. The ACTIVE 
STATE should always be set to ACTIVE HIGH. 

To edit TIME DELAY 

SCROLL DOWN   to:

TIME DELAY 

 

Press ENTER KEY  and use the arrow keys to enter the desired value 

NOTE:   Event Input Function #1 corresponds to Digital Input #3, Event Input 
Function #2 corresponds to Digital Input #4, etc.  See FIGURE 18. 

To edit the SUSPECT PARAMETER NUMBER (SPN) 

SCROLL DOWN   to:

SUSPECT PARAMETER NUMBER  
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Press the ENTER KEY  to edit the SPN.  The available SPN values are 
separated by category.   

CHOOSING THE SPN 
Use the scroll keys to choose the category from the table below and  

press ENTER KEY   then use the scroll keys to choose the SPN and  

press ENTER KEY   

EVENT INPUT FUNCTION SPN AND FMI OPTIONS 

  Failure Mode Identifier valid options 

Category Suspect Parameter Number 
High 

Shutdown
Low 

Shutdown
High 

Warning 
Low 

Warning Status 
Starting Air Pressure y y y y   
Fuel Filter Differential Pressure y y y y   
Engine Oil Filter Differential Pressure y y y y   
Engine Oil Pressure   y   y   
Air Filter Differential Pressure y y y y   
Fire Extinguisher Pressure y y y y   

Pressures 

Gas Pressure y y y y   
Engine Coolant Temperature y   y y   
Ambient Air Temperature y y y y   
Exhaust Temperature y y y y   
Engine Oil Temperature y y y y   
Generator Rear Bearing 
Temperature y y y y   
Generator Winding #1 Temperature y   y     
Generator Winding #2 Temperature y   y     
Generator Winding #3 Temperature y   y     
Right Exhaust Temperature y y y y   

Temperatures 

Left Exhaust Temperature y y y y   
External Tank Fuel Level y y y y   
Fuel Level y y y y   
Engine Oil Level y y y y   

Levels 

Engine Coolant Level y y y y   
Battery Charging System Voltage       y   
Battery Voltage y   y y   
Custom Event y y y y y 
Fuel Leak         y 
Generator Frequency y y y y   
Generator Voltage y y y y   
Generator Current y   y     
Generator Power   y   y   
Inlet Manifold Charge Combustion         y 
Air Damper Closed         y 
ATS in Normal Position         y 

Others 

ATS in Emergency Position         y 
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  Failure Mode Identifier valid options 

Category Suspect Parameter Number 
High 

Shutdown
Low 

Shutdown
High 

Warning 
Low 

Warning Status 
Battery Charger Failure         y 
Utility to Generator Transfer Failure y   y     
Generator to Utility Transfer Failure     y     
Loss of Utility         y 
Earth Fault         y 
Earth Leakage         y 

 

After the SPN is chosen, the FAILURE MODE IDENTIFIER (FMI) is the next setting. The following 
FMI are available: 

• HIGH WARNING (example: High Temperature Warning) 

• LOW WARNING (example: Low Temperature Warning) 

• HIGH SHUTDOWN (example: Engine Overspeed Shutdown) 

• LOW SHUTDOWN (example: Low Generator Voltage Shutdown) 

• STATUS (example: Fuel Leak Detected condition exists) 

However, all SPN and FMI combinations are not valid.  The above table indicates which FMIs 
are valid for which SPNs.  If a combination other than one indicated with a y in the table above 
is configured, the event will not trigger any response by the EMCP 3. 

NOTE:  If your software has a release date prior to October 2006, all SPNs listed in 
the above table may not be present in your software. 
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9 ANALOG INPUTS 
The EMCP 3.1 has two analog inputs.  The EMCP 3.2 and 3.3 both have three analog inputs.  
Each input consists of two connector pins for use with two-wire resistive senders. One-wire 
senders can be used if the passive analog return pin is connected to the common chassis 
ground.  See ELECTRICAL CONNECTIONS Chapter 3.5 for illustrations on how to connect the 
sensors to the control. 

The first and second analog inputs have dedicated parameters. They cannot be programmed for 
other functions. The third analog input on EMCP 3.2 and 3.3 is called the SPARE ANALOG INPUT. 

• Analog input #1 is dedicated for ENGINE OIL PRESSURE. 

• Analog input #2 is dedicated for ENGINE COOLANT TEMPERATURE.   

• Analog Input #3 is configured to monitor ENGINE OIL TEMPERATURE by default. 

The first and second analog inputs will not be used for electronic engines that use ADEM™ A3, 
A4 or newer, engine ECM.  On these engines, the engine oil pressure sensor and the engine 
coolant temperature sensors are wired to the engine ECM and not to the generator set control.  
In order to receive the sensor information from the data link instead of from sensors wired into 
the EMCP 3, the setpoints Engine Oil Pressure Sensor Configuration and Engine Coolant 
Temperature Sensor Configuration must be set to Data Link.  If they are not set this way, the 
event log will contain diagnostics for the sensors, and the sensor values on the Engine 
Overview screen on the EMCP 3 GSC display will show  (asterisks). 

Note: These setpoints are protected by a Level 3 password.  For help on 
programming the Level 3 password prior to running this procedure, see 
Chapter 6 Security.  Alternately, the Caterpillar® Service Tool can be used to 
program these setpoints. 

PROGRAMMING USING DISPLAY 
To program the EMCP 3 sensors for Data Link input using the display, go through the following 
menu options (once Level 3 access has been obtained): 

At MAIN MENU  

SCROLL DOWN   to: 

 

 

CONFIGURE 

SCROLL DOWN   to: 

 
 

SETPOINTS 

SCROLL DOWN   to: 

ENG MONITOR/PROTECT 
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SCROLL DOWN   to:  ENG COOL TEMP MON 

If the setpoint is set to SENSOR then, to change Press ENTER KEY   

SCROLL DOWN   to: DATA LINK  Press ENTER KEY   

Press ESCAPE KEY     and SCROLL DOWN   to:  ENG OIL PRES MON  

If the setpoint is set to SENSOR then, to change Press ENTER KEY   

SCROLL DOWN   to: choose DATA LINK, then Press ENTER KEY   

PROGRAMMING USING CATERPILLAR® SERVICE TOOL 
To program the EMCP 3 sensors for Data Link input using the Caterpillar® Service Tool as 
shown in FIGURE 19, do the following steps: 

1. Connect to the EMCP 3 GSC using the Caterpillar® Service Tool 

2. Enter the Configuration Tool 

3. Select Engine Coolant Temperature Monitor on the left 

4. If the Engine Coolant Temperature Sensor Configuration is set to Sensor, change it to 
Data Link. 

5. Select Engine Oil Pressure Monitor on the left 

6. If the Engine Oil Pressure Sensor Configuration is set to Sensor, change it to Data Link. 
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FIGURE 19: SENSOR CONFIGURATION USING CATERPILLAR
®

 SERVICE TOOL  

NOTE:  3500 MUI Generator sets that have EMCP3 GSC software with a release 
date of Oct. 2006 or earlier are using a flash file that is different from the 
standard flash file. This flash file has different maps from the standard flash 
file to support the 3500 MUI engine. From Oct. 2006 released software 
supports both the standard and the 3500 MUI maps in the one flash file. The 
map that is used is determined by a setpoint corresponding to each analog 
input; Oil Pressure Sensor Map Selection Number and Coolant Temperature 
Sensor Map Selection Number. 

9.1 SPARE ANALOG INPUT (EMCP 3.2 & 3.3) 
The SPARE ANALOG INPUT has a sensor map in the software for ENGINE OIL TEMPERATURE.  This 
input can be programmed to monitor other parameters such as: 

TEMPERATURES 
Ambient Air Temperature 
Engine Oil Temperature 
Exhaust Temperature 
Right Exhaust Temperature 
Left Exhaust Temperature 
Generator Rear Bearing Temperature

PRESSURES 
Air Filter Differential Pressure 
Fire Extinguisher Pressure 
Fuel Filter Differential 
Pressure 
Oil Filter Differential Pressure 
Starting Air Pressure 

  
  
LEVELS 

Engine Coolant Level 
Engine Oil Level 
Fuel Level 
External Tank Fuel Level 

 

NOTE: There are 3 sensor maps in the software. Two of the maps are for 
temperature and the third map is for fuel level.  A pressure map is not 
currently included in the software. 

The spare Analog input is capable of reading resistance from 5 ohms up to 2000 ohms. There 
are three in-built maps to convert from the measured resistance to a value, these are: 
 

1) VDO Oil Temperature Map 

2) 3500MUI Oil Temperature Map 

3) Fozmula Fuel level Map 

 
Any value below the bottom point on the map or above the highest point on the map will raise a 
corresponding diagnostic event. 

WARNINGS AND SHUTDOWNS 



63 

9 ANALOG Inputs 

Each of these inputs can be configured to have HIGH WARNINGS, LOW WARNINGS, HIGH 
SHUTDOWNS and LOW SHUTDOWNS with configurable thresholds.  Also, all of the events 
associated with the analog inputs have programmable time delays.  For information on how to 
program these thresholds and time delays can be found in Chapter 7, Setpoints. 
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10 OUTPUTS 
The EMCP 3 has several outputs that can be configured for different behavior.  This chapter 
defines the outputs and explains how to configure them. 

RELAY OUTPUTS 
The EMCP 3.1 has six relay outputs and the EMCP 3.2 and 3.3 have eight relay outputs.  Each 
relay is capable of handling 2 A @ 30 V DC.  All six relays on the EMCP 3.1 GSC are type-A.   
The EMCP 3.2 and 3.3 have six relays which are type-A and two relays that are type-C.  

Note: Type-A relays have one normally-open contact and a common. Type-C relays have one 
normally-open contact, one normally-closed contact, and a common.  

CAUTION: These relays are VOLT FREE meaning that the commons are not 
referenced to anything within the GSC. The relay contacts are not 
protected against shorts to battery or ground. 

RELAY OUTPUT #1 is dedicated to control the starter motor on MUI engines.  On EUI engines, 
this relay may or may not be connected. 

RELAY OUTPUT #2 is dedicated to enable fuel on MUI engines. On EUI engines, this relay may 
or may not be connected. Consult your Genset package manuals.   

The six remaining Relay Outputs on the EMCP 3.2 and EMCP 3.3 (four remaining Relay 
Outputs on EMCP 3.1) are programmable for various other applications. 

DIGITAL OUTPUTS 
The EMCP 3.1 does not have any digital outputs.  The EMCP 3.2 has one digital output, and the 
EMCP 3.3 has two digital outputs.  Each output is a discrete 300 mA sinking driver output.  
These outputs are programmable for various applications. 

DIGITAL SELECTORS 
Relay outputs #3 and higher as well as digital outputs (on EMCP 3.2 and 3.3) are 
programmable and can be set to operate based on different conditions.  In order to select which 
condition controls the output, there are functions called DIGITAL SELECTORS associated with 
each relay output (#3 and higher) and digital output. This is shown in FIGURE 20, FIGURE 21, and 
FIGURE 22.   

• EMCP 3.1 has four (4) Digital Selectors (connected to Relay Outputs 3-6) 

• EMCP 3.2 has seven (7) Digital Selectors (connected to Relay Outputs 3-8 and 
Digital Output 1) 

• EMCP 3.3 has eight (8) Digital Selectors (connected to Relay Outputs 3-8 and 
Digital Outputs 1-2) 

The Digital Selector software acts like a 12 position switch for each relay and is used to 
determine which one of those conditions will actually be associated with each output.  For each 
output there are 10 different options of conditions that can make the output go ACTIVE, one 
option that will allow the output to be controlled with a SCADA data link command, and one 
condition to DISABLE the output altogether.  These options are shown in FIGURE 20, FIGURE 21, 
and FIGURE 22.  Definitions for these options are in Chapter 10.1, Digital Selector Options. 
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FIGURE 20  EMCP 3.1 OUTPUTS 
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FIGURE 21  EMCP 3.2  OUTPUTS 
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FIGURE 22  EMCP 3.3 OUTPUTS 
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10.1 DIGITAL SELECTOR OPTIONS 
The digital selector is a software function that acts like a 12 position switch, to determine the 
behavior of an output.  For each selector there are 10 unique conditions that can make the 
output go active, an option to control the output via the SCADA data link, and one option to 
disable the output altogether.  The 10 unique conditions for each selector are shown in FIGURE 
20, FIGURE 21, and FIGURE 22 above. 

The Disabled option causes the output to stay Inactive.  Inactive for the relay outputs means 
that the Normally Open relay contacts will remain open.  Inactive behavior for the digital outputs 
is determined by the Active State Configuration setpoint.  For more information on Setpoints and 
Configuring Outputs see the following Chapters; 10.2, Programming Outputs Using The Service 
Tool and 10.3, Programming Outputs Using The Display. 

The SCADA Data Link option allows outputs to be activated by commands sent via the Modbus 
(SCADA) Data Link.  These commands are sent via registers 628 through 636.  For more 
information, refer to Chapter 21.3, Discrete Inputs and Outputs. 

DEFINITIONS OF DIGITAL SELECTOR OPTIONS 
As shown in FIGURE 20, FIGURE 21, and FIGURE 22, the Digital Selectors can be configured to be 
driven by one of the following conditions (all conditions not available on all Digital Selectors):  

AIR SHUTOFF  
Activated by Emergency Stop condition 

Activated by Overspeed condition 

Automatically deactivates after 15 second delay 

AUTO MODE 
Activated after the Auto Key has been pressed (or a Modbus command is given to set 
Engine Operating Mode to Auto - register 302) and while the EMCP 3 GSC remains in the 
Auto mode 

BREAKER #1 TRIP  
Activated when any event occurs that has an event response configuration set for breaker 
trip 1.  See Chapter 5.1, Configuring Event Responses for more information. 

Deactivates when the event is neither present nor active. 

NOTE: This output does not control a circuit breaker unless the user makes the 
connections to do so. 

BREAKER #2 TRIP  
Activated when any event occurs that has an event response configuration set for breaker 
trip 2.  See section Chapter 5.1, Configuring Event Responses for more information. 

Deactivates when the event is neither present nor active 

NOTE: This output does not control a circuit breaker unless the user makes the 
connections to do so. 

COMMON ALARM  
Activated anytime the EMCP 3 GSC has a present or active warning or shutdown event in 
the event system. 

Deactivates when no warnings or shutdowns are present or active 
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COMMON WARNING  
Activated anytime the EMCP 3 GSC has a present or active warning event in the event 
system. 

Deactivates when no warnings are present or active. 

COMMON SHUTDOWN  
Activated anytime the EMCP 3 GSC has a present or active shutdown event in the event 
system.  

Deactivates when no shutdowns are present or active 

CRANK ALERT  
Requires setpoint Crank Alert Activation Time set greater than zero 

Activated when engine start is initiated, before engine begins to crank 

Deactivates after Crank Alert Activation Timer expires 

DISABLE AUX AC SUPPLY  
Intended to be used to disconnect the battery charger, heaters etc when the engine is 
running 

Activated when engine start is initiated 

Deactivates when engine is stopped: RPM=0 

ECU FAULT RESET  
For electronic engines that do not support J1939 communication. 

When Reset Engine Events is selected in the Event logs, it will activate for one second and 
then deactivate. This option is only available when the engine is set to Electronic and the 
communication is set to No J1939 communication. 

ENGINE START INITIATED  
Activated when engine start is initiated (engine is going to start, even when engine speed is 
still 0) 

Deactivates when engine stop is initiated (engine is going to stop, even when engine speed 
is still at rated speed) 

ENGINE STARTED  
Activated when engine has reached crank terminate speed 

Deactivates when engine is stopped: RPM=0 

EVENT OUTPUT FUNCTION  
Requires setpoint configuration for Event Output Function #1 

Activated while the event(s) configured for Event Output Function #1 is (are) active 

For more information on configuring and using the Event Output Function, see 
Programming Event Output Functions in Chapters; 10.2, Programming Outputs Using The 
Service Tool and 10.3, Programming Outputs Using The Display below. 

HIGH %KW 
Activated when Programmable Trip Point #1 is active.  Programmable Trip Point #1 
activates based on high %kW, according to user-configurable thresholds.  For more 
information on configuring the Programmable Trip Point function, see Chapter 15, 
Programmable Trip Point function. 
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HORN CONTROL  
Activated when any event occurs that has an event response configuration set for audible 
alert 

Deactivates when event is neither present or active or when the alarm acknowledge key is 
pressed 

IN COOLDOWN  
Requires setpoint Cooldown Duration set greater than zero 

Activated when engine stop has been initiated and cooldown cycle begins 

Deactivates when cooldown timer has expired and remains deactivated any time the genset 
is not in cooldown 

PCT OUTPUT #2 
Activated any time Output #2 of the Programmable Cycle Timer is Active 

For more information on configuring Programmable Cycle Timers, see Chapter 13, 
Programmable Cycle Timer. 

RATED SPEED COMMAND 
Activated when Rated Speed is commanded. Will always be active unless Idle Speed is 
commanded. 

NOTE: Intended to give a rated speed permissive signal to a governor 

RUN MODE 
Activated after the Run Key has been pressed (or a Modbus command is given to set 
Engine Operating Mode to Run - register 302)  and while the EMCP 3 GSC remains in the 
Run mode. 

START AID  
Requires setpoint Start Aid Activation Time set greater than zero 

Activated when engine start is initiated before the engine begins to crank 

Deactivates after Start Aid Activation Timer expires 

V & HZ WITHIN LIMITS  
Activated when measured generator voltage and frequency are both within the Warning 
thresholds for their respective parameters  

Deactivates when either measured generator voltage or frequency are outside of the 
Warning thresholds for their respective parameters  

10.2 PROGRAMMING OUTPUTS USING THE SERVICE TOOL 
Outputs can be configured by using the Caterpillar® Service Tool.  To begin, connect to the 
EMCP 3 GSC and select Service > Configuration from the menu to enter the Configuration Tool, 
FIGURE 23.  
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FIGURE 23 SELECTING CONFIGURATION   

The following sections will explain the steps involved in configuring an output, and walk through 
an example of configuring Relay Output 3 to Breaker #1 Trip and Digital Output 1 to Event 
Output Function on the EMCP 3.2.  The steps are identical for EMCP 3.1 and 3.3 (Digital Output 
1 doesn’t apply to the 3.1). 

NOTE:  Some setpoint values may be different from the screenshots; those may not 
be important to this example.  However, be aware that changing other 
setpoints will cause the EMCP 3 to behave differently, so any changes 
should be done carefully.  As always, it is recommended to save a setpoint 
configuration file before making any changes as shown in Chapter 12, 
Saving and Restoring Setpoints. 

PROGRAMMING DIGITAL SELECTORS 
To program a Digital Selector, select Digital Selectors from the left pane.   Edit the Digital 
Selector Source Configuration for the appropriate Digital Selector.  The options given are 
Disabled, Data Link, and Input #1 through Input #10.  Refer to in FIGURE 20, FIGURE 21, and 
FIGURE 22 to determine which input corresponds to which option. 

The EMCP 3.2 has seven (7) Digital Selectors.  As the screenshot shows FIGURE 24, more are 
listed, but are given as Disabled or Not Installed.  This means they don’t apply to the EMCP 3.2.  

 

 
FIGURE 24  SELECTING DIGITAL SELECTOR 
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To configure Relay Output 3 to Breaker #1 Trip, the corresponding Digital Selector must be 
configured.  Referring back to FIGURE 21, note that Digital Selector 1 is tied to Relay Output 3.  
Breaker #1 Trip is Input 7.   

Modify Digital Selector #1 Source Configuration, selecting Input #7, Figure 25.  

 
FIGURE 25  SELECTING INPUT #7 

Similarly, note that Digital Selector #7 is tied to Digital Output 1, and Event Output Function is 
Input 6.  So modify Digital Selector #7 Source Configuration, selecting Input #6.  The resulting 
settings are shown below, FIGURE 26. 

 

 
FIGURE 26  SELECTOR #7 RESULTS 
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PROGRAMMING EVENT OUTPUT FUNCTIONS 
If it is desired to trigger an output based on an event or a set of events, then an additional step 
is required after one of the Digital Selectors is configured for Event Output Function (as was 
done for Digital Selector 7 in the example above).  This is to define the type of event(s) that will 
activate the output. 

The EMCP 3.2 only has one (1) Event Output Function.  Two setpoints define the Event Output 
Function. 

EVENT OUTPUT FUNCTION #1 SUSPECT PARAMETER NUMBER: Every event in the EMCP 3 system 
is defined with an SPN and FMI.  This is the SPN.  The Caterpillar® Service Tool shows the 
parameter list, allowing any one to be selected.  The SPN selected here does not matter if it is 
used to drive the output based on a general type of event such as warnings, shutdowns, etc. 

EVENT OUTPUT FUNCTION #1 TRIGGER CONDITION: This setpoint defines the FMI (Failure Mode 
Identifier) or set of FMIs that will trigger the output.  It is also used to determine whether the 
output should be driven only by an event with a specific SPN (called a Specific Event), or any 
SPN that has a certain FMI (called a General Event).  The General Event options are meant for 
special cases.  If it is used to drive an output based on any warning or shutdown, it is 
recommended to configure a Digital Selector to Common Warning, Common Shutdown, or 
Common Alarm, instead of using the General Event options. 

EXAMPLE 1: Configuring the Event Output Function for any fault related to the Accessory Data 
Link. 

Set Event Output Function #1 Suspect Parameter Number to Accessory Data Link, and set 
Event Output Function #1 Trigger Condition to Specific Event - Any Warning, Shutdown, or 
Diagnostic, FIGURE 27 . 
 
 

 

 
Figure 27  Configuring the Event Output Function 

 
EXAMPLE 2: Configuring the Event Output Function for Custom Event #1 Condition Exists (for 
example, if using the Custom Event from Event Input Function #1). 

Set Event Output Function #1 Suspect Parameter Number to Custom Event #1 (the number 
matches with the Event Input Function number), and set Event Output Function #1 Trigger 
Condition to Specific Event - Condition Exists, FIGURE 28. 
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FIGURE 28  SPECIFIC EVENT 

PROGRAMMING RELAY OUTPUTS 
Relay Outputs 1-6 are Form-A relays, which means they only have Normally Open contacts.  
The polarity of these relays are not configurable.  They are viewable on the Caterpillar® Service 
Tool, by selecting Relay Outputs in the left pane.  All of the outputs are configured with an active 
state of High, indicating that the contacts are closed when the condition is active (indicating that 
the relays behave as Normally Open relays), Figure 29. 

 

 
FIGURE 29  RELAY OUTPUTS 

NOTE: Read-only setpoints do not look different from other setpoints on the 
Caterpillar® Service Tool.  However, if the setpoint is modified, the Service 
Tool will return an error, as shown below in the following set of screenshots, 
FIGURES 30, 31, and 32. 
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FIGURE 30  READ-ONLY SETPOINT ERROR 

 
FIGURE 31  READ-ONLY SETPOINT ERROR 

 
FIGURE 32  READ-ONLY SETPOINT ERROR 

Relay Outputs 7 and 8 (available on 3.2 and 3.3) are Form-C relays, which means that both 
Normally Open and Normally Closed contacts are available.  Changing the polarity involves 
rewiring to the opposite pin.  The pins for Relay Outputs 7 and 8 are listed here.   
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EMCP 3 70-PIN AMP CONNECTOR  

Pin # Function 
1 Relay 8 Normally Open (NO) Contact 
2 Relay 7 Normally Open (NO) Contact 
14 Relay 8 Normally Closed (NC) Contact 
15 Relay 7 Normally Closed (NC) Contact 
24 Relay 8 Common 
25 Relay 7 Common 

 
For more wiring details, see Figure 2 and Figure 3 in Chapter 3.7, EMCP 3.1, 3.2, 3.3  Electrical 
Diagrams. 

PROGRAMMING DIGITAL OUTPUTS (EMCP 3.2 AND 3.3) 
Digital Outputs have a sinking driver output.  When the condition controlling the output becomes 
active, the default setting of High for the Digital Output Active State Configuration causes the 
output to be pulled to battery negative voltage.  This will turn on a circuit that is wired between 
the output and battery voltage.  When the condition controlling the output is inactive, the default 
setting of High for the Digital Output Active State Configuration causes the output to be floating.  
This will turn off the circuit that is wired between the output and battery voltage. 

To reverse this polarity (i.e. turn on a circuit when the controlling condition is inactive), select 
Digital Outputs from the left pane and change the Active State Configuration for the desired 
output to Low, FIGURE 33. 

 

 
FIGURE 33 ACTIVE STATE CONFIGURATION 

10.3 PROGRAMMING OUTPUTS USING THE DISPLAY 
Outputs can be configured by using the EMCP 3 display.  For some of the setpoints, LEVEL 2 
ACCESS is required.  For information on obtaining Level 2 Access refer to Chapter 6, Security.  
This section will assume that Level 2 Access has already been obtained. 

The following explains the steps involved in configuring an output, and includes a walk through 
example for configuring Relay Output 3 to Breaker #1 Trip and Digital Output 1 to Event Output 
Function on the EMCP 3.2. The steps are identical for EMCP 3.1 and 3.3 (except Digital Output 
1 doesn’t apply to the 3.1) although the screens may look slightly different. 
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PROGRAMMING DIGITAL SELECTORS 
To program the Digital Selectors, go through the following menu options. 

MAIN MENU  

 

scroll down   to: 

CONFIGURE  

enter key   

MAIN MENU
AC OVERVIEW
CONFIGURE

 

scroll down   to: 

Setpoints  

enter key   

CONFIGURE
SECURITY
SETPOINTS

 

scroll down   to: 

OTHER  

enter key   

SETPOINTS
NETWORK
OTHER

 

DIGITAL SELECTORS  

enter key   
 

 

enter key   to configure Digital Selector #1 

enter key   
 

to edit the Source Configuration.  The options are 
Disabled, Use Input #1 (through #10), and finally Data 
Link.  Refer to Figure 20, Figure 21, and Figure 22 to 
determine which input corresponds to which option. 

In order to configure Relay Output 3 to Breaker #1 Trip, the corresponding Digital Selector must 
be configured.  Referring back to Figure 21, note that Digital Selector 1 is tied to Relay Output 3.  
Breaker #1 Trip is Input 7.  So  
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scroll down   to: 

USE INPUT #7 

 
to select Use Input #7. 

enter key   
 

Similarly, note that Digital Selector #7 is tied to Digital Output 1, and Event Output Function is 
Input 6. 

ESCAPE KEY  to return to the list of Digital Selectors 

scroll down   to: 

DIGITAL SELECTOR #7 

 

enter key   
 

enter key   to edit the Source Configuration. 

SCROLL DOWN   TO: 

USE INPUT #6 

 

enter key   
 

PROGRAMMING EVENT OUTPUT FUNCTIONS 
If it is desired to trigger an output based on an event or a set of events, then an additional step 
is required after one of the Digital Selectors is configured for Event Output Function (as was 
done for Digital Selector 7 in the example above).  This is to define the type of event(s) that will 
activate the output. 

TO PROGRAM EVENT OUTPUT FUNCTIONS, go through the following menu options: 

MAIN MENU 
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scroll down   to: 

CONFIGURE 
MAIN MENU
AC OVERVIEW
CONFIGURE

 

ENTER KEY    

scroll down   to: 

SETPOINTS 

enter key   

CONFIGURE
SECURITY
SETPOINTS

 

scroll down   to: 

EVENTS 

 

scroll down   to: 

EVENT O/P FUNCTIONS 

 

ENTER KEY    
 

to edit 

EVENT OUTPUT FUNCTION #1 
  

ENTER KEY    
 

The EMCP 3.2 only has one (1) Event Output Function.  Two setpoints define the Event Output 
Function. 

EVENT OUTPUT FUNCTION #1 TRIGGER CONDITION: This setpoint defines the FMI or set of FMIs 
that will trigger the output.  It is also used to determine whether the output should be driven only 
by an event with a specific SPN (called a Specific Event), or any SPN that has a certain FMI 
(called a General Event).  The General Event options are only intended for special cases.  If it is 
desired to drive an output based on any warning or shutdown, it is recommended to configure a 
Digital Selector to Common Warning, Common Shutdown, or Common Alarm, instead of using 
the General Event options. 

EVENT OUTPUT FUNCTION #1 SUSPECT PARAMETER NUMBER: Every event in the EMCP 3 system 
is defined with an SPN and FMI.  This is the SPN.  The Caterpillar® Service Tool shows the 
parameter list, allowing any one to be selected.  If it is desired to drive the output based on a 
general type of event (for example, any warning, any shutdown, etc), then the SPN selected 
here does not matter. 
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EXAMPLE 1: Configuring the Event Output Function for any fault related to the Accessory Data 
Link. 

Set Event Output Function #1 Suspect Parameter Number to Accessory Data Link, and set 
Event Output Function #1 Trigger Condition to Specific Event - Any Warning, Shutdown, or 
Diagnostic. 

 

to edit  

TRIGGER CONDITION 

 

ENTER KEY   . 

Scroll Up  or Scroll Down  until Specific Event - Any Warning, Shutdown, or Diagnostic 
is  shown (an abbreviated text is shown due to space limitations).   

 

 

ENTER KEY    

 
EXAMPLE 2: Configuring the Event Output Function for Custom Event #1 Condition Exists (for 
example, if using the Custom Event from Event Input Function #1). 

Set Event Output Function #1 Suspect Parameter Number to Custom Event #1 (the number 
matches with the Event Input Function number), and set Event Output Function #1 Trigger 
Condition to Specific Event - Condition Exists (this options reads CONDITION EXISTS on the 
EMCP 3.1 or 3.2 display, and SPC CONDITION EXISTS on the EMCP 3.3 display). 

PROGRAMMING RELAY OUTPUTS 
Relay Outputs 1-6 are Form-A relays, which means they only have Normally Open contacts.  
The polarity of these relays are not configurable.  They are viewable on the display by going 
through the following menu options: 

MAIN MENU  

scroll down   to: 

CONFIGURE  

enter key   

MAIN MENU
AC OVERVIEW
CONFIGURE
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scroll down   to: 

Setpoints  

enter key   

CONFIGURE
SECURITY
SETPOINTS

 

scroll down   to: 

 I/O  
ENTER KEY   

 

scroll down   to: 

RELAY OUTPUTS 
 ENTER KEY   

 

Select any of the outputs 

 

 ENTER KEY   

 
 
All of the outputs are configured with an active state of High, indicating that the contacts are 
closed when the condition is active (indicating that the relays behave as Normally Open relays). 

NOTE: The lock icon with no number after it indicates that the setpoint can not be 
changed from the display. 

Relay Outputs 7 and 8 (available on 3.2 and 3.3) are Form-C relays, which means that both 
Normally Open and Normally Closed contacts are available.  Changing the polarity involves 
rewiring to the opposite pin.  The pins for Relay Outputs 7 and 8 are listed here.  For more 
wiring details, see Figure 2 and Figure 3 in Chapter 3.7, EMCP 3.1, 3.2, 3.3  Electrical 
Diagrams. 

 
EMCP 3 70-PIN AMP CONNECTOR 

Pin # Function 
1 Relay 8 Normally Open (NO) Contact 
2 Relay 7 Normally Open (NO) Contact 
14 Relay 8 Normally Closed (NC) Contact 
15 Relay 7 Normally Closed (NC) Contact 
24 Relay 8 Common 
25 Relay 7 Common 

PROGRAMMING DIGITAL OUTPUTS (EMCP 3.2 AND 3.3)  
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Digital Outputs have a sinking driver output.  When the condition controlling the output becomes 
active, the default setting of High for the Digital Output Active State Configuration causes the 
output to be pulled to battery negative voltage.  This will turn on a circuit that is wired between 
the output and battery voltage.  When the condition controlling the output is inactive, the default 
setting of High for the Digital Output Active State Configuration causes the output to be floating.  
This will turn off the circuit that is wired between the output and battery voltage. 

To reverse this state (i.e. turn on a circuit when the controlling condition is inactive), go through 
the following menu options: 

 

MAIN MENU  

scroll down   to: 

CONFIGURE  

enter key   

MAIN MENU
AC OVERVIEW
CONFIGURE

 

scroll down   to: 

Setpoints  

enter key   

CONFIGURE
SECURITY
SETPOINTS

 

scroll down   to: 

 I/O  
ENTER KEY   

 

scroll down   to: 

DIGITAL OUTPUTS 
 ENTER KEY   

 

to edit  

DIGITAL OUTPUT #1 
ENTER KEY   

  
EMCP 3.2 

(or scroll down to select Digital Output #2, EMCP 3.3 only) 

 
EMCP 3.3 
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to edit 

ACTIVE STATE CONFIGURATION 

 

ENTER KEY    

to select  

LOW 

scroll up  

 

ENTER KEY    
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11 MODIFIABLE TEXT STRINGS 
The EMCP 3 GSC supports the customization of event names in the event log. This feature 
called MODIFIABLE TEXT STRINGS.    

The MODIFIABLE TEXT STRINGS feature uses events called CUSTOM EVENTS. These are special 
events that can be configured to display a custom text string in the event log, which is useful 
when an existing SPN and text string does not exist for the required event. These events can be 
configured and triggered similar to other events.  However, these events are unique in that their 
displayed text strings can be customized via the Caterpillar® Service Tool using any character in 
the supported character set of the EMCP 3 GSC software flash file.  Furthermore, the 
Caterpillar® Service Tool has the capability to upload a Modifiable Text Strings configuration file 
(containing previously saved custom event text strings) from the computer, or download a 
configuration from the EMCP 3 GSC to the computer. 

In order to display a custom text string for an event, following steps must be taken: 

1. One of the Event Input Functions must be configured with a Suspect Parameter 
Number (SPN) of Custom Event and a Failure Mode Identifier (SPN) of Status (or 
Condition Exists).  For more information on configuring Event Input Functions, see 
Chapter 8.1. 

2. A custom string must be entered, using the Modifiable Text Strings tool in the 
Caterpillar® Service Tool, as described in Chapter 11.2. 

3. The language must be set to the customer language, not to Technician English. 

An example of the modifiable text strings is given below. FIGURE  34 shows the setting within the 
Caterpillar® Service Tool that customizes the text description of Custom Event #1.  FIGURE  35 
shows the event log view of the event when it has become present, as viewed in Technician 
English.  FIGURE 36 shows the same as above, viewed in the secondary language (in this case, 
English). 

 
FIGURE  34 : CUSTOMIZING A TEXT STRING IN CATERPILLAR

®
 SERVICE TOOL 

 

  

FIGURE  35 : BEFORE CUSTOMIZING THE TEXT STRING FIGURE 36: AFTER CUSTOMIZING THE TEXT STRING 
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The Modifiable Text Strings functionality differs between EMCP 3 GSC platforms and language 
sets.  The EMCP 3.1 supports up to six Custom Events; the EMCP 3.2 and 3.3 support up to 
eight Custom Events.  Because of their differences in screen resolution, the display platforms 
also differ in the number of pixels allowed (characters vary in width) in the custom event name.   

Different language sets support a different set of characters.  Due to all of these differences, 
Modifiable Text String configuration files have limited portability between EMCP 3 GSC 
modules. 

11.1 LANGUAGE SUPPORT 
The primary language for the EMCP 3 GSC control will always be U.S. (Technician) English.  
The user will always be able to revert back to Technician English from the selected language 
that is supported by the flash file.  However, when the EMCP 3 GSC display is viewed in 
Technician English, the user will not be able to view the custom text strings and will only be able 
to view the default strings (as in FIGURE  35) for a given input.    

The EMCP 3 GSC has the capability of supporting one flash file containing one secondary 
language at any particular time.  If the user is interested in having a new secondary language, a 
new flash file to configure the new language must be installed.  Therefore, the user will not be 
allowed to install multiple flash files supporting different languages. 

The EMCP 3 GSC supports Unicode characters from the English character set, as well as the 
character set from the local language supported by the file.  It is the user’s responsibility to 
install the preferred flash file with the correct language support that will allow the modification of 
text strings.    

The user is also responsible for choosing the appropriate operating system or Unicode text 
entry system for the chosen language.  The Caterpillar® Service Tool software accepts input 
from the PC keyboard settings.  If, for example, the PC keyboard setting is for U.S. English, it 
may be difficult to enter Russian (or other non-English) characters.  

11.2 MODIFIABLE TEXT STRING CONFIGURATION FILE 
The user will have the capability of transferring the custom text string data to and from the 
EMCP 3 GSC by means of the Caterpillar® Service Tool, and the capability of modifying the 
configuration file offline.  When not connected to the Caterpillar® Service Tool, the user has the 
ability to make changes to a saved configuration file by navigating to the menu File > Open > 
Modifiable String Data File, as shown in the FIGURE 37 below.  
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FIGURE 37: CATERPILLAR  SERVICE TOOL EMCP 3 GSC OFFLINE EDITING 

The user is prompted to select a previously saved file in XML format, to edit, as shown in 
FIGURE 38. 

 

 
FIGURE 38 : CATERPILLAR

®
 SERVICE TOOL EMCP 3 GSC OFFLINE CONFIGURATION FILE SELECTION 
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FIGURE  39  : CATERPILLAR
®

 SERVICE TOOL EMCP 3 GSC OFFLINE CONFIGURATION FILE EDITING 

NOTE: The user must Save any offline changes before attempting to connect the 
Service Tool to the EMCP 3 GSC, or the changes will not be saved as 
shown in FIGURE 39.   

Besides Offline Editing, the user will have the capability of uploading and downloading a 
configuration data when Online.  The configuration file (same file for offline or online editing) 
includes but is not limited to, the following data: 

• The language ID 

• Configurable parameter value name current strings 

• List of Unicode characters that the EMCP 3 GSC supports 

• Pixel Width of each Unicode character 

11.3 PROGRAMMING MODIFIABLE TEXT STRINGS USING CATERPILLAR® 
SERVICE TOOL 
The Modifiable Text Strings are programmable via the Caterpillar® Service Tool, version 2005B 
v2.0 or later.   
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In order to update or change the Modifiable Text String values, the following menu options are 
accessible via the Caterpillar’s Service Tool, keeping in mind that the Modifiable Text String 
parameters can ONLY be updated when the EMCP 3 GSC is in the STOP position.  After 
connecting to the EMCP 3 GSC, navigate to the menu Service > Modifiable Strings. 

 

 
FIGURE 40 : CATERPILLAR

®
 SERVICE TOOL EMCP 3 GSC SUMMARY SCREEN 

There are two options accessible from the Modifiable String screen (Load from ECM and Load 
from File).  The user must select one of the options before editing the Modifiable Text Strings.  
Considering that the option of programming Modifiable Text String is usually completed upon 
initial setup, the user should access the Load from ECM option.  The service tool is now 
collecting information from the control and will display the following message:  Loading Data 
From ECM.   

After the downloading of data from the EMCP 3 GSC to the service tool, the user is now able to 
enter the modifiable text strings.   The Modifiable Text String are considered a pair,  and the 
user has the option of customizing the pair of text strings.  Therefore, the user is allowed to 
enter two lines of Custom Text as displayed in the figure below.  The user is able to save the 
entered custom text strings and has the option of saving the Custom text strings to the display 
or a file.     

 

 
FIGURE 41: ENTERING A STRING IN THE CATERPILLAR

®
 SERVICE TOOL MODIFIABLE TEXT STRING SCREEN 

The lavender box at the left near the top of the service tool Modifiable Strings screen shows the 
entered text in the final font and character spacing, and indicates how much space is remaining 
on the EMCP 3 GSC display line.  The second line has less available space, because the event 
log index is also displayed on that line (see FIGURE 41). 
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NOTE: The Modifiable Text String parameter value’s field is initially blank until it is 
replaced with a custom text string parameter value.  The custom text string 
parameter value entered will replace the default strings.  

Remember only when you Save To ECM will the changes made be uploaded to the EMCP 3 
GSC and take effect. Then the EMCP 3 GSC will display the custom text string parameter 
value(s) in the flash file secondary language.  The user’s custom text string parameter(s) are 
displayed only when an event FMI 31 for the custom event is triggered.  

When viewing the display in Technician English, the user will only have access to the Default 
Strings.   Since the Modifiable Text Strings are offered as a string pair, the default strings will be 
displayed as Custom Event #1 on the first line, and Status on the second line. 

The user’s Custom Text Strings are displayed in the user’s preferred language.  If the service 
tool doesn’t support the user’s preferred language, US English will be used.  

11.4 TROUBLESHOOTING MODIFIABLE TEXT STRINGS 
The following are a common problems with Modifiable Text String and the steps you can take to 
resolve them. 

PROBLEM: I AM UNABLE TO VIEW THE CUSTOM EVENT AT ALL 
TEST STEP 1. CHECK FOR WIRING PROBLEMS. 

From the Main Menu, select I/O Status. When you activate the input, does the 
appropriate input indication change?  If not, check your wiring.  The input should be 
wired between the appropriate digital input pin and ground (-BATT). 

EXPECTED RESULT: 
When you flip the switch that is wired between the proper input pin and (-BATT), the I/O 
Status screen indication changes from a hyphen (-) to a number (depending on which 
number input you are switching). 

RESULTS: 
OK - The wiring and indication on the EMCP 3 GSC are okay.  Proceed to Test Step 2. 
NOT OK - The wiring needs correction.  Stop and repair. 

 

TEST STEP 2. IS THE EVENT INPUT FUNCTION CONFIGURED FOR THE CUSTOM EVENT?  
In order to show the custom text string in the event log, the EVENT INPUT FUNCTION #X SUSPECT 
PARAMETER NUMBER must be configured for a special type of event called CUSTOM EVENT, and 
the FAILURE MODE IDENTIFIER must be set to CONDITION EXISTS. 

Be aware of a numbering offset.  Digital Input #3 triggers Event Input Function #1, which 
(if configured properly) triggers Custom Event #1.  For higher numbered Digital Inputs, 
the numbers increase correspondingly. 

EXPECTED RESULT: 
The Event Input Function #1 Suspect Parameter Number (if using Digital Input #3) is 
configured for Custom Event, and the Event Input Function #3 Failure Mode Identifier is 
configured for Condition Exists (called Status on the Service Tool) 

RESULTS: 
OK - The setpoints are configured correctly.  Proceed to Test Step 3. 
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NOT OK - The setpoints need to be changed.  You need either security level 2 access, or 
access to the Service Tool, to change these setpoints.  If changing the Suspect 
Parameter Number setpoint from the control panel display, first the category Others 
must be selected, and then Custom Event (the items are not in alphabetical order). 
 

TEST STEP 3. IS THE EVENT RESPONSE ENABLED? 
Each type of event, such as Custom Event #1 Condition Exists,  has an associated 
Event Response Configuration, which must be enabled for the event to show up in the 
event log. 

EXPECTED RESULT: 
Custom Event #n Condition Exists Event Response Configuration (the setpoint name 
may or may not include the words Condition Exists) for the particular custom event you 
are trying to trigger, should be set to Warning, Soft Shutdown, Hard Shutdown or Active 
Only (other settings are optional). 

RESULTS: 
OK - The setpoint is already configured for one of those (warning, soft shutdown, hard 
shutdown or Active Only).  Please, call your customer support representative for further 
assistance. 
NOT OK - The setpoint needs to be changed.  You need either security level 2 access, or 
access to the Service Tool, to change this setpoint.  Make sure the ECS is set to STOP 
before attempting to change this setpoint. 

 

PROBLEM: THE CUSTOM EVENT IS VIEWABLE BUT, THE DEFAULT TEXT IS SHOWN ON 
THE EMCP 3 GSC DISPLAY INSTEAD OF THE USER’S CUSTOM STRING 
TEST STEP 1. VERIFY THAT THE CONTROL PANEL DISPLAY IS SET TO THE PRIMARY LANGUAGE. 

The control panel display supports a user language (which may be English, or perhaps a 
different language) as well TECHNICIAN ENGLISH.  If your primary language is English, 
you may not notice that the display is set to TECHNICIAN ENGLISH. 

NOTE: User language of ENGLISH and TECHNICIAN ENGLISH look nearly identical. 

You can change the language setting from the Main Menu by selecting Preferences > 
Language. 

NOTE: PREFERENCES is the bottom item in the Main Menu, and LANGUAGE is the 
bottom item in the Preferences menu.  This facilitates changing from a 
language the user does not understand to a language the user does 
understand. 

EXPECTED RESULT: 
Check the language setting.  TECHNICIAN ENGLISH should NOT be selected. 

 

RESULTS: 
OK - The language is not set to TECHNICIAN ENGLISH.  Proceed to Test Step 2. 

NOT OK - Scroll down to the primary language and press the Enter key on the EMCP 3 
GSC display to change the language.  Go back into the event log and verify that the 
custom string is being displayed for the Custom Event when the corresponding input is 
activated. 
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TEST STEP 2. VERIFY A CUSTOM STRING 
Verify that a custom string was created and uploaded using the Caterpillar® Service Tool 
Modifiable Text Strings tool. 
Enter the Modifiable Text Strings tool and press the button reading Load from ECM (the 
button may read Load from Display instead).  Verify that the Custom Event you are 
trying to display with a custom text string has the custom string displayed here. 

EXPECTED RESULT: 
There is a text string shown to the right of the custom event you are trying to configure.  
For example, in FIGURE  39, Custom Event #1, #5, and #6 DO NOT have a custom string 
defined, but Custom Event #2, #3, and #4 DO have custom strings defined. 

RESULTS: 
OK - There is a custom string defined for the Custom Event I am trying to configure.  
Proceed to Test Step 3. 
NOT OK - A custom string needs to be entered.  Double-click to the right of either Line 1 
or Line 2 of the Custom Event, and type in your custom string. When you are finished, 
press the button reading Save To ECM to upload your changes to the EMCP 3.2 
 

TEST STEP 3.  VERIFY THAT YOU ARE TRIGGERING A STATUS EVENT. 
The Event Input Function Failure Mode Identifier corresponding to the Custom Event you 
are trying to trigger should be set to Condition Exists or Status (even if the custom event 
you is a high or low warning or shutdown). 

EXPECTED RESULT: 
Check the event log entry for the Custom Event.  Does it read STATUS on the second 
line?  The others, LOW WARNING, LOW SHUTDOWN, HIGH WARNING, or HIGH 
SHUTDOWN, cannot be displayed with custom text. 

NOTE: This does not mean you cannot configure the custom event to trigger a 
warning or shutdown.  Simply configure the Custom Event #x Condition 
Exists Event Response Configuration (the setpoint name may or may not 
include the words Condition Exists) to trigger a Warning, Soft Shutdown, or 
Hard Shutdown.  You may want to indicate the type of action taken in your 
custom text string.  For example BUILDING FIRE DETECTED WARNING 
versus BUILDING FIRE DETECTED SHUTDOWN. 

RESULTS: 
OK - The event does read CUSTOM EVENT on line 1 and STATUS on line 2.  Please, 
call your customer support representative for further assistance. 
NOT OK - Reconfigure the desired Event Input Function Failure Mode Identifier to 
Condition Exists or Status. 
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12 SAVING AND RESTORING SETPOINTS 
The EMCP 3 GSC supports the saving and uploading of the EMCP 3 GSC setpoints through a 
setpoint configuration file.  This file, called the ECM Replacement File, is accessible via the 
ECM Replacement tool of the Caterpillar® Service Tool software. The file contains information 
specific to the EMCP 3 GSC, and includes the setpoint values that are specific to a given EMCP 
3 GSC module.  The user has the option of saving the data to an ECM Replacement File from 
an EMCP 3 GSC module or uploading the data from the ECM Replacement File to another 
EMCP 3 GSC module.  The user also has the option of uploading general configuration data to 
several EMCP 3 GSC modules by means of a similar tool called Fleet Configuration.  Both of 
these options are accomplished through the Caterpillar® Service Tool software. 

NOTE: This Chapter only addresses setpoints residing in the EMCP 3 GSC. To save 
and restore setpoints for other (optional) modules on the EMCP 3 J1939 
data links, a similar procedure must be followed for each individual module.  
For more information refer to Chapter 17, Optional Modules. 

12.1 SAVING EMCP 3 CONFIGURATION DATA 
To save an EMCP 3 GSC configuration use the Caterpillar® Service Tool.   

The EMCP 3 GSC configuration should be saved upon initial access or after the initial 
configuration. This will be required for future accessibility when exchanging or replacing the 
EMCP 3 GSC module.   

After connecting to the EMCP 3 GSC, navigate to the Menu Service > COPY CONFIGURATION.  
There are two options: (See FIGURE 42). 

• Fleet Configuration  

• ECM Replacement  

 

 
FIGURE 42: CATERPILLAR

®
 SERVICE TOOL EMCP 3 GSC SUMMARY SCREEN 

FLEET CONFIGURATION OPTION 
Select the FLEET CONFIGURATION option when there is a need to save and copy GENERAL DATA 
to several ECMs (non-module-specific).   

The FLEET CONFIGURATION tool works very similar to the ECM Replacement tool, with the 
exception of module-specific data such as ENGINE SERIAL NUMBER.  
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ECM REPLACEMENT OPTION 
To save EMCP 3 GSC configuration data to an ECM Replacement file:  

Select from the Service Tool menu:  

SERVICE  > 

COPY CONFIGURATION  > 

ECM REPLACEMENT  
If there are no previously saved field replacement files, the following message is displayed:  No 
Data Is Available. Load From ECM Now.   

Select which ECM’s configuration data is to be viewed and/or saved for future use. This 
configuration data to be saved in the ECM Replacement file is shown in FIGURE 43.  

NOTE: The option of deselecting certain setpoints can be chosen at this screen.   

After any selection changes are completed, the user must choose SAVE TO FILE. The ECM 
replacement file is now saved for future access.   Make sure to note what directory and folder 
the file is stored at. 

 

 
FIGURE 43: CATERPILLAR

®
 SERVICE TOOL ECM REPLACEMENT SCREEN 
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NOTE: The configuration data must be saved to a file before disconnecting from the 
service tool or the data WILL BE LOST and must be re-loaded from the source 
module again. 

12.2 LOADING EMCP 3 CONFIGURATION DATA 
The loading of EMCP 3 GSC configuration data is very similar between ECM REPLACEMENT and 
FLEET CONFIGURATION.  For illustration purposes, the ECM REPLACEMENT option will be 
described here. 

CONFIGURATION DATA 
To load EMCP 3 GSC configuration data from an ECM Replacement file, the user must select 
from the Service Tool menu:  

Service >  

Copy Configuration >  

ECM Replacement 
If there exists a previously saved ECM Replacement file, the tool will allow the user to select 
between them, as shown in FIGURE 44.  If there are no previously saved ECM Replacement 
files, the user must first load configuration data from an EMCP 3 GSC module.  For instructions 
on loading configuration data from an EMCP 3 GSC module, see Chapter 12.1, SAVING EMCP 
3 CONFIGURATION DATA. 
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FIGURE 44 : CATERPILLAR
®

 SERVICE TOOL FIELD REPLACEMENT FILE SELECTION 

NOTE: ECM Replacement files are stored in the ECM Replacement folder, while 
Fleet Configuration files are stored in the Fleet Configuration folder.   

The list of setpoints and values are shown after opening an ECM Replacement file.   

DESELECTING SETPOINTS 
The user has the option of deselecting certain setpoints, if the user wants to keep the values 
currently configured into the connected EMCP 3 GSC module.  The user may upload the 
selected setpoints into the new EMCP 3 GSC by pressing the PROGRAM ECM button.  The user 
is then prompted with the ECM selector box.  The EMCP 3 GSC should be highlighted since it is 
being programmed. FIGURE 45 below displays the programming of an EMCP 3 GSC with the 
setpoint values from an ECM Replacement file.  

 

 
FIGURE 45: CATERPILLAR

®
 SERVICE TOOL  

When the field replacement file has been successfully programmed to the new EMCP 3 GSC, a 
PROGRAMMING COMPLETE box will display.  Press OK. 

The above steps, for uploading saved configuration data, will need to be repeated for each 
EMCP 3 GSC module needing same or similar setpoint configurations. 
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NOTE: When programming EVENT RESPONSE CONFIGURATION setpoints, the 
control must be in STOP mode. If the control is not in STOP, there will be a 
message after the programming is complete. The message will show that 
none of the Event Response Configuration setpoints were changed. 
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13 PROGRAMMABLE CYCLE TIMER (EMCP 3.2 & 3.3) 
The Programmable Cycle Timer (PCT) feature allows the operator to program seven 
independent times when tasks, called PCT Outputs, will be activated or deactivated 
automatically during the week. This is useful for cases where two or more generators are 
required to automatically share the duty of supplying a load throughout the week.  

Using PCT, each genset can be programmed to start and stop at pre-set times.  

For example: if a standby set does not have access to a utility supply to power a trickle charger, 
the PCT can be set for an hour a week to keep the battery well charged.  

CAUTION: The co-operation of a transfer switch is required to ensure that the 
gensets are not stopped on load. 

The PCT FEATURE consists of seven independent timers; each timer has the following setpoints 
(setpoints shown are for PCT #1): 

PROGRAMMABLE CYCLE TIMER #1: Activation Day of the Week:  
This permits independent selection of each day (Sun -> Sat) that the timer will 
activate. 

PROGRAMMABLE CYCLE TIMER #1: Activation Start Time 
 The time of day (in hours and minutes) that the timer will activate. 

PROGRAMMABLE CYCLE TIMER #1: Active Time 
The duration (in hours and minutes) for which the timer will be active (up to 24 
hours). 

PROGRAMMABLE CYCLE TIMER #1: Output #1 Activation Configuration 
Whether the Programmable Cycle Timer’s first output will be activated when this 
timer is active.  

PROGRAMMABLE CYCLE TIMER #1: Output #2 Activation Configuration 
Whether the Programmable Cycle Timer’s second output will be activated when this 
timer is active.  

The PCT has two internal outputs; these should not be confused with the physical outputs of the 
control. The outputs are connected internally to the control module. In the standard 
configuration, PCT OUTPUT #1 is connected to a Remote Initiate command. OUTPUT #2 is 
connected via DIGITAL SELECTOR #6 to RELAY OUTPUT #8.  This effectively allows the operator 
to configure a timed relay, for external connectivity. 

The status of the PCTs can be found within the menu structure at: 

CONTROL -> PROG CYCLE TIMER -- (See FIGURE 46). 

The TOP ROW displays the seven PCTs (#1 through #7).  
The MIDDLE row is for OUTPUT #1.  
The LAST row is for OUTPUT #2.  

13.1 CONTROLLING THE OUTPUTS 
The status of each output is indicated by a 1, 0, or - in the PROG CYCLE column under #1 
through #7. 

The number ONE 1 means that this PCT is driving that output to be TRUE  
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The number ZERO 0 means that this PCT is NOT driving this output true now, but, this 
output is programmed to be TRUE at another time.  
 

A HYPHEN - means that this PCT is NOT programmed to activate this output. 
 

 
FIGURE 46: PCT DISPLAY EXAMPLE 

PCT #1 is ACTIVE, 1 -- Output #1. Output #2 is NEVER enabled (the ‘-‘ in the bottom row).  

PCT #2 is NOT active, 0  --  however, when it is active, it activates both Output #1 and 
Output #2. The two zeroes show that this PCT will ENABLE both outputs when it 
becomes active.  

PCT #3 is NOT active. When it becomes active it will ONLY activate Output #2.  

PCT #4, PCT #5, PCT #6, and PCT #7 are DISABLED. They NEVER activate Output #1 or 
Output #2. 

SETPOINTS associated with Programmable Cycle Timer are configured from this screen by 

scrolling LEFT  and  RIGHT  until the desired PCT is within the selection box and then 
pressing the ENTER KEY  .  

INTERNAL OUTPUTS 
The PCT has two internal outputs; these should not be confused with the physical outputs of the 
control. The outputs are connected to internal logic. 

In the standard logic configuration, PCT Output #1 is connected to a REMOTE INITIATE command 
and PCT Output #2 is connected via Digital Selector #6 to Relay Output #8.  This effectively 
allows the operator to configure a timed relay, for external connectivity. 

The status of the PCTs can be found within the menu structure at Control -> Prog Cycle Timer, 
an example is shown in FIGURE 47. 

The seven times are displayed across the top row. For the Output 1 and Output 2 rows, the 
number one 1 means that this Programmable Cycle Timer is driving that output to be true. The 
number zero 0 means that this Programmable Cycle Timer is not driving this output true but, 
that it would at other times. A hyphen - means that this Programmable Cycle Timer never 
activates this output.  
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FIGURE 47: PROGRAMMABLE CYCLE TIMER STATUS SCREEN 

The setpoints associated with Programmable Cycle Timer are configured from this screen by 
scrolling left and right until the desired Programmable Cycle Timer is within the selection box 
and then pressing ENTER KEY  .  
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14 REDUCED POWER MODE 
REDUCED POWER MODE (RPM) is a feature that puts the control into a state where the power 
consumption is reduced. RPM is intended to extend the amount of time the generator can sit 
between runs before the control drains the batteries too low to crank the generator in cases 
where a battery trickle charger is not fitted. 

In order to reduce the power consumed when in RPM, many functions within the control are 
turned OFF.  

TURNED OFF DURING RPM 

 The display  

 The communication lines 

 Most inputs  

 All outputs 

 LEDs (lamps) on the front of the control blink briefly every second (rather than being 
on continuously).  

When RPM is enabled, the control will only enter RPM after a programmable time delay 
provided the generator is stopped and no keys have been pressed during the delay time.  

The control will wake from RPM on any one of the following conditions: 

WAKE FROM RPM 

 Input 1 (Emergency-Stop) is grounded 

 Input 2 (Remote Initiate) is grounded 

 A key on the keypad is pressed 

 The Programmable Cycle Timer is about to enter a period when it will activate an 
output. 

CAUTION: Cat generator sets normally use an active high contact of E-Stop to the 
control. When there is no E-Stop, input 1 (E-Stop) is normally in the 
grounded state. This is one of the conditions to leave RPM or the control 
would never enter RPM. Therefore, in order to make use of Reduced 
Power Mode on a Cat genset, the customer/dealer needs to be aware 
that they are giving up the fail-safe nature of E-Stop and they have to re-
wire any E-Stop contacts connected to the control.  

NOTE: In many cases there is a redundant fail-safe contact of the E-Stop switch 
controlling the fuel or connected to the Engine ECU on electronic engines) 

ACTIONS TO ENABLE RPM 

1. Ensure all the contacts of Emergency-Stop that are wired to the EMCP3 are normally 
open (Normally Open switch). This will cause an E-Stop event, this resolved in the next 
step. 
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2. Set the active state of Digital Input #1 to active low.  Reset the E-Stop event. 

3. Change the setpoint Reduced Power Mode Enable Status to ENABLED. This can be 
done with either ET or using a level 3 password to navigate Configure -> Setpoints -> 
Other -> Reduced Power Mode. 

4. The setpoint Reduced Power Mode Delay Time should be checked. It should be at a 
desirable value. This value is the amount of time (once the generator is at rest and after 
the last key-press) before the control will go into Reduced Power Mode. 

 

Semi-Awake 
The EMCP 3 becomes SEMI-AWAKE when in Reduced Power Mode.  Approximately every 30 
minutes it well do status checks of the control for about 40 seconds. The control checks the 
status of the resistive senders, Magnetic Pick-Up, raise any SHORTED or OPEN events (if 
detected), and will activate any relays (such as common alarm).  

During SEMI-AWAKE the display remains off and the LEDs (lamps) continue to blink.  

Once the SEMI-AWAKE time is completed the control will return to full RPM (deactivating any 
relays that are active).  

 

 
 



102 

15 PROGRAMMABLE Trip Point function 

15 PROGRAMMABLE TRIP POINT FUNCTION 
The standard configuration on EMCP 3.2 and 3.3 has one Programmable Trip Point function 
block configured to respond to the %KW of the genset (this feature is not available on EMCP 
3.1. It is not capable power monitoring).   

NOTE: The Programmable Trip Point function cannot be configured to act upon a 
different parameter from %KW. In order to obtain such a capability, a custom 
flash file must be ordered. Contact your Caterpillar dealer for details. 

The setpoints of this block are configured by default such that, if the %KW exceeds 90% for 10 
seconds then the output of the block will become true and remain true until the %KW drops 
below 85% for 1 second. 

The output of the Programmable Trip Point function block can be configured through Digital 
Selector #2 to Relay output #4 or through Digital Selector 7 to Digital (transistor) Output #1.  

The setpoints in the Programmable Trip Point function can be changed from the display, they 
are as follows: 

PROGRAMMABLE TRIP POINT FUNCTION TRIGGER CONDITION 
[Default = Trip Above Threshold] 

This selects whether the output will be active if the value is above or below the threshold. 

PROGRAMMABLE TRIP POINT FUNCTION PERCENTAGE THRESHOLD 
[Default = 90%]  

This is the threshold that the measured parameter must pass to change the state of the output, 
in the default case (%KW) this is 90% of rated kW. 

PROGRAMMABLE TRIP POINT FUNCTION HYSTERESIS PERCENTAGE 
[Default = 5%] 

Once the output is on, the value must return by thus much past the Threshold before the output 
turns off again, in the default case (%KW) this 5% causes the relay to not turn off again until 
85% of rated kW (90-5). This hysteresis is used to ensure that a value close to the threshold 
does not cause the output to rattle on and off. 

PROGRAMMABLE TRIP POINT FUNCTION TRIP ACTIVATION DELAY TIME 
 [Default = 10 seconds] 

This is the time that the value must exceed the threshold before the output of the block 
becomes active. It is used to ensure that the momentary transients are ignored. 

PROGRAMMABLE TRIP POINT FUNCTION TRIP DEACTIVATION DELAY TIME 
[Default = 1 seconds] 

This is the time that the value must return past the threshold before the output of the block 
becomes inactive again. It is used to ensure that the momentary transients are ignored. 
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16 J1939 DATA LINKS 

16.1 PRIMARY J1939 DATA LINK 
The Primary J1939 Data Link is supported by all levels of the EMCP 3 GSC. 

The Primary J1939 Data Link is used for local communication among modules associated with a 
single genset.  These include one or two engine Electronic Control Modules (ECM), the 
Caterpillar Digital Voltage Regulator (CDVR), and a Thermocouple Module.  The EMCP 3 GSC  
can interface with both EUI and MUI engines; in MUI engines, the engine sensors are wired 
directly to the EMCP 3 GSC. 

The Primary J1939 Data Link utilizes the Society of Automotive Engineers (SAE) J1939 protocol 
and requires hardware compliant to the high-speed Controller Area Network (CAN) 2.0B 
protocol defined in the International Standards Organization (ISO) 11898-2 document, running 
at 250k bits per second. 

The Primary J1939 Data Link supports appropriate SAE J1939 Broadcast Parameter Group 
Numbers (PGN) and Suspect Parameter Numbers (SPN) for engine and genset data and 
diagnostics. 

PRIMARY J1939 WIRING 
The Primary J1939 communication wires are brought out of the EMCP 3 GSC as part of the 70-
pin AMP connector.  The pins, as designated on the AMP connector, are shown in TABLE 1.   

TABLE 5: PRIMARY J1939 DATA LINK ON 70-PIN CONNECTOR 

AMP CONNECTOR 

Pin # Name Description 
34 CAN1 - Differential (-) for CAN 
42 CAN1 SH Shield for CAN 
50 CAN1 + Differential (+) for CAN 

NETWORK TOPOLOGY 
The physical topology of the CAN network used in the Primary J1939 Data Link is a bus 
topology, consisting of a main trunk and small drops.   

• The maximum allowable trunk length is 130 ft (40 m), and the maximum drop 
length is 3 ft (1 m).   

• The CAN network requires a termination resistor on the extreme ends of the 
main trunk.   

The topology for the EMCP 3.1 is illustrated in FIGURE 48.   

The topology for the EMCP 3.2 and EMCP 3.3 is illustrated in FIGURE 49 (without optional 
modules) and FIGURE 50 (with optional modules). 

 

 



104 

16 J1939 Data Links 

 
FIGURE 48: EMCP 3.1 CAN WIRING DIAGRAM 
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FIGURE 49: EMCP 3.2 GSC  AND EMCP 3.3 GSC  CAN WIRING DIAGRAM 

(with no optional modules) 
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16.2 ACCESSORY J1939 DATA LINK (EMCP 3.2 & 3.3) 
The Accessory J1939 Data Link is supported by the EMCP 3.2 and EMCP 3.3. 

The Accessory Data Link is used for local or remote communication among modules associated 
with a single genset.  These include a Resistance Temperature Device (RTD) Module, a 
Thermocouple Module, up to four Digital Input/Output Modules, and up to four Annunciators.   

The Accessory J1939 Data Link utilizes the Society of Automotive Engineers (SAE) J1939 
protocol and requires hardware compliant to the high-speed Controller Area Network (CAN) 
2.0B protocol defined in the International Standards Organization (ISO) 11898-2 document, 
running at 250k bits per second. 

The Accessory J1939 Data Link supports appropriate SAE J1939 Broadcast Parameter Group 
Numbers (PGN) and Suspect Parameter Numbers (SPN) for engine and genset data and 
diagnostics. 

ACCESSORY J1939 WIRING 
The Accessory J1939 communication wires are brought out of the EMCP 3 GSC  as part of the 
70-pin AMP connector.  The pins, as designated on the AMP connector, are shown in Table 6 .   

TABLE 6  ACCESSORY J1939 DATA LINK ON 70-PIN CONNECTOR 

ACCESSORY J1939 COMMUNICATION WIRES 

Pin # Name Description 

62 CAN2 + Differential (+) for CAN 

63 CAN2 SH Shield for CAN 

64 CAN2 - Differential (-) for CAN 

NETWORK TOPOLOGY 
The physical topology of the CAN network used in the Accessory J1939 Data Link is a bus 
topology, consisting of a main trunk and small drops.   

• The maximum allowable trunk length is 800 ft (250 m), and the maximum drop 
length is 9 ft (3 m).   

• The CAN network requires a termination resistor on the extreme ends of the 
main trunk.   

The topology for the EMCP 3.2 and EMCP 3.3 in the default configuration, with no remote 
devices connected, is illustrated in FIGURE 49 above.   

The topology for the EMCP 3.2 and EMCP 3.3 with some remote devices connected is 
illustrated in FIGURE 50.   

NOTE: The devices shown in FIGURE 50 are only representative; more remote 
devices can be connected, as long as the proper lengths are maintained, 
and the termination resistor is placed at the end of the trunk.  Refer to Table 
7  Number of Optional Modules Supported in Chapter 17 for the maximum 
number of devices supported on each level. 
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FIGURE 50: EMCP 3.2  AND EMCP 3.3 CAN  WIRING DIAGRAM (WITH OPTIONAL MODULES) 
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17 OPTIONAL MODULES 
The EMCP 3 consists of the EMCP 3 GSC, as well as some optional auxiliary modules.  These 
modules connect to the EMCP 3 GSC via either the primary or accessory J1939 data link.  The 
EMCP 3 GSC can also communicate with a Caterpillar electronic engine controller.  Though this 
is not considered an optional module.   

Different numbers of modules are supported for different levels of EMCP 3 GSC. The numbers 
are given below in Table 7  Number of Optional Modules Supported. 

For J1939 compliance, all modules comply with the applicable portions of the following: 

SAE J1939-21, July 1998, Data Link Layer 

SAE J1939-71, January 2002, Application Layer 

SAE J1939-73, May 2000, Application Layer – Diagnostic 

SAE J1939-81, July 1997, Network Management 

For more information about connecting modules to the J1939 data links, refer to Chapter 16.2 
Accessory J1939 Data Link. 

THE ANNUNCIATOR 
The Annunciator module is an auxiliary alarm indication device, consisting of 16 pairs of 
indicator LEDs, and an audible horn.  Each pair can be individually configured based for an 
application, and a custom film kit is available to customize the graphic/text indication.  For 
further information see Chapter 17.1 below. 

THE THERMOCOUPLE, RTD, & DIO 
EMCP 3 GSC uses a common design approach for the three modules known as the 
Thermocouple, RTD (Resistance Temperature Detector) and DIO (Discrete I/O) modules.  The 
same hardware design is used for the power supply and CAN network communications board. 
Individual circuit board assemblies are used for the 20-channel thermocouple interface or 8-
channel RTD interface board.   

The Thermocouple module, RTD module and DIO module feature identical rugged packaging 
and watertight Deutsch IPD connectors.  The only physical difference in packages between 
these three optional modules is that the DIO module has an LED to indicate communication 
network status.   

Applications can include networked power generator set control systems.  

For further information on the Thermocouple module see Chapter 17.2, for the RTD module see 
Chapter 17.3, and for the DIO module see Chapter 17.4 below. 

THE CATERPILLAR DIGITAL VOLTAGE REGULATOR 
The Caterpillar Digital Voltage Regulator (CDVR) module is an auxiliary voltage regulator 
device, regulating the generator voltage and engine speed to provide optimal response to 
various load types and changes in load.  It is connected to the generator exciter and field, and 
communicates with the EMCP 3 GSC for monitoring purposes.  For further information see 
RENR7941 Caterpillar Digital Voltage Regulator.  
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TABLE 7  NUMBER OF OPTIONAL MODULES SUPPORTED 

EMCP 3.1 EMCP 3.2 EMCP 3.3 
MODULE 

Primary 
J1939 

Primary 
J1939 

Accessory 
J1939 

Primary 
J1939 

Accessory 
J1939 

Electronic engine controller 1 1 0 1 0 
CDVR 1 1 0 1 0 

Annunciator 1 1 4 1 4 
Thermocouple 0 0 0 1 1 

RTD 0 0 0 0 1 
DIO 0 0 4 0 4 

J1939 COMPLIANCE 
For J1939 compliance, all modules comply with the applicable portions of the following: 

SAE J1939-21, July 1998, Data Link Layer 

SAE J1939-71, January 2002, Application Layer 

SAE J1939-73, May 2000, Application Layer – Diagnostic 

SAE J1939-81, July 1997, Network Management 

17.1 ANNUNCIATOR 
The EMCP 3 Annunciator serves to display system alarm 
conditions and status indications. The Annunciator has been 
designed for use on the EMCP 3 GSCJ1939 Communication 
Network and may be used in either Local (Primary J1939) or 
Remote (Accessory J1939) applications, providing 
customers with enhanced site flexibility. 

In Local application, the Annunciator may be mounted on the 
Package generator set with the EMCP 3.2 or 3.3 GSC to 
provide a complete package-mounted monitoring solution.  
One Annunciator can be mounted on the package and 
connected to the Primary J1939 data link. 

The Annunciator may also be mounted separate from the 
generator set to provide Remote indication of system 
operating and alarm conditions.  Up to four Annunciators can 
be mounted remotely and connected to the Accessory J1939 
data link. 
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ANNUNCIATOR FEATURES 
The Annunciator includes: 

Sixteen (16) LED pairs for annunciation of up to 32 system events 

An additional pair of LEDs provides status indication of the J1939 data link connection 

Can annunciate alarm conditions received from any module on the J1939 data link 

Alarm Horn with Lamp Test and Alarm Acknowledge pushbuttons 

Configurable to NFPA 99/110 requirements for local and remote annunciation on 
Emergency Standby Generator Systems 

Provides a simple means to change the labels for the annunciation LEDs for site specific 
requirements (Custom Label Kit purchased separately) 

Provides superior visibility of the LEDs in direct sunlight. 

Graphic symbols along with text labels are provided next to each LED pair to indicate 
various alarms and events. 

Can be mounted either locally on the package generator set, on the Primary J1939 Data 
Link, or Remotely (up to 800 feet) on the Accessory J1939 Data Link 

Designed and Tested to meet stringent Impulse Shock and Operating Vibration 
requirements 

286 mm (11.26 in) High  x  157 mm (6.18 in) Wide  x  141 mm (5.55 in) Deep 

ANNUNCIATOR SPECIFICATIONS 
ELECTRICAL SPECIFICATIONS 

Control Power 12 V DC & 24 V DC nominal (9 – 32 V DC acceptable) 

Over voltage capability is 32 V DC for 1 hour @ 85°C 

Single, 6-pin connector provides both power and communication 

Designed to meet relevant European standards for EMI/RFI/Immunity without the use of 
external filtering (Third party testing is being pursued). 

ENVIRONMENTAL SPECIFICATIONS 
Operating Temperature  -40 to 85°C (-40 to 185°F) 

Storage Temperature  -50°C to +120°C. 

Relative Humidity 90%, non-condensing, 30°C to 60°C. 

Failure Point 120°C.  If the ambient temperature were to exceed 120°C, the device 
would NOT be expected to return to proper operation. 

Can be mounted directly on the generator set panel or remotely 

NETWORK COMMUNICATIONS INTERFACE  
Incorporates an SAE J1939 communications port, able to operate on either the EMCP 3 
GSC Primary or Accessory J1939 data link 

Node address is auto configurable as per J1939-81 

Optical isolation is provided for the CAN line. 
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Module operates normally with loss of communication link, retaining configured setpoints 
in non-volatile memory 

Configuration and firmware updates are accomplished with the Caterpillar® Service Tool 
over the J1939 network 

ANNUNCIATOR WIRING 
The back of the Annunciator module contains a 8-terminal screw terminal block.  Attached to the 
block is a 6-pin Deutsch adapter.  The pin outs for both are shown in Figure 51 and Table 8 . 

CONNECTOR FRONT VIEW
DEUTCSH P/N: DT04-6P
1 = PWR+
2 = PWR-
3 = N/C

4 = N/C
5 = CAN-L
6 = CAN-H

1 2 3

456

  

FIGURE 51: ANNUNCIATOR DEUTSCH CONNECTOR PIN CONFIGURATION AND TERMINAL BLOCK 

TABLE 8  ANNUNCIATOR TERMINAL BLOCK PIN CONFIGURATION 

ANNUNCIATOR TERMINAL BLOCK PIN CONFIGURATION 

Terminal # Function Description 
1 N/C Not Connected 
2 N/C Not Connected 
3 N/C Not Connected 
4 N/C Not Connected 
5 Horn Drive Connects to Horn(-) 
6 Alarm Ack Alarm Acknowledge 
7 Lamp Test Lamp Test 
8 CAN-H CAN Datalink HI 
9 CAN-L CAN Datalink LOW 
10 N/C Not Connected 
11 PWR+ + Battery Input, connects to Horn(+) 
12 PWR- - Battery Input 

LED COLORS 
Each pair of LEDs on the Annunciator consists of two of the following three colors: Green, 
Amber, and Red, which allows for custom configuration of STATUS, WARNING and SHUTDOWN 
conditions.  The available colors and combinations are listed in Table 9  LED Colors: 
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TABLE 9  LED COLORS 

LED COLORS 

ROW LED 1 LED 2 ROW LED 1 LED 2 ROW LED 1 LED 2 
1 Red Amber 7 Red Amber 13 Green Amber 
2 Red Amber 8 Red Amber 14 Green Amber 
3 Red Amber 9 Red Amber 15 Red Green 
4 Red Amber 10 Red Amber 16 Red Green 
5 Red Amber 11 Red Amber 
6 Red Amber 12 Red Amber 

 

 

MODULE STATUS LED 
A red/green pair located at the bottom of the EMCP 3 GSC, is used to report Module/Network 
Status.  The various states indicated are explained in Table 10 below. 

TABLE 10  ANNUNCIATOR MODULE / NETWORK STATUS LED BEHAVIOR 

BEHAVIOR EXPLANATION 

Red solid CAN data link diagnostic. For 
example: the module is wired wrong 
(Data Link), wrong cable, or no 
terminating resistor. 

Green solid CAN data link OK 
Green 
flashing 

No CAN data link diagnostic, but no 
communication detected.  
Hooking the Annunciator up with the 
power on. 

Red/Green 
flashing 

No application software loaded 

 

ANNUNCIATOR SOFTWARE CONFIGURATION 
The Annunciator is field-programmable using the Caterpillar® Service Tool.  It is also flash 
programmable to update software using the Caterpillar® Service Tool. 

The service tool software must be installed on a Windows PC.  The Caterpillar communication 
adapter must be connected between the PC and the J1939 data link on which the target 
Annunciator is connected.  (The service tool may be connected to the EMCP 3 GSC Accessory 
Data Link service connector). 

When connecting to the Annunciator, the user will first see the Module Summary screen shown 
in FIGURE 52. 
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FIGURE 52: CATERPILLAR

®
 SERVICE TOOL ANNUNCIATOR SUMMARY SCREEN 

This screen shows module information such as Serial Number, Part Number, Software Group 
Number, and Software Release Date. 

GLOBAL ACKNOWLEDGE 
The Annunciator can be configured to both initiate and respond to an Event Acknowledge 
message over the J1939 data link.  If this setpoint is enabled, the Annunciator events may be 
acknowledged directly on the Annunciator by pressing the Alarm Acknowledge button or 
remotely by pressing the Alarm Acknowledge button on the EMCP 3 GSC or by pressing the 
Acknowledge button on another Annunciator that is on the same data link. Acknowledging 
events also silences the horn. 

The default setting for this setpoint is DISABLED, but it can be enabled from the Service  
Configuration menu item. 

ECU INSTANCE NUMBER 
The Module Description will also indicate a number that identifies the Annunciator uniquely from 
any other Annunciator modules on the (Primary or Accessory) J1939 data link.  In this example, 
the service tool is connected to Alarm Module #2.   

This number is called the ECU INSTANCE and it is programmable.  To program the Annunciator 
to a different ECU Instance number, enter the Configuration Screen by selecting the Service  
Configuration, as shown in FIGURE 53. 

The service tool configuration screen, shown in FIGURE 54, identifies the serial number of the 
Annunciator that is connected.  This is important in matching the desired ECU Instance to the 
actual hardware.  In this example, the Annunciator will be programmed to ECU Instance #1.  To 
do this, select the ECU Instance row, and double click on the current ECU Instance.  A dialog 
box will open, allowing entry of the new ECU Instance.  Type a numeric value, 1, 2, 3, or 4 and 
click OK. 

When you click OK, the service tool software will automatically restart and reconnect to the data 
link.  Upon reconnecting, the summary screen will now show the new module name, based on 
the ECU Instance.  In this example, the new module name will be Alarm Module #1. 
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FIGURE 53: CATERPILLAR

®
 SERVICE TOOL ANNUNCIATOR CONFIGURATION SCREEN 

CONFIGURING ANNUNCIATOR LED BEHAVIOR 
To configure the behavior of the LED pairs, enter the LED Pair Configuration screen by 
selecting Service  LED Pair Configuration. An example of the LED Pair Configuration screen 
is shown in FIGURE 54. 

Each LED pair has four parameters required to configure it.  It is best to configure the four 
columns in order from left to right; first Trigger Condition, next Severity Level, then Suspect 
Parameter Number, and finally Failure Mode Identifier (if required).  The reason for the order is 
because the value set in one column affects the choices available in the subsequent columns.  
If a field is grayed out, it is not available due to conditions set in previous columns. 

TRIGGER CONDITION 
There are three possible selections for Trigger Condition: SPECIFIC EVENT, GENERAL EVENT, and 
DISABLED. 

SPECIFIC EVENT is used to assign an LED pair to a specific data link parameter, such as Oil 
Pressure, Engine Speed, Coolant Temperature, etc.  The desired parameter must be chosen in 
the Suspect Parameter Number column. 

GENERAL EVENT is used to assign an LED pair as a general alarm or shutdown indicator.   
When configured as General Event, the LED will not be assigned to a particular parameter.  It 
will respond to any event with a severity level chosen in the Severity Level column, regardless 
of the Suspect Parameter Number.   

For this reason, when General Event is selected, the Suspect Parameter Number cannot be 
changed. 
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FIGURE 54: CATERPILLAR

®
 SERVICE TOOL ANNUNCIATOR LED CONFIGURATION SCREEN 

DISABLED is used to disable the LED pair.  The remaining three parameters will be grayed out 
when Disabled is selected. 

SEVERITY LEVEL   
Severity Level defines which types of events the LED pair will react to.  Selections that begin 
with Condition Exists will respond to J1939 Event messages for Failure Mode Identifier (FMI) 31 
Condition Exists.   

For example, LED pair #2 is configured for Condition Exists, Red On, Other Not Used, Horn On 
with SPN 190 (Emergency Stop Active).  This means that when the Annunciator received a 
J1939 message indicating Emergency Stop with FMI 31, the Red LED will turn on and the Horn 
will also turn on.   

Other Not Used indicates that the other LED color in the pair is never used.  

Green Off (for example) indicates that the green LED lights when the condition chosen 
for this LED pair is NOT active. 

Most Severity Level selections imply (a) J1939 Failure Mode Identifier (FMI) code(s):   

CONDITION EXISTS is equivalent to FMI 31 

HIGH WARNING can be FMI 15 or FMI 16   

LOW WARNING can be FMI 17 or FMI 18   

HIGH SHUTDOWN is equivalent to FMI 0 

LOW SHUTDOWN is equivalent to FMI 1   

HIGH OR LOW SHUTDOWN is equivalent to FMI 0 or FMI 1   
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Since the FMI codes are implied by this column, the FMI column is grayed out for any of these 
selections.   

The only option that will allow an FMI to be configured is SPECIFIC DIAGNOSTIC. 

SUSPECT PARAMETER NUMBER  
The Suspect Parameter Number column is used to select or type in the SPN for the parameter 
assigned to the LED pair.  Most supported SPNs can be selected from the list.  Refer to the 
SAE J1939 literature or RENR7902 Systems Operation Testing and Adjusting Manual for a 
complete list of supported SPNs. 

NOTE: Remember to click the Submit button at the bottom of the LED Pair 
Configuration tool after making the selections for each LED pair. Only then 
will the new settings take effect.  If you make selections and attempt to leave 
the LED Pair Configuration tool, a prompt will ask you if you wish to have 
your changes take effect.  If you decline, your changes will be lost. 

17.2 THERMOCOUPLE MODULE (EMCP 3.3) 

THERMOCOUPLE FEATURES  
Reads up to 20 Type J or K thermocouple inputs 

Temperatures are configured to indicate the SAE J1939 
SPN to be transmitted by that temperature input.  Suspect 
Parameter Numbers (SPNs) for configuration of 
temperature inputs are customer specific.  Resolution: 
One byte parameters have a resolution of 1 °C / bit and a 
range of  -40 °C to 210 °C.  Two byte parameters have 
resolution of 0.03125 °C / bit and a range of -273 °C to 
1735 °C 

Cold junction compensation is provided 

System throughput has all 20 channels scanned in 2 seconds (100 ms/channel) 

Overall drift with temperature is 0.015% / °C of span (maximum) 

Module is fully functional during configuration and communications 

Parameter values and diagnostic error codes are retained when the modules are de-
energized 

Open-circuit and short-circuit diagnostics are supported 

Can be mounted directly on the generator set panel or remotely 

Suitable for moist, high shock and vibration environments 

Compact size (see mechanical drawing, FIGURE 55) 
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THERMOCOUPLE SPECIFICATIONS 
ELECTRICAL SPECIFICATIONS 

Accept 5-32 V DC power (12 or 24 V DC nominal) 

Over voltage capability is 32 V DC for 1 hour @ 85°C 

Power supply inputs are protected against transient surges and short circuits and are 
isolated from I/O 

Three way isolation is provided for the CAN line, inputs and power supply; isolation 
voltage is 1500 V AC (rms) or 2550 V for 1 sec 

Burden is limited to less than 200 mA; inrush not to exceed 800 mA 

Common mode rejection is -80 db@ 5V p-p (50-60 Hz) 

Common mode input range is +/- 4 V minimum 

Designed to meet relevant European standards for EMI/RFI/Immunity without the use of 
external filtering (Third party testing is being pursued) 

ENVIRONMENTAL SPECIFICATIONS 
Encapsulated in a rugged aluminum housing with watertight Deutsch connectors (IP65 
rating) 

Operating temperature range -40 to 85°C (-40 to 185°F) (for ambient temperatures 
exceeding 85°C, the temperature scanner may deviate in accuracy an additional ±1°C) 

The ambient storage temperature range is -50°C to +120°C 

It is protected against 95% humidity non-condensing, 30°C to 60°C 

NETWORK COMMUNICATIONS INTERFACE  
Incorporates an SAE J1939 communications port with variable slew rate on the 
transceiver to accommodate different CAN (SAE J1939) connections (capable of 
working on both the EMCP 3 GSC Primary and Accessory J1939 data links) 

Node address is auto configurable as per J1939-81 

Optical isolation is provided for the CAN line 

Retains current date and time relative to synchronization every 24 hours (or upon boot 
up) with equipment system time via an explicit command from the EMCP 3 GSC or 
Service Tool when the GSC is not available; synchronization time is accurate to within 1 
sec 

Includes a watchdog timer to atomically reboot should the microprocessor lock 

Module operates normally with loss of communication link, retaining configured values 
and error codes in non-volatile memory 

Configuration and firmware updates are accomplished with the Caterpillar® Service Tool 
over the J1939 network 
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THERMOCOUPLE WIRING 

POWER AND CAN BUS WIRING 

 

THERMOCOUPLE SENSOR WIRING 

 
 

 

 

 

 

 



119 

17 OPTIONAL Modules 

THERMOCOUPLE PHYSICAL LAYOUT 

 
 

FIGURE 55: THERMOCOUPLE, RTD, AND DISCRETE I/O MODULE PHYSICAL LAYOUT 

THERMOCOUPLE MODULE – CONFIGURATION 
The Thermocouple module is field programmable using the Caterpillar® Service Tool.  It is also 
flash programmable to update software using the Caterpillar® Service Tool. 

The service tool software must be installed on a Windows PC.  The Caterpillar communication 
adapter must be connected between the PC and the J1939 data link on which the target 
Thermocouple module is connected.  When connecting the Thermocouple module, the user will 
first see the Module Summary screen shown in FIGURE 56. 

 
FIGURE 56: CATERPILLAR

®
 SERVICE TOOL THERMOCOUPLE MODULE SUMMARY SCREEN 

The service tool configuration tool contains setpoints for configuring the Thermocouple module 
identification, as well as the thermocouple inputs. 
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FIGURE 57 shows the ECM Identification Parameters list.  This list shows the ECM serial number 
(read-only) of the module that is connected, and allows for configuration of the ECU instance.  
Each thermocouple module on the data link must have a unique ECU instance.  If ECU 
instances are duplicated, one of the modules must be disconnected and the other reconfigured 
to a different ECU instance.  

 
FIGURE 57: CATERPILLAR

®
 SERVICE TOOL THERMOCOUPLE MODULE IDENTIFICATION PARAMETERS 

Upon changing the ECU instance, the Caterpillar® Service Tool will automatically reconnect to 
the data link, and the Thermocouple module name should reflect the new ECU instance.  In this 
example, as shown in FIGURE 58, the module was previously named Thermocouple Module #1, 
and after the ECU instance is changed to 2 and the service tool reconnects, the name reads 
Thermocouple Module #2. 

 
FIGURE 58: CATERPILLAR

®
 SERVICE TOOL THERMOCOUPLE MODULE AFTER ECU INSTANCE CHANGE 

CONFIGURING THERMOCOUPLE INPUTS 
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FIGURE 59 shows the THERMOCOUPLE INPUT #1 Configuration list, when using the Caterpillar® 
Service Tool.  All twenty thermocouple inputs have identical parameters and options. 

 
FIGURE 59: CATERPILLAR

®
 SERVICE TOOL THERMOCOUPLE INPUT CONFIGURATION 

The SENSOR TYPE CONFIGURATION selects either a J or K type configuration.  Select the 
appropriate configuration based on the type of thermocouple installed. 

The SUSPECT PARAMETER NUMBER (SPN) is a numerical entry between a predetermined list of 
SPNs that are supported by the Thermocouple module.  All of the thermocouple inputs support 
the same list of SPNs.  To change the SPN, type in the number that corresponds with the 
desired parameter as shown in FIGURE 61.  See RENR7902 for specific information on what 
possible SPN values can be used. 

The HIGH TEMPERATURE SHUTDOWN EVENT THRESHOLD sets the high temperature at which a high 
shutdown event will occur. 

The HIGH TEMPERATURE WARNING EVENT THRESHOLD sets the high temperature at which a high 
warning event will occur. 

 
FIGURE 60: CATERPILLAR

®
 SERVICE TOOL THERMOCOUPLE MODULE SUSPECT PARAMETER NUMBER 
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The LOW TEMPERATURE WARNING EVENT THRESHOLD sets the low temperature at which a low 
warning event will occur. 

The EVENT NOTIFICATION DELAY TIME sets the amount of time the threshold must be exceeded 
until the Thermocouple module triggers that particular event on the data link.  Each of the delay 
time options corresponds with a particular event type. 

17.3 RTD MODULE (EMCP 3.3) 

RTD FEATURES 
Reads up to eight (8) Platinum RTD inputs with 2, 3, and 4 
wire configurations 

System throughput has all 8 channels scanned in 2 
seconds (250 ms/channel). 

Overall drift with temperature is 15mOhm/°C (maximum) 

Module is fully functional during configuration and 
communications  

Parameter values and diagnostic error codes are retained 
when the modules are de-energized 

Suitable for moist, high shock and vibration environments 

Compact size (see mechanical drawing, FIGURE 61) 

RTD SPECIFICATIONS 
ELECTRICAL SPECIFICATIONS 

Accept 5-32 V DC power (12 or 24 V DC nominal) 

Over voltage capability is 32 V DC for 1 hour @ 85°C 

Power supply inputs are protected against transient surges and short circuits and are 
isolated from I/O 
Optical isolation is 500 V DC from input to ground.  Three way isolation is provided for 
the CAN line, inputs and power supply. 

Burden is limited to less than 200 mA; inrush not to exceed 800 mA 

Isolation voltage is 1500 V AC (rms) or 2550V for 1 sec. 

Designed to meet relevant European standards for EMI/RFI/Immunity without the use of 
external filtering (Third party testing is being pursued) 

ENVIRONMENTAL SPECIFICATIONS 
Encapsulated in a rugged aluminum housing with watertight Deutsch connectors (IP65 
rating) 

Operating temperature range -40 to 85°C (-40 to 185°F) (for ambient temperatures 
exceeding 85°C, the temperature scanner may deviate in accuracy an additional ±1°C) 

The ambient storage temperature range is -50°C to +120°C 

It is protected against 95% humidity non-condensing, 30°C to 60°C 
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NETWORK COMMUNICATIONS INTERFACE  
Incorporates an SAE J1939 communications port with variable slew rate on the 
transceiver to accommodate different CAN (SAE J1939) connections (capable of 
working on both the EMCP 3 GSC Primary and Accessory J1939 data links) 

Node address is auto configurable as per J1939-81 

Optical isolation is provided for the CAN line 

Retains current date and time relative to synchronization every 24 hours (or upon boot 
up) with equipment system time via an explicit command from the EMCP 3 GSC or 
Service Tool when the GSC is not available; synchronization time is accurate to within 1 
sec 

Includes a watchdog timer to automatically reboot should the microprocessor lock. 

Module operates normally with loss of communication link, retaining configured values 
and error codes in non-volatile memory   

Configuration and firmware updates are accomplished with the Caterpillar® Service Tool 
over the J1939 network 

RTD WIRING 

POWER AND CAN BUS WIRING 
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RTD SENSOR WIRING 

 

RTD WIRING TYPICAL CONNECTIONS 

 

RTD WIRING 

 
FIGURE 61: THERMOCOUPLE, RTD, AND DISCRETE I/O MODULE PHYSICAL LAYOUT 
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RTD MODULE – CONFIGURATION 
The RTD (Resistance Temperature Detector) module is field programmable using the 
Caterpillar® Service Tool.  It is also flash programmable to update software using the 
Caterpillar® Service Tool. 

The service tool software must be installed on a Windows PC.   

The Caterpillar communication adapter must be connected between the PC and the J1939 data 
link on which the target RTD module is connected.  

When connecting to the RTD module, the user will first see the Module Summary screen shown 
in FIGURE 62. 

 
FIGURE 62: CATERPILLAR

®
 SERVICE TOOL RTD MODULE SUMMARY SCREEN 

The service tool configuration tool, accessed by pressing F5 or clicking the configuration tool 
icon on the toolbar, contains setpoints for configuring the RTD module identification, as well as 
the RTD inputs. 

CONFIGURING RTD INPUTS 
The RTD Input #1 Configuration list of the service tool configuration tool is shown in FIGURE 63.  
All eight RTD inputs have identical parameters and options. 

 
FIGURE 63: CATERPILLAR

®
 SERVICE TOOL RTD MODULE DIGITAL INPUT CONFIGURATION 

The SENSOR TYPE CONFIGURATION selects between a 2, 3, or 4 wire configuration.  Select the 
appropriate configuration based on the type of RTD sensor installed. 

The TEMPERATURE COEFFICIENT CONFIGURATION selects between an IEC Platinum, JIS Platinum, 
Legacy US Platinum, SA MA Platinum or US Platinum type of RTD sensor.  Select the 
appropriate configuration based on the type of RTD sensor installed. 
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The SUSPECT PARAMETER NUMBER (SPN) is a choice between a predetermined list of SPNs that 
are supported by the RTD module.  All of the RTD inputs support the same list of SPNs.  To 
change the SPN, type in the number that corresponds with the desired parameter as shown in 
FIGURE 64.  See RENR7902 for specific information on what possible SPN values can be used. 

The HIGH TEMPERATURE SHUTDOWN EVENT THRESHOLD sets the high temperature at which a 
shutdown event will occur. 

The HIGH TEMPERATURE WARNING EVENT THRESHOLD sets the high temperature at which a high 
warning event will occur. 

The LOW TEMPERATURE WARNING EVENT THRESHOLD sets the low temperature at which a low 
warning event will occur.  

The EVENT NOTIFICATION DELAY TIME sets the amount of time the threshold must be reached until 
the RTD module triggers that particular event on the data link.  Each of the delay time options 
corresponds with a particular event type. 

 
FIGURE 64: CATERPILLAR

®
 SERVICE TOOL RTD MODULE SUSPECT PARAMETER NUMBER 

17.4 DISCRETE I/O MODULE 
The EMCP 3 GSC Discrete I/O (DIO) module is designed for 
mounting on generator sets or remotely, to provide auxiliary 
switch inputs or relay contact outputs.   Up to 4 DIO modules 
can be used on the EMCP 3 GSC Accessory J1939 data link, 
given that they are programmed to unique ECU Instance 
numbers. 

DISCRETE I/O FEATURES 
Reads twelve (12) discrete inputs and sets eight (8) 
Form C relay outputs 
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Converts between physical I/O and CAN (J1939) data 
link commands 

System throughput:  All channels are scanned in 100 ms 

Low-Level input voltage range: 0 to 0.8 V 

High-Level input voltage range: 3.75 to 24V 

Inputs have internal pull-up resistors 

LED to indicate communication network status 

Compact size (see mechanical drawing, FIGURE 65) 

 

DISCRETE I/O SPECIFICATIONS 
ELECTRICAL SPECIFICATIONS 

Accept 5-32 V DC power (12 or 24V DC nominal) 

Over voltage capability is 32 V DC for 1 hour @ 85°C 

Resistive Loads rated for 3A@30 V DC  

Normally Closed (NC) relay contacts rated for 3A@125 V AC / 2A@277 V AC / 3A@30 
V DC 

Normally Open (NO) relay contacts rated for 5A@125 V AC / 2A@277 V AC / 5A@30 V 
DC 

Inductive Loads rated for 0.5A@250 V AC cosφ=0.4 

Maximum current draw of 400mA + 50mA per energized relay @ 12V DC 

Power supply inputs are protected against transient surges and short circuits and are 
isolated from I/O 
Isolation voltage:  4000 V AC (rms), 50/60 Hz for 1 min. between coil and contacts, 750 
V AC, 50/60 Hz for 1 min. between contacts of the same polarity 

ENVIRONMENTAL SPECIFICATIONS 
Encapsulated in a rugged aluminum housing with watertight Deutsch connectors (IP65 
rating) 

Operating temperature range -40 to 85°C (-40 to 185°F) 

The ambient storage temperature range is -50°C to +120°C. 

It is protected against 95% humidity non-condensing, 30°C to 60°C. 

Designed to meet relevant European standards for EMI/RFI/Immunity without the use of 
external filtering (Third party testing is being pursued). 

NETWORK COMMUNICATIONS INTERFACE  
Incorporates an SAE J1939 communications port with variable slew rate on the 
transceiver to accommodate different CAN (SAE J1939) connections (capable of 
working on both the EMCP 3 GSC Primary and Accessory J1939 data links) 

Node address is auto configurable as per J1939-81 
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Optical isolation is provided for the CAN line 

Retains current date and time relative to synchronization every 24 hours (or upon boot 
up) with equipment system time via an explicit command from the EMCP 3 GSC or 
Service Tool when the GSC is not available; synchronization time is accurate to within 1 
sec 

Includes a watchdog timer to atomically reboot should the microprocessor lock 

Module operates normally with loss of communication link, retaining configured values 
and error codes in non-volatile memory   

Configuration and firmware updates are accomplished with the Caterpillar® Service Tool 
over the J1939 network 

Monitored parameters and alarms are read-only over the network 

 

DISCRETE I/O WIRING 

POWER AND CAN BUS WIRING 

 

I/O WIRING TYPICAL CONNECTIONS 

INPUT 
 

 
DIN     GND 

 

OUTPUT 
          LOAD - LOAD 

 
NO       NC           C 
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TABLE 11  DISCRETE I/O 

INPUTS PIN OUTPUTS PIN OUTPUTS PIN 

DIN1 1 NC_1 5 C_6 19 
DIN2 11 C_1 6 NO_6 20 
DIN3 21 NO_1 7 NC_7 28 
DIN4 31 NC_2 15 C_8 29 
DIN5 2 C_2 16 NO_7 30 
DIN6 12 NO_2 17 NC_8 38 
DIN7 22 NC_3 25 C_8 39 
DIN8 32 C_3 26 NO_8 40 
DIN9 3 NO_3 27 

 

  
DIN10 13 NC_4 35 
DIN11 23 C_4 36 
DIN12 33 NO_4 37 
GND 4 NC_5 8 
GND 14 C_5 9 
GND 24 NO_5 10 
GND 34 

 

NC_6 18 

NO = Normally Open 
NC = Normally Closed 

C = Common 

 

 
FIGURE 65: THERMOCOUPLE, RTD, AND DISCRETE I/O MODULE PHYSICAL LAYOUT 

DISCRETE I/O SOFTWARE CONFIGURATION 
The DIO module is field-programmable using the Caterpillar® Service Tool.  It is also flash 
programmable to update software using the Caterpillar® Service Tool.  

The service tool software must be installed on a Windows PC.  The Caterpillar communication 
adapter must be connected between the PC and the J1939 data link on which the target DIO 
module is connected.  (The service tool may be connected to the EMCP 3 GSC Accessory Data 
Link service connector). 
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FIGURE 66: CATERPILLAR

®
 SERVICE TOOL DIO SUMMARY SCREEN 

When connecting to the DIO, the user will first see the Module Summary screen shown in 
FIGURE 66. The service tool configuration tool, accessed by pressing F5 or clicking the 
configuration tool icon on the toolbar, contains setpoints for configuring the DIO identification, as 
well as the inputs and outputs. 

 
FIGURE 67: CATERPILLAR

®
 SERVICE TOOL DIO IDENTIFICATION PARAMETERS 

FIGURE 67 shows the ECM Identification Parameters list.  This list shows the ECM serial number 
(read-only) of the module that is connected, and allows for configuration of the ECU instance.  It 
is important to match a specific module to a certain ECU Instance.  The system will not function 
properly if ECU instances are duplicated.  Upon changing the ECU instance, the Caterpillar 
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service tool will automatically disconnect and reconnect to the data link, and the DIO module 
name should reflect the new ECU instance.   

In the example shown in FIGURE 68, the module was previously named Discrete I/O Module #1, 
and after the ECU instance is changed to 2 and the service tool reconnects, the name reads 
Discrete I/O Module #2. 

 
FIGURE 68: CATERPILLAR

®
 SERVICE TOOL DIO AFTER ECU INSTANCE CHANGE 

CONFIGURING DIGITAL INPUTS 
FIGURE 69 shows the Discrete Input #1 Configuration list using the service tool configuration 
tool.  All twelve discrete inputs have identical parameters and options. 

 
FIGURE 69: CATERPILLAR

®
 SERVICE TOOL DIO DIGITAL INPUT CONFIGURATION 
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The active state configuration determines which state (high or low) triggers the event, and 
depends on the sensor/switch wiring configuration. 

The event notification delay time sets the amount of time the input must remain active until the 
DIO module triggers an event on the data link. 

SUSPECT PARAMETER NUMBER (SPN) 
The suspect parameter number (SPN) is a choice between a predetermined list of SPNs that 
are supported by the DIO module.  All of the discrete inputs support the same list of SPNs, 
except Custom Event. 

Discrete Input #1, when set to Custom Event, will trigger an event for Custom Event #1.  
Discrete Input #2, when set to Custom Event, will trigger an event for Custom Event #2; likewise 
for all twelve discrete inputs. 

FAILURE MODE IDENTIFIER (FMI) 
The FAILURE MODE IDENTIFIER (FMI) configures what type of failure this event will represent.  
The technician is free to configure any FMI for any SPN, but discretion must be used.  Certain 
combinations may not be meaningful (i.e. the EMCP 3 GSC may not be configurable to display 
or trigger a response for certain combinations of SPN and FMI).   

For example, a Fuel Level SPN with a Condition Exists FMI is not meaningful; the EMCP 3  can 
be configured to display or react to only fuel level low or high warnings or shutdowns. 

CONFIGURING RELAY OUTPUTS 
The Relay Output #1 Configuration list of the service tool configuration tool is shown in FIGURE 
70.  All eight relay outputs have identical parameters and options. 

The suspect parameter number (SPN) is a choice between a predetermined list of SPNs that 
are supported by the DIO module.  If you wish to configure the DIO to trigger an output based 
on an event on the data link related to a specific SPN, the SPN must be selected here. 

 

 
FIGURE 70: CATERPILLAR

®
 SERVICE TOOL DIO RELAY OUTPUT CONFIGURATION 

The trigger condition is a list of conditions that will trigger this output.  For the conditions labeled 
specific event, the relay will be activated upon receiving a category of events (either a single 
FMI or a set of FMIs) for the SPN selected in the suspect parameter number parameter.  For the 
conditions labeled general event, the relay will be activated upon receiving a category of events 
(either a single FMI or a set of FMIs) for any SPN.  In this case, the DIO module will ignore the 
entry in the suspect parameter number parameter.  If the disabled condition is chosen, the relay 
output will not activate on any condition. 
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18 SCADA (MODBUS) DATA LINK (EMCP 3.2 & 3.3) 
The SCADA DATA LINK or MODBUS is supported by the EMCP 3.2 and EMCP 3.3.  

The EMCP 3.2 and EMCP 3.3 have a SUPERVISORY CONTROL AND DATA ACQUISITION (SCADA) 
communications link between the controller and a host device using the MODBUS protocol.  The 
host device is able to remotely monitor or control the genset package equipped with the EMCP 
3 GSC in much the same way an operator does from the panel. 

• The host device connects to the EMCP GSC through a half-duplex RS-485 
serial link.   

• The data is transmitted in a binary format over the serial connection.   

• The host device acts as Modbus Master, and the EMCP 3 GSC acts as the 
Modbus Slave, also called a REMOTE TRANSMITTER UNIT (RTU).   

• The host device initiates all communication, sending commands or requests for 
information to the EMCP 3.2   

• The EMCP 3 GSC then takes action based on the query and/or sends a 
response to the query over Modbus. 

Baud rates can be configured on the EMCP 3 GSC. Various data rates between 2400 
bits/second (baud) and 57,600 bits/second are available. See the SOFTWARE CONFIGURATION  
Chapter 0 below for instructions. 

WIRING 
SCADA COMMUNICATION wires are brought out of the EMCP 3 GSC as part of the 70-pin AMP 
connector.  Table 12  shows the pins on the AMP connector.  

TABLE 12  SCADA PINS ON 70-PIN CONNECTOR 

SCADA COMMUNICATION WIRES 

Pin # Name Description 
3 MODBUS –  Optically isolated half-duplex differential (-) for Modbus 
4 MODBUS Reference  Half-duplex RS-485 Reference for Modbus 
5 MODBUS +  Optically isolated half-duplex differential (+) for Modbus 

 
MODBUS DATA TRANSMISSION over RS-485 is accomplished over a single shielded twisted pair 
for differential signaling with transmit and receive alternating over the same wire pair 
(MODBUS+ and MODBUS-).  The Reference (MODBUS REF) should be connected to the 
shield, to prevent ground loop currents.   

• FIGURE 71 shows a possible wiring configuration to a RS-485 device.   

• FIGURE 72 shows a possible wiring configuration to a RS-485 to RS-232 
converter.   

NOTE: See documentation of connected device to verify wiring configuration. 
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EMCP 3
70-pin

connector

MODBUS -

MODBUS Ref

MODBUS +

TxD/RxD-

COMMON

TxD/RxD+

5

9

1

3

5

4

RS-485
DB-9

connector

*

* - For multipoint network, terminate with 120 ohm
resistors at ends of network trunk

*

 
FIGURE 71: POSSIBLE WIRING CONFIGURATION TO AN RS-485 DEVICE 

  

EMCP 3
70-pin

connector TD A (-)

TD B (+)

RD A (-)3

5

4

RS-485
to RS-232
converter

* *

COMMON

RD B (+)

MODBUS -

MODBUS Ref

MODBUS +

* - For multipoint network, terminate with 120 ohm
resistors at ends of network trunk  

FIGURE 72: POSSIBLE WIRING CONFIGURATION TO AN RS-485 TO RS-232 CONVERTER 

LINE TERMINATION 
Both ends of the Modbus lines (or the extreme ends of the trunk, for a multipoint network) 
should have termination between MODBUS+ and MODBUS-.   

A 0.5W 150Ω resistor may be adequate.   

If line polarization is implemented (see Software Configuration Chapter below), a better choice 
is a 10 μF capacitor (10V minimum) in series with a 0.25W 120Ω resistor.    

NOTE: For more details on setting up a Modbus network over a serial line, please 
refer to RS-485 specifications or Modbus specifications. See the Software 
Configuration Chapter below for instructions on enabling line polarization. 
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SOFTWARE CONFIGURATION 
The SCADA DATA LINK may require software configuration.  The configuration parameters are 
accessible on the EMCP 3 GSC via the following menu options: 

MAIN MENU   
CONFIGURE  

SETPOINTS:  
NETWORK  

DATA LINK - SCADA  
 

BAUD RATE options are the following:  2400, 4800, 9600, 14400, 19200, 28800, 38400, 57600, 
and 115200 baud.  (115200 baud is not currently supported). 

PARITY can be set to None, Even, or Odd parity. 

The SLAVE ADDRESS is a unique address for each slave on the Modbus data link.  This address 
is referenced in the data messages, described in the Data Link Layer section below.  The slave 
(EMCP 3 GSC ) will only respond to messages addressed to its particular slave address, or to 
global requests.  This address can be set to any integer from 1 to 247. 

The CONNECT TIMEOUT INTERVAL is the amount of time the EMCP 3 GSC will wait between 
message transmissions before it resets the SCADA security level.  If a SCADA PASSWORD has 
been set, this timeout will disallow any further SCADA reads/writes until the proper password is 
written. 

The RS-485 BIAS RESISTOR provides line polarization.  Line polarization helps prevent noise and 
external interference.  The data terminals of the EMCP 3 GSC are internally opto-coupled, and 
therefore line polarization is not required for the EMCP 3 GSC. However, other devices may 
require line polarization.  To polarize the line, the EMCP 3 GSC Modbus terminals have 
hardware-selectable passive pull-up / pull-down lines.  Only a single device on a Modbus 
network should have line polarization. 

In addition to these setpoints, SCADA access can be restricted by means of assigning a 
SCADA PASSWORD (register 724).  For more information, see Chapter 21.1 DATA LINK 
SECURITY. 

MESSAGE DATA STRUCTURE 
Modbus registers are 2 bytes long.  A register is the smallest block that can contain a single 
piece of data.  Larger pieces of data occupy consecutive registers, with the most significant 
word (pair of bytes) in the lowest register, and the least significant word (pair of bytes) in the 
highest register. 

NOTE: Modbus register addresses are referenced starting with register 1, whereas 
data link requests begin at 0.  This results in an offset of 1 in the register 
address.  For example, to request the parameter Generator Overall Power 
Factor, which resides in Modbus register number 103 ($67), a register 
address of $66 must be sent. 
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TABLE 13  MODBUS PACKET FORMAT 

DATA STRUCTURE 

Byte Offset Field Field Description 

0 Address 

Slave address, for both query and response.  Every control on the network 
has a unique slave address between 1 and 247.  Use 0 to make a 
broadcast query, which is supported for Function Codes 6 and 16.  The 
EMCP 3 GSC will always respond with it’s own slave address. 

1 Function 
Code 

Function Code for both query and response. See Supported Function 
Codes for a list and syntax of supported function codes. 

2 
… 

(n-3) 
Data 

Data or exception responses. See Supported Function Codes for the 
format of address, counts, and data.  See Exception Responses for the 
format of exception responses. 

(n-2) 
(n-1) 

CRC 
Cyclic Redundancy Check to catch transmission errors.  The low byte is 
transmitted first, then the high byte. 

COMMUNICATION 
Modbus communication is comprised of data packets.  A packet is a set of bytes transmitted 
consecutively and interpreted as one message, and can vary in length.  A packet is sent with 
byte offset 0 first, and the data is sent with the most significant byte first.  Every packet shares a 
common structure, which is shown in Table 13  Modbus Packet Format.  Only the Data field has 
a variable length, depending on the function being performed and the amount of data being 
transmitted. 

SUPPORTED FUNCTION CODES 
Three normal function codes are supported by the EMCP 3.2  If the EMCP 3 GSC  receives an 
erroneous request, it can also generate an error function code, called an exception response.  
See EXCEPTION RESPONSES Chapter 0 for descriptions of exception responses. 

3 ($03) – READ REGISTERS 
Send this Function Code to read data, single or up to 123 consecutive registers, from the EMCP 
3 GSC .  Note that the query will contain the register count, while the response will contain the 
byte count (byte count = register count x 2).  Note also that the query has a fixed length of 4 
bytes, whereas the response has a variable length depending on the number of registers 
requested. 

TABLE 14: DATA FIELDED OF READ REGISTERS QUERY  

DATA Fielded of READ REGISTERS QUERY 

Address slave address (recipient of this msg) 
Function Code $03 

register address (high byte) 
register address (low byte) 
register count (high byte) 

Data field 

register count (low byte) 
CRC (low byte) CRC 
CRC (high byte) 
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TABLE 15: DATA FIELDED OF READ REGISTERS RESPONSE 

DATA Fielded of READ REGISTERS RESPONSE 

Address slave address (source of this msg) 
Function Code $03 

byte count Data field 
data (Big Endian) 
(variable length) 
CRC (low byte) CRC 
CRC (high byte) 

 

6 ($06) – WRITE SINGLE REGISTER 
Send this Function Code to write data to a single register on the EMCP 3 GSC. Note that the 
EMCP 3 GSC will attempt to write the data, and then respond with the new value in the register.  
If the query inadvertently attempted to write data to a read-register, the response data bytes will 
not match the query data bytes.  This Function Code may be broadcast, in which case no 
response will be sent. 

TABLE 16: DATA FIELDED OF WRITE SINGLE REGISTER QUERY 

DATA Fielded of WRITE SINGLE REGISTER QUERY 

Address slave address (recipient of this msg) 

Function Code $06 

data link register address (high byte) 

data link register address (low byte) 

data (high byte) 

Data field 

data (low byte) 

CRC (low byte) CRC 

CRC (high byte) 
 

TABLE 17: DATA FIELDED OF WRITE SINGLE REGISTER RESPONSE 

DATA Fielded of WRITE SINGLE REGISTER RESPONSE DATA 

Address slave address (source of this msg) 

Function Code $06 

data link register address (high byte) 

data link register address (low byte) 

data (high byte) (confirm written data) 

Data field 

data (low byte) (confirm written data) 

CRC CRC (low byte) 

 CRC (high byte) 
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16 ($10) – WRITE MULTIPLE REGISTERS 
Send this Function Code to write data to up to 123 contiguous registers on the EMCP 3 GSC.  
Note that the query will contain both the register count and the byte count (byte count = register 
count x 2).   

Note, also, that the query has a variable length depending on the number of registers being 
written, whereas the response has a fixed length of 4 bytes.   

The EMCP 3 GSC will not respond with any data, only the starting address and the register 
count as sent in the query.  The entire Write will fail, and the slave will return an Exception 
Response, if any register in this span is a Read register.  

This Function Code may be broadcast, in which case no response will be sent. 

TABLE 18: DATA FIELDED OF WRITE MULTIPLE REGISTERS QUERY 

DATA Fielded of WRITE MULTIPLE REGISTERS QUERY 

Address slave address (recipient of this msg) 
Function Code $10 

data link register address (high byte)
data link register address (low byte)
register count (high byte)
register count (low byte)
byte count

Data field 

data (Big Endian) 
(variable length) 
CRC (low byte) CRC 
CRC (high byte) 

 

TABLE 19:  DATA FIELDED OF WRITE MULTIPLE REGISTERS RESPONSE 

DATA Fielded of  WRITE MULTIPLE REGISTERS RESPONSE 

Address slave address (source of this msg) 

Function Code $10 

data link register address (high byte) 

data link register address (low byte) 

register count (high byte) 

Data field 

register count (low byte) 

CRC CRC (low byte) 

 CRC (high byte) 
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DATA LINK REGISTER ADDRESSES 
Register addresses in the EMCP 3 GSC start with address 100 and go up.  If using a PLC or 
other legacy Modbus system where the addresses are represented in five digits, the EMCP 3 
GSC register addresses represent offsets from 40000 (holding registers).  Therefore, the 
register address 100 would be represented as 40100, register address 1000 would be 41000, 
etc. 

Detailed information about each EMCP 3 GSC Modbus register is given in Chapter 21, SCADA 
Parameter Information . 

ERROR CHECKING 
In EMCP 3 GSC  SCADA communications, various levels of error-checking are performed. 

The Modbus data link protocol allows for BYTE-LEVEL ERROR CHECKING and PACKET-LEVEL 
ERROR CHECKING.   

• For BYTE-LEVEL error-checking, parity checking may be done.   

• For PACKET-LEVEL error-checking, the Modbus protocol dictates that a Cyclic 
Redundancy Check be performed to catch transmission errors; that is, verify that 
the packet received is identical to the packet that was sent.  These occur in the 
Modbus data link layer.  More information on the CRC is given below. 

Once the packet is verified, the addresses and function codes are checked.  This is handled 
using simple logic, determining whether the function code is supported and determining whether 
or not the address range or count is within range.  If not, an exception response is sent.  This 
occurs in the Modbus application layer.  

FAULT RESPONSE 
Once the addresses and function codes are checked, the data is ready to be handled by the 
EMCP 3 GSC application software.  There is error-checking, at this level, is to determine 
whether there are any application-specific errors.   

For example: if you are attempting to write 101% into a register that is defined to hold 0-100%, 
then, even though the data may fit into the register (and therefore passes the previous error-
checking), the application does not accept an input of 101%, and therefore a FAULT RESPONSE is 
sent.   

This fault response is called a FAULT IDENTIFIER, or FID.   

A fault response is data that is valid over the Modbus data link, but the EMCP 3 GSC and the 
Modbus Master device agree to reserve for use as an FID.   

PARITY CHECK 
Parity checking uses standard even or odd parity.  The parity can be set in the EMCP 3 GSC  to 
even, odd, or none.  Parity checking occurs at the byte-level.  Upon successful parity check, the 
checked byte is accepted as part of the transmitted message.  If the parity check fails, the byte 
is discarded. 
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CYCLIC REDUNDANCY CHECK 
The CYCLIC REDUNDANCY CHECK (CRC) algorithm checks the contents of the entire message.  
The CRC field consists of a 16–bit value, and is appended to the end of the message.  When 
this is done, the low–order byte of the field is appended first, followed by the high–order byte. 
The CRC high–order byte is the last byte to be sent in the message. 

The CRC value is calculated by the sending device, which appends the CRC to the message. 
The receiving device recalculates a CRC using the same algorithm during receipt of the 
message, and as it receives the CRC field, compares the calculated value to the received value.  
If the two values are not equal, the message is discarded. 

A detailed description as well as sample code and a calculation example are given in the 
Modbus Serial Line Implementation Guide version 1.0 or the most current version, available at 
www.modbus.org. 

EXCEPTION RESPONSES 
Upon a parity or CRC error, the byte or message (respectively) is discarded.  If neither of these 
errors occurs, the read/write status is checked.  An EXCEPTION RESPONSE will be sent if there is 
a read/write error. 

If the register cannot be read from or written to at a particular time due to some application 
software state, it will not generate an Exception Response.  Instead, the application layer will 
respond with data that is in the Fault Identifiers (FID) range.   

An Exception Response contains a function code that is related to the function code the EMCP 
3 GSC is responding to; it’s value is [128 + Function Code for Query].  Any function code 128 
($80) or higher is an Exception Response. 

128+ ($80 AND ABOVE) – EXCEPTION RESPONSE TO UNSUPPORTED QUERIES 
The EMCP 3 GSC does not support any function codes not listed above in the Supported 
Function Codes Chapter.  Such queries will return an exception response with this exception 
code. 

EXCEPTION CODE REASON 
01 Unsupported function code 

 

131 ($83) – EXCEPTION RESPONSE TO READ REGISTERS QUERY 
The exception response contains only 1 byte of data, which is comprised of the exception code. 

EXCEPTION CODE REASON 
02 Starting or ending (starting + count) register address invalid 
03 Register Count was less than 1 or greater than 123 
04 Read error possibly due to some register(s) in the span not being Read 

registers 
 

134 ($86) – EXCEPTION RESPONSE TO WRITE SINGLE REGISTER QUERY 
The exception response contains only 1 byte of data, which is comprised of the exception code. 

EXCEPTION CODE REASON 
02 Register address invalid 
03 Register value out of range perhaps because longer than 2 bytes 
04 Write error possibly due to not being a Write register 
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144 ($90) – EXCEPTION RESPONSE TO WRITE MULTIPLE REGISTERS QUERY 
The exception response contains only 1 byte of data, which is comprised of the exception code. 

EXCEPTION CODE REASON 
02 Starting or ending (starting + count) register address invalid 
03 Register Count was less than 1 or greater than 123, or byte count was not 

(Register Count x 2) 
04 Write error possibly due to some register(s) in the span not being Write 

registers 

FAULT IDENTIFIERS (FID) 
FAULT IDENTIFIERS (FIDS) are based on the concept that the entire data space within the 
register(s) is partitioned in a predefined manner, irrespective of the specific type of data in the 
register(s).  The range of data in the EMCP 3 GSC  response allows the master device to 
interpret the data as valid or as an indication of a fault. 

The following chart shows the transmitted signal ranges, including the ranges that comprise 
Fault Identifiers (FIDs). 

TABLE 20:  TRANSMITTED SIGNAL RANGES 

TRANSMITTED SIGNAL RANGES 

Range 
Name 

Boolean 
Data† 1-Register Data 2-Register Data Notes 

0, 1 0 – 64,255 0 –  
4,211,081,215 

Valid Data 

$0000 or 
$0001 

$0000 –$FAFF $00000000 – 
$FAFFFFFF 

See individual Parameter 
Descriptions for units, offset, 
and scaling to convert to 
physical units 

2-65532 65,256 – 65,023 4,211,081,214 Not Used 
$0010 - 
$FFFC 

$FB00 –$FDFF $FB000000 –
$FDFFFFFF 

These data ranges are not 
used. 

65533 65,024 – 65,279 4,261,412,864h – 
4,278,190,079h 

Error 

$FFFD $FE00 –$FEFF $FE000000 –
$FEFFFFFF 

FID: Signal saturated, out of 
range, or error from source 
transmitter 

65535 65280 – 65535 4,278,190,080 – 
4,294,967,294 

Not 
Available / 

Not 
Requested 

$FFFF $FF00 –$FFFF $FF000000 –
$FFFFFFFF 

FID: Parameter is not 
applicable in the current state, 
not available from the 
controller, or not requested 

† Note that 2-bit data is not transmitted individually, but rather within a register. 
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19 MONITORING SOFTWARE (EMCP 3.2 & 3.3) 
The EMCP 3 Monitoring Software can be used to control and monitor a generator set over the 
SCADA data link.  This functionality is available on the EMCP 3.2 and EMCP 3.3.  

 

 
FIGURE  73: EMCP 3 MONITORING SOFTWARE SCREEN 

 
FIGURE  73 shows the default control panel, provided with the EMCP 3 Monitoring Software.  
Control Panels can be edited or created, as shown in Chapter 19.3, Creating A Control Panel 
View. 

19.1 SOFTWARE SETUP 
The computer must first be connected to the EMCP 3 GSC over the SCADA Data Link following 
the instructions located in the EMCP 3 Monitoring Software Quick Start Guide Chapter 19.2.   

After launching the program, it will ask for a login name and a password.  You may use the 
default username of administrator and enter admin for the password as shown in FIGURE  74.     

To add the device to the network, select Network > Add Device or right-click on the cable 
symbol in the top left corner (where it says Offline) and select Add Device.   
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FIGURE  74: LOGIN SCREEN 

For Device Name, enter a name of your choosing for the device and then select the device type 
and the node address as shown in FIGURE  75.  Make sure that the node address matches the 
SCADA Data Link Slave Address setpoint on the EMCP 3 GSC.   

The setpoint can be found from the main menu by making the following selections: Configure > 
Setpoints > Network > Data Link – SCADA. 

 

 
FIGURE  75: ADDING THE DEVICE 
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Check the online configuration settings by selecting Network > Online Configuration or again by 
right clicking on the cable symbol and selecting Online Configuration.  Verify that the connection 
interface is correct and that the baud rate and parity match the settings on the EMCP 3 GSC as 
shown in FIGURE  76.  On the EMCP 3 GSC, these settings can be found from the main menu 
by making the following selections: Configure > Setpoints > Network > Data Link – SCADA.  

To create a simple test, select Edit > Control Panel Configuration.  In this control panel, a digital 
display showing battery voltage will be added to verify that a connection between the EMCP 3 
GSC and the software has been established.  (Simply telling the software to Go Online does not 
verify a connection.  This is because the software will appear to successfully go online whether 
or not a connection is present). 

 

 
 

 FIGURE  76: ONLINE CONFIGURATION SETTINGS 

Select Edit > Add Control > Digital Display or click the Digital Display button on the toolbar.  To 
add the control, double click on the desired location within the control panel.  This will add the 
digital display as shown in FIGURE  77. 
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FIGURE  77: ADDING THE DIGITAL DISPLAY 

After adding the display, it needs to be set to display battery voltage.  Right click on the display 
and select Set Parameter Association.  This will bring up a Control Configuration window as 
shown in FIGURE  78.   

 
FIGURE  78: CONTROL CONFIGURATION WINDOW 
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Under Device/Group, select the previously named device (ENG in this example) and all of the 
possible parameters for the digital display will be shown in the Parameter List.   
Double click on Battery Voltage to select it.  This can be seen in FIGURE  79.   

Make sure to double click the parameter or it will not be selected.  Also, it shows up under 
Selected Parameter after it has been selected.   

Click ok and the parameter will be set. 

 

 
FIGURE  79: SELECTING A PARAMETER 

Now that the parameter is set, save the document by selecting File > Save or click the Save 
button on the toolbar.   

Select a location and name for the file and click save.  The control panel should now look similar 
to FIGURE  80. 
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FIGURE  80: CONTROL PANEL THAT DISPLAYS BATTERY VOLTAGE 

Close the Control Panel Edit window by selecting the X in the top right corner of the window.  
Make sure to close only the control panel window and not the program.  Select View > Control 
Panel Data to bring up the Control Panel View window.  This is shown in FIGURE  81. 

 

 
FIGURE  81: CONTROL PANEL DISPLAY 

To test the connection, select Network > Go Online or right click on the cable symbol in the top 
left corner (where it says Offline) and select Go Online.  This tells the computer to begin the 
connection and within a few seconds the battery voltage should be displayed.  It should look 
similar to FIGURE  82. 
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FIGURE  82: CONTROL PANEL DISPLAY AFTER GOING ONLINE 

If the battery voltage is reading correctly, then the connection is working properly and it is time 
to begin designing the control panel view.  If not, first make sure that the window being 
displayed is the Control Panel View window and not the Control Panel Edit window.   

Also, recheck all settings mentioned at the beginning of this setup chapter.  Finally, check the 
wiring for any possible problems.   

Another simple test is to select the View Current Events button from the toolbar and it should 
display all events currently listed on the EMCP 3 GSC. 

19.2 QUICK START GUIDE 
The EMCP 3 Monitoring Software Quick Start Guide is located on the SIS website 
(https://sis.cat.com).  

Log into the Caterpillar network with the correct CWS ID and password.  

Click on to the link to the SIS web site above or copy and paste it into you browser.  

Under Highlights, on the left, select Downloads. 

 

https://sis.cat.com/
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The next screen will display a list of available downloads.   

 
Using the scroll bar on the right, scroll down until you see EMCP Monitoring Software in the left 
column. The next column is title EMCP Monitoring Software.zip and to the far right is the link 
Additional Info. Click on it for the Quick Start Guide. 
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The next screen will display EMCP3 Monitoring Software.   

 
 
At the bottom of the text, select: ECMP monitoring software – QUICKSTART ver1_ 0,doc to 
start the download. 

 

The File Download box will open.  

 
Select OPEN to start a document editor and display the Quick Start Guide or SAVE to a folder. 
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19.3 CREATING A CONTROL PANEL VIEW 
In the software setup Chapter, a control panel view was created to display battery voltage.  A 
control panel view, however, can be created to do many more things.  This Chapter will provide 
an overview of the steps necessary to design a control panel view. 

To begin, select Edit > Control Panel Configuration to bring up the editing window.  The entire 
control panel can be created from within this window.  This window is shown in FIGURE  83.  If 
this option is unavailable, close out of the Control Panel View window.  Both windows cannot be 
open at the same time.  Also, it is recommended to go offline before editing the control panel 
view.  This can be done by selecting Network > Go Offline or by right clicking on the cable 
symbol and selecting Go Offline. 

 
FIGURE  83: CONTROL PANEL EDIT WINDOW 

NOTE: The monitoring software allows the use to create new control panel views by 
selecting which parameters to display and in what format (circular gauge, 
numeric display, etc). then save the configuration to a file. A Default 
configuration file is supplied is supplied with the monitoring software and the 
file name default.pvc contains basic screens with standard parameters 
already built in . The user can modify the file and save as a new file if 
desired 

To add new controls and displays simply click the proper button on the toolbar and then double 
click within the control panel.  Controls can also be chosen by selecting Edit > Add Control and 
choosing a control from the list. 

There are three types of controls available – displays, switches and LEDs.  The display controls 
consist of the circular gauge, digital display, thermometer and linear gauge.  These displays can 
be used to display information about the generator set.  Some examples include engine coolant 
temperature, generator total real power, engine RPM and battery voltage.  This can be seen in 
FIGURE  84. 
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FIGURE  84: DISPLAY CONTROLS 

The switches consist of the sliding switch, panel switch, lever switch, rocker switch, single 
button and rotary switch.  The rotary knob and the multiple button switch also fall into this 
category.  These switches can be used to control something that is either off or on.  Some 
examples include emergency stop, remote initiate command and digital selectors.  The multiple 
button switch can also control the engine operating mode command as in FIGURE  85. 

 
FIGURE  85: SWITCH CONTROLS 

 
The LEDs consist of the single LED and the multiple LED control.  These LEDs are used to 
display outputs from the genset.  Some examples include digital input active state and engine 
operating mode (see FIGURE  86).   

 
FIGURE  86: LED CONTROLS 



153 

19 MONITORING Software (EMCP 3.2 & 3.3) 

After adding controls to the control panel, they can be moved and resized.  To move a control, 
simply click and drag it to its desired location.  To resize it, select the control by clicking on it 
and then move the mouse to the edge of the control until the pointer becomes an arrow.  Then, 
just simply click and drag it to its desired size as shown in  FIGURE  87.  

 
FIGURE  87: MOVING AND RESIZING CONTROLS 

Other display properties can be changed for any of the controls by right clicking on the control 
and selecting Set Display Properties.  For example, the font size and color for the digital display 
can be changed as shown in FIGURE  88. 

 
FIGURE  88: CHANGING DISPLAY PROPERTIES OF THE DIGITAL DISPLAY 
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Each control has different parameters that can be associated with it.  To change the parameters 
follow the instructions in the setup Chapter. This time, however, select any desired parameter. 
The possible parameters can also be viewed under the following categories: block types, 
control, engine, generator, I/O and status. 
To do this, click the + next to the device name in the Device/Group window and select the 
desired category as shown in FIGURE  89. 

 
FIGURE  89: VIEWING PARAMETERS BY CATEGORY 

Remember to double click the desired parameter to select it.  Click ok and the parameter will be 
set.  This can be seen in FIGURE  90. 
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FIGURE  90: SETTING THE PARAMETER FOR THE DIGITAL DISPLAY 

After selecting a desired parameter, the displayed text can be changed by right clicking on the 
text box and selecting Set Text or simply by double clicking on the text.  This change can be 
seen in FIGURE  91. 

 
FIGURE  91: EDITING THE TEXT AND FONT SETTINGS 

The background of the control panel can also be changed.  Right click on an empty space in the 
control panel and select Set Background Image or select Edit > Set Background Image.  To 
change the background to a simple color, open Paint and create a screen of the desired color.  
Then save it and open it as the background image. 

The controls and text can also be set to transparent.  This is done by right clicking on the 
desired item and selecting Display Transparent.  These changes can be seen in FIGURE  92. 
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FIGURE  92: CHANGING BACKGROUND IMAGE AND SETTING CONTROLS TO TRANSPARENT 

Tabs can also be used on the control panel.  To rename the current tab select Edit > Rename 
Selected Tab.  To add another tab select Edit > Add Tab.  To edit the new tab, simply click that 
tab and the new sheet will open.  This can be seen in FIGURE  93. 

 
FIGURE  93: ADDING AND RENAMING TABS 

NOTE:  When using multiple tabs, the parameters for each control should be set after 
moving and resizing them.  If this is not done, the control may go back to its 
original position when the parameter was first set and possibly corrupt the 
entire tab.  This is not necessary for the first tab, only the following ones. 

If moving or resizing a control after setting the parameter is necessary, move it to the desired 
location and then RESET the parameter again.  This will RESET its standard position and prevent 
the control from moving.  Be sure to RESET the parameter for any control that has been moved.  
Again, this is not necessary for the first tab. 
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19.4 LOGGING DATA TO A FILE 
The EMCP 3 GSC Monitoring Software can also view data in text format and can log this data to 
a file.  To pick the data to be logged, select Edit > Data Log Configuration. 

To choose the logging data, select the desired parameter under the parameter list and click add 
or simply double click the desired parameter.  This should add the parameter to the right of the 
screen where all selected parameters are located.  Multiple parameters can be chosen if 
desired.  This can be seen in FIGURE  94. 

The parameters can also be viewed under the following groups: block types, control, engine, 
generator, I/O, and status.  To select a certain group type, click on the desired choice under the 
Device/Group heading.  This will change the parameter list to show only the parameters that fall 
under the selected group. 

After selecting the data, click ok to close the configuration screen.   

 
FIGURE  94: DATA LOG CONFIGURATION WINDOW 

To view this data select View > Data Log Data.  This will bring up a new screen as shown in 
FIGURE  95.  If the data value says Offline, be sure to go online as described in the software 
setup Chapter.  Once online, select Data Configuration > Arm or press the play button on the 
toolbar to begin receiving the data. 

 
FIGURE  95: VIEWING DATA LOG VALUES 
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This data can also be logged to a file.  First, go back to the Data Log Configuration window by 
selecting Edit > Data Log Configuration.  On the right side of the screen where the parameters 
are located, select the Data Storage tab.  Write the desired name and location of the file into the 
box next to Log File or click browse to select the name and location.  This can be seen in 
FIGURE  96. 

Select the Triggering tab to choose the start and stop events.  For the start event, select either 
On Arm, Manual Trigger, or Absolute Time.  On Arm will start the data collection immediately 
after selecting Arm or after clicking the play button. Manual Trigger will begin the data collection 
once the manual trigger button on the toolbar has been pushed or by selecting Data 
Configuration > Start Trigger.  Absolute Time will begin the data collection at the specific data 
and time specified. The stop event can be configured for Manual Trigger, Duration, or Absolute 
Time. Manual Trigger will stop the data collection once the manual trigger button is clicked or by 
selecting Data Configuration > Stop Trigger.  Duration will stop collecting data as soon as the 
specified amount of time has passed. 

 
FIGURE  96: SETTING THE LOG FILE 

Absolute Time will stop the data collection once the specified date and time is met. 

After the data has been collected, the text file can be opened.  Find the saved file and open it in 
a text editor such as notepad.  The file will contain a timestamp from the start of data logging as 
well as data captured according to the Base Scan Rate setting in the Data Log Configuration 
window shown in FIGURE  96. The file should look similar to the one shown in FIGURE  97. 

 
FIGURE  97: LOG FILE 
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20 INSTALLING & UPGRADING SOFTWARE 
The EMCP 3 supports field-programming (called flashing) of software for all of the modules.  
This is done by using the Caterpillar® Service Tool software and a Caterpillar Communication 
Adapter connected to one of the J1939 data link service connectors. 

The flashing feature is only supported on the J1939 Primary data link even though the EMCP 3 
GSC is connected to both data links.  Refer to your generator set package documentation for 
the location of the service connectors. 

To flash the EMCP 3 requires the following hardware and software: 
 

SOFTWARE AND HARDWARE REQUIRED 

 The Caterpillar® Service Tool software installed and licensed on a PC 

 A Caterpillar Communication Adapter 

 A 9-pin Deutsch service connection to the appropriate J1939 data link 

 The new application software flash file for the target module 

 The J1939 Primary data link service connector must be used for modules connected to 
the J1939 Primary Data Link.   

 The J1939 Accessory data link service connector must be used for modules connected 
to the J1939 Accessory Data Link.   

20.1 UPGRADING SOFTWARE   

CAUTION: To UPGRADE software, steps 1, 2, and 3 must be completed first before 
flashing the software upgrade (steps 4 – 9).  

To install NEW software into a BLANK MODULE, skip to steps 4 - 9. 

NOTE: To UPGRADE use the following Steps 1 – 9. 

1. Stop the generator set 

The EMCP 3 modules cannot be flashed while the generator set is running.  The engine 
must be stopped (the Engine Overview screen should show 0 rpm and STOPPED).  

 

 
FIGURE 98: ENGINE OVERVIEW SCREEN - STOPPED 

2. Back up your current configuration (all of the setpoint values) 
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See Chapter 12.1 SAVING EMCP 3 CONFIGURATION DATA for instructions.  The 
procedure given there is for the EMCP 3 GSC; the process is similar for each of the 
EMCP 3 modules. 

NOTE: Flashing application software does not affect the setpoints.  However, 
should a problem occur during flashing, this backup can be used to 
quickly configure a replacement module and minimize downtime. 

3. Record your current software version information 

This is done by connecting to the appropriate J1939 data link, and connecting with the 
Caterpillar® Service Tool, and viewing the ECM Summary information (see example 
screenshot below, FIGURE 99).  

 
FIGURE 99: ECM SUMMARY INFORMATION 

NOTE: This is useful in case the customer wishes to roll back to the previous 
version, this information can be used to obtain the correct flash file. 

20.2 INSTALLING SOFTWARE INTO A BLANK MODULE  

NOTE: For BLANK MODULE  software installation use steps 4 – 9. 

4. Connect to the module using WinFlash 

After connecting to the target module with the Caterpillar® Service Tool, enter the 
WinFlash component by selecting Utilities > WinFlash as shown in FIGURE 100. 

 
FIGURE 100: WINFLASH 
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5. Select the target module 

After the module(s) have been found and listed, click on the target module and click on 
the Select ECM button below the list (if the EMCP 3 is the only detected ECM, then the 
Select ECM button will be grayed out) as shown in FIGURE 101. 

 
FIGURE 101: TARGET MODULE 

NOTE: Occasionally, WinFlash will not find all of the modules on the J1939 data 
link to which it is connected.  If you are certain that the target module is 
connected to the same J1939 data link, you may attempt to re-scan the 
data link by pressing F8 (or selecting File > Update ECM List). 

6. Select the flash file 

On the right side of the window, click on Browse… and navigate to the folder where the 
new application software flash file is located (FIGURE 102). 

7. Click to select the file, and click on open 
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FIGURE 102: FLASH FILE SELECTION 

8. Begin flashing 

Click on Begin Flash at the bottom of the window. 

This process may take up to 10 minutes, depending on the file size and connection 
speed.  Typically, the EMCP 3 GSC application flash file will take 5-10 minutes, and the 
other modules will take less time.  

NOTE: The flashing process will abort at this step if the EMCP 3 is not 
STOPPED, or if an incorrect version of software was selected. 
This includes EMCP 3.1 versus 3.2 versus 3.3 software. 
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FIGURE 103: LOADING FLASH FILE 

9. Complete 

When the flashing process is complete, the ECM that was flashed will reboot.  Also, 
WinFlash will bring up a window giving options for what to do next (see FIGURE 104 
below).  This indicates that the software has finished flashing, and is ready to use.  

 
FIGURE 104: FLASHING PROCESS COMPLETE 

The EMCP 3 GSC will automatically reboot If it was the module that was flashed with 
new application software.  

On startup, the EMCP 3 shows the software part number.   

Verify the software part number matches the new application software that was flashed 
(FIGURE 105). 

 

 
FIGURE 105: SOFTWARE PART NUMBER 
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21 SCADA PARAMETER INFORMATION (EMCP 3.2 & 3.3) 
This Chapter provides information on Parameters by function. For an alphabetical list of 
parameters, see APPENDIX B: Alphabetic Reference Of Modbus Registers. 

21.1 DATA LINK SECURITY 
Data link security uses a different set of passwords than the EMCP 3 GSC local security.  The 
passwords grant access to the same levels of functionality and setpoints, however.  FIGURE  106 
below illustrates the different security levels.   

NOTE: The display and SCADA can be at different access levels at the same time. 

 

 
 

FIGURE  106: ILLUSTRATION OF EMCP 3 GSC SECURITY LEVELS 

 

The EMCP 3 GSC supports five levels of SCADA access, with increasing permissions: 
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NO ACCESS 
This level only allows access to two registers: Current Security Level (732), and Write Access 
Password (700). Any other read queries will return unavailable data ($FF’s), and write queries 
will fail with an exception response. 

LEVEL 0 ACCESS 
This level allows access to all Modbus registers.  However, none of the setpoints can be written 
with this access level.  See Chapter 7 for information about programming EMCP 3 GSC 
setpoints via Modbus. 

LEVEL 1 ACCESS 
This level allows access to all Modbus registers.  It also allows the changing of setpoints that 
have a security level of Level 1.  See APPENDIX D for information about setpoints and their 
associated security levels. 

LEVEL 2 ACCESS 
This level allows access to all Modbus registers.  It also allows the changing of setpoints that 
have a security level of Level 1 or 2.  See APPENDIX D for information about setpoints and their 
associated security levels. 

LEVEL 3 ACCESS 
This level allows access to all Modbus registers.  It also allows the changing of setpoints that 
have a security level of Level 1, 2 or 3. See APPENDIX D for information about setpoints and 
their associated security levels.  The Caterpillar Dealer TC must be contacted to acquire a Level 
3 Password. 

NOTE: If a password for a certain security level is not configured, or set to a single 
zero, that password is disabled.  If access to the level below that is acquired, 
the EMCP 3 GSC will automatically grant access to the higher (password-
disabled) level.  For example, if there is a password configured for Level 1, 
but not for Level 2, then the EMCP 3 GSC will initialize to Level 0.  Then if 
the correct Level 1 password is entered, the EMCP 3 GSC will automatically 
grant Level 2 Access. 

The SCADA, Level 1, or Level 2 passwords can be changed by writing the new password to the 
SCADA Password, Level 1 Password, or Level 2 Password register, as long as the SCADA data 
link is at a sufficient access level.   

• To change the Level 1 password, Level 1 access must be obtained.   

• To change the SCADA or Level 2 passwords, Level 2 access must be obtained.   

• A higher level of access can be requested by writing the password of the desired 
level to the Write Access Password register.   

• A lower level of access can be requested simply by entering the desired security 
level number into the Write Current Security Level register. 

All of the passwords, as well as the phone-in prompt, use the 1-byte ASCII format and character 
set.  Each string is variable in length, so in order to enter a shorter password, the rest of the field 
may be padded with the space character ($20). 

All other characters are considered invalid data, and will result in a FID response. 
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Two of the built in timeout features will reset the security level after a period of inactivity:   

The first is the Level 0 Timeout, which resets the SCADA access level to level 0 (or the lowest 
unprotected level above level 0) after 10 minutes without any successful write commands over 
the SCADA data link.  To prevent this fixed timer from expiring without risking affecting functions 
of the EMCP 3 GSC, writing to the Key Press register (310) will reset this timer. 

The second is the SCADA Timeout, which resets SCADA access completely below the SCADA 
security level (or the lowest unprotected level).  The timeout for this is configurable from 0.1 
seconds to 1 hour – it is the SCADA Data Link Connection Timeout Interval setpoint, and will 
only expire after a period without ANY activity on the SCADA data link. 

WRITE ACCESS PASSWORD 
$02BC (700) - 8 REGISTERS (16 BYTES) LONG - WRITE 
Modbus register to which the password for the desired Access Level (0, 1, 2, or 3) is written.   

ASCII data, numbers (characters $30 through $39) valid. If the password is less than 16 
characters long, pad the end with space characters ($20).  

(Example: 12345678 = $ 31 32 33 34 35 36 37 38 20 20 20 20 20 20 20 20.  See APPENDIX A 
for a full programming example). 

LEVEL 1 PASSWORD 
$02C4 (708) - 8 REGISTERS (16 BYTES) LONG - WRITE 
Modbus register to which a new Level 1 password is written, to change the password. 

This is allowed only if current security level is 1 or higher.  

ASCII data, numbers (characters $30 through $39) valid. To disable this password, enter a 
single zero.  If a password is less than 16 characters long, pad the end with space characters 
($20). See APPENDIX A for a programming example. 

Level 2 Password 

$02CC (716) - 8 REGISTERS (16 BYTES) LONG - WRITE 
Modbus register to which a new Level 2 password is written, to change the password. 

This is allowed only if current security level is 2 or higher.  

ASCII data, numbers (characters $30 through $39) valid.  To disable this password, enter a 
password of a single zero.  If a password is less than 16 characters long, pad the end with 
space characters ($20). 

SCADA PASSWORD 
$02D4 (724) - 8 REGISTERS (16 BYTES) LONG - WRITE 
Modbus register to which a new SCADA password is written, to change the password. 

This is allowed only if the current security level is 2 or higher.  The SCADA password allows the 
user to obtain Level 0 Access to the EMCP 3 GSC. See APPENDIX A for a programming 
example. 

 ASCII data, numbers (characters $30 through $39) valid. The SCADA password may be a 
maximum of 8 characters long.  The last 8 characters should be set to NULL ($00) or space 
($20). To disable this password, enter a password of a single zero.   
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Pad the end of a password with space characters ($20). 

This password is stored as a numerical data.  Therefore, any leading zeros will be removed. 

CURRENT SECURITY LEVEL 
$02DC (732) - 1 REGISTER (2 BYTES) LONG - READ 
Current security level of the SCADA Data Link. See APPENDIX A for a programming example. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 3 

 

WRITE CURRENT SECURITY LEVEL 
$02DD (733) - 1 REGISTER (2 BYTES) LONG - WRITE 
Write a security level value into this register to drop to a lower security level.  In order to change 
to a higher security level, write a password to the Write Access Password register instead. See 
APPENDIX A for a programming example. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 3 

 

LEVEL 3 PASSWORD PHONE IN PROMPT 
$02DE (734) - 8 REGISTERS (16 BYTES) LONG - READ 
Numerical key that needs to be communicated to the factory support operator who can provide 
a Level 3 password.  Once the password is received, write it to the Write Access Password 
register (700). This is the same prompt as on the EMCP 3 GSC in the Configure – Security – 
Enter Level 3 menu. 

ASCII data, characters $30 through $39 valid.  

KEY PRESS 
$0136 (310) - 1 REGISTER (2 BYTES) LONG - WRITE 
Triggers a key press event on the control. 

The key press event is useful to reset the SCADA security level reset timer, which resets the 
SCADA access to level 0 after 10 minutes of inactivity.  Reading from Modbus registers will not 
reset the above timers, but writing to any Modbus register will do so.  This is a safe register to 
write, since it does not affect other functions of the EMCP 3.2 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

21.2 SPARE ANALOG INPUT 
The EMCP 3.2 and higher have a SPARE ANALOG INPUT.  It is factory-configured as one of three 
types of input:  

• Level 
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• Temperature 

• Pressure  

Based on the type configuration, it can be assigned to a particular SUSPECT PARAMETER 
NUMBER (SPN), and the PERCENTAGE (level), TEMPERATURE, or PRESSURE can be read over 
SCADA with the appropriate units.   

If the configuration is set to a specific sensor type and SPN but, a request is made over SCADA 
for a different type or SPN, then $FFFF will be sent in the response.   

For example: 

If Type Configuration is set to TEMPERATURE, and SPARE ANALOG INPUT PRESSURE is 
queried, the response will be $FFFF  

If Suspect Parameter Number is set to OIL FILTER DIFFERENTIAL PRESSURE, and AIR 
FILTER 1 DIFFERENTIAL PRESSURE FROM I/O PIN is queried, $FFFF will be returned. 

 

SPARE ANALOG INPUT PERCENTAGE 
$00CF (207) - 1 REGISTER (2 BYTES) LONG - READ 
Percentage of full scale measured by auxiliary level sensor #1. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, and the Type 
Configuration is set to Level. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

FUEL LEVEL FROM I/O PIN 
$0324 (804) - 1 REGISTER (2 BYTES) LONG - READ 
Ratio of volume of fuel to the total volume of fuel storage container, as measured by the 
auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Level, and the SPN is set to Fuel Level. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

EXTERNAL TANK FUEL LEVEL FROM I/O PIN 
$0325 (805) - 1 REGISTER (2 BYTES) LONG - READ 
Ratio of volume of fuel to the total volume of fuel storage container, as measured by the 
auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Level, and the SPN is set to External Tank Fuel Level. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 
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ENGINE OIL LEVEL FROM I/O PIN 
$0326 (806) - 1 REGISTER (2 BYTES) LONG - READ 
Ratio of current volume of engine sump oil to maximum required volume, as measured by the 
auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Level, and the SPN is set to Engine Oil Level. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

ENGINE COOLANT LEVEL FROM I/O PIN 
$0327 (807) - 1 REGISTER (2 BYTES) LONG - READ 
Ratio of volume of liquid found in engine cooling system to total cooling system volume, as 
measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Level, and the SPN is set to Engine Coolant Level. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

SPARE ANALOG INPUT TEMPERATURE 
$00D0 (208) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature measured by auxiliary temperature sensor #1. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, and the Type 
Configuration is set to Temperature. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

GENERATOR REAR BEARING TEMPERATURE FROM I/O PIN 
$00A2 (162) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of the bearing inside the alternator, as measured by the auxiliary analog input. 
Bearing 1 is the left or rear bearing. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Generator Rear Bearing 
Temperature. 

 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

ENGINE OIL TEMPERATURE FROM I/O PIN 
$0320 (800) - 1 REGISTER (2 BYTES) LONG - READ 
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Temperature of the engine lubricant, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Engine Oil Temperature. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

EXHAUST TEMPERATURE FROM I/O PIN 
$0321 (801) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of combustion byproducts leaving the engine, as measured by the auxiliary analog 
input.  

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Exhaust Temperature. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

LEFT MANIFOLD EXHAUST TEMPERATURE FROM I/O PIN 
$0322 (802) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of combustion byproducts within the left engine exhaust manifold, as measured by 
the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Left Exhaust Temperature. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

RIGHT MANIFOLD EXHAUST TEMPERATURE FROM I/O PIN 
$0323 (803) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of combustion byproducts within the right engine exhaust manifold, as measured 
by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Right Exhaust Temperature. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

AMBIENT AIR TEMPERATURE FROM I/O PIN 
$032E (814) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of the air surrounding the genset, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Temperature, and the SPN is set to Ambient Air Temperature. 
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RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

SPARE ANALOG INPUT PRESSURE 
$00D1 (209) - 1 REGISTER (2 BYTES) LONG - READ 
Pressure measured by auxiliary pressure sensor #1. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, and the Type 
Configuration is set to Pressure. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

FIRE EXTINGUISHER PRESSURE FROM I/O PIN 
$0328 (808) - 1 REGISTER (2 BYTES) LONG - READ 
Pressure of fire extinguisher contents, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Pressure, and the SPN is set to Fire Extinguisher Pressure. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

OIL FILTER DIFFERENTIAL PRESSURE FROM I/O PIN 
$0329 (809) - 1 REGISTER (2 BYTES) LONG - READ 
Change in engine oil pressure, measured across the filter, due to the filter and any accumulation 
of solid or semisolid material on or in the filter, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Pressure, and the SPN is set to Oil Filter Differential Pressure. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

AIR FILTER 1 DIFFERENTIAL PRESSURE FROM I/O PIN 
$032A (810) - 1 REGISTER (2 BYTES) LONG - READ 
Change in engine air system pressure, measured across the filter, due to the filter and any 
accumulation of solid foreign matter on or in the filter, as measured by the auxiliary analog input 
to the control. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Pressure, and if the Suspect Parameter Number configured for the Spare 
Analog Input is set to Air Filter Differential Pressure. 

RESOLUTION OFFSET DATA RANGE 
1 / 128 kPa / bit -250 kPa -250 to 251.99 kPa 
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FUEL FILTER DIFFERENTIAL PRESSURE FROM I/O PIN 
$032B (811) - 1 REGISTER (2 BYTES) LONG - READ 
Change in fuel delivery pressure, measured across the filter, due to accumulation of solid or 
semisolid matter on the filter element, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Pressure, and the Suspect Parameter Number configured for the Spare 
Analog Input is set to Fuel Filter Differential Pressure. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

STARTING AIR PRESSURE FROM I/O PIN 
$032D (813) - 1 REGISTER (2 BYTES) LONG - READ 
Gage pressure of air in an engine starting system that utilizes compressed air to provide the 
force required to rotate the crankshaft, as measured by the auxiliary analog input. 

This is applicable only when the Spare Analog Input Enable Status is Enabled, the Type 
Configuration is set to Pressure, and the Suspect Parameter Number configured for the Spare 
Analog Input is set to Starting Air Pressure. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

21.3 DISCRETE INPUTS AND OUTPUTS 
EMCP 3 GSC digital inputs, digital outputs, and relay outputs can be monitored over the 
SCADA data link.  Table 21:  shows the number of each available on each level of control.  If an 
input is queried that is not available on a particular control, then an FID or an exception 
response will be sent in the response. 

TABLE 21: DISCRETE I/O FOR EACH LEVEL OF EMCP 3 GSC 

 EMCP 3.1 † EMCP 3.2 EMCP 3.3 

Number of Digital Inputs 6 8 8 
Number of Digital Outputs 0 1 2 
Number of Relay Outputs 6 8 8 
Number of Digital Selectors 4 7 8 
† Note that although discrete I/O counts are given for the EMCP 3.1 for completeness, the EMCP 3.1 does 
not have SCADA functionality, and therefore is not within the scope of this Chapter. 

 

On the EMCP 3 GSC, the Source Configuration for each digital selector can be configured to 
input 1 through 10, or Data Link.  Each Digital Selector has one Modbus register to read the 
Digital Selector #n Commanded Value, and one to write a Digital Selector #n Activate 
Command.   

These queries will only affect or reflect the outputs if the Digital Selector #n Source 
Configuration setpoint is set to Data Link.   

Otherwise, these queries will set or read the SCADA command, but the EMCP 3 GSC will not 
use that command, and therefore the values will be meaningless. 
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DIGITAL INPUT #1 ACTIVE STATE  (THROUGH)  DIGITAL INPUT #8 ACTIVE STATE 
$0258 (600) THROUGH $025F (607) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates that Digital Input #n is ACTIVE. 

DIGITAL INPUT REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $0258 600 
2 $0259 601 
3 $025A 602 
4 $025B 603 
5 $025C 604 
6 $025D 605 
7 $025E 606 
8 $025F 607 

 

All of these registers have the same data structure and bit definitions. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

RELAY OUTPUT #1 ACTIVE STATE  (THROUGH)  RELAY OUTPUT #8 ACTIVE STATE 
$0268 (616) THROUGH $026F (623) - 1 REGISTER (2 BYTES) LONG - READ 
Relay Output #n is ACTIVE. 

RELAY OUTPUT REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $0268 616 
2 $0269 617 
3 $026A 618 
4 $026B 619 
5 $026C 620 
6 $026D 621 
7 $026E 622 
8 $026F 623 

 
All of these registers have the same data structure and bit definitions. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

DIGITAL OUTPUT #1 ACTIVE STATE 
$0270 (624) - 1 REGISTER (2 BYTES) LONG - READ 
Digital Output #1 is ACTIVE. 

BIT DEFINITIONS: 
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00 = FALSE 

01 = TRUE 

DIGITAL OUTPUT #2 ACTIVE STATE 
$0271 (625) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Digital Output #2 is ACTIVE. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

DIGITAL SELECTOR #1 ACTIVATE COMMAND  (THROUGH)  DIGITAL SELECTOR #10 
ACTIVATE COMMAND 
$0274 (628) THROUGH $027D (637) - 1 REGISTER (2 BYTES) LONG - WRITE 
SCADA command to activate Digital Selector #n. 

This will affect an output only if the SOURCE CONFIGURATION of the desired digital selector is set 
to DATA LINK.  

DIGITAL SELECTOR REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $0274 628 
2 $0275 629 
3 $0276 630 
4 $0277 631 
5 $0278 632 
6 $0279 633 
7 $027A 634 
8 $027B 635 
9 $027C 636 

10 $027D 637 
 
All of these registers have the same data structure and bit definitions. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

DIGITAL SELECTOR #1 COMMANDED VALUE  (THROUGH)  DIGITAL SELECTOR #10 
COMMANDED VALUE 
$027E (638) THROUGH $0287 (647) - 1 REGISTER (2 BYTES) LONG - READ 
Value of current Activate Command being applied to Digital Selector #n. 

This will reflect the active state of an output only if the Source Configuration of the 
corresponding digital selector is set to Data Link. 
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DIGITAL SELECTOR REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $027E 638 
2 $027F 639 
3 $0280 640 
4 $0281 641 
5 $0282 642 
6 $0283 643 
7 $0284 644 
8 $0285 645 
9 $0286 646 

10 $0287 647 
 
All of these registers have the same data structure and bit definitions. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

21.4 GENERATOR AC PARAMETERS  
The SCADA data link allows remote monitoring of various generator AC quantities.  These 
include per-phase as well as average or overall parameters; voltages, currents, powers, and 
power factors; real, reactive, and apparent powers. 

Some AC quantities are not valid for every setting of the Generator Connection Configuration 
setpoint.  If a parameter is queried while it is invalid, an FID will be sent in the response. Table 
22: shows which parameters are invalid under which wiring configurations. 

TABLE 22: AC QUANTITIES DEPENDENT ON WIRING CONFIGURATION 

 STAR 3-WIRE 
DELTA 

4-WIRE 
DELTA 

2-WIRE 
1-PHASE 

3-WIRE 
1-PHASE 

Gen Freq (0066h) OK OK OK OK OK 
VL-L AVG (0064h) OK OK OK OK OK 
VA-B (006Ch) OK OK OK OK OK 
VB-C (006Dh) OK OK OK Invalid Invalid 
VC-A (006Eh) OK OK OK Invalid Invalid 
VL-N AVG (0094h) OK Invalid OK Invalid OK 
VA (0072h) OK Invalid OK Invalid OK 
VB (0073h) OK Invalid OK Invalid OK 
VC (0074h) OK Invalid OK Invalid Invalid 
IAVG (0065h) OK OK OK OK OK 
IA (006Fh) OK OK OK OK OK 
IB (0070h) OK OK OK OK OK 
IC (0071h) OK OK OK Invalid Invalid 

 

GENERATOR AVERAGE AC RMS FREQUENCY 
$0066 (102) - 1 REGISTER (2 BYTES) LONG - READ 
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Average AC frequency measured at the generator output. 

RESOLUTION OFFSET DATA RANGE 
1/128 Hz / bit 0 Hz 0 to 501.9922 Hz 

 

GENERATOR AVERAGE LINE-LINE AC RMS VOLTAGE 
$0064 (100) - 1 REGISTER (2 BYTES) LONG - READ 
Average Line to Line RMS voltage measured at the generator output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR AVERAGE LINE-LINE AC RMS VOLTAGE PERCENT 
$00A3 (163) - 1 REGISTER (2 BYTES) LONG - READ 
Average Line to Line RMS voltage at the generator, as a percentage of nominal generator 
voltage. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99% 

 

GENERATOR PHASE A LINE-LINE AC RMS VOLTAGE 
$006C (108) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Line RMS voltage measured at the generator phase AB output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR PHASE B LINE-LINE AC RMS VOLTAGE 
$006D (109) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Line RMS voltage measured at the generator phase BC output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 
 

GENERATOR PHASE C LINE-LINE AC RMS VOLTAGE 
$006E (110) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Line RMS voltage measured at the generator phase CA output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 
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GENERATOR AVERAGE LINE-NEUTRAL AC RMS VOLTAGE 
$0094 (148) - 1 REGISTER (2 BYTES) LONG - READ 
The average Line to Neutral AC RMS voltage measured at the generator output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR PHASE A LINE-NEUTRAL AC RMS VOLTAGE 
$0072 (114) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Neutral RMS voltage measured at the generator phase A output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR PHASE B LINE-NEUTRAL AC RMS VOLTAGE 
$0073 (115) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Neutral RMS voltage measured at the generator phase B output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR PHASE C LINE-NEUTRAL AC RMS VOLTAGE 
$0074 (116) - 1 REGISTER (2 BYTES) LONG - READ 
Line to Neutral RMS voltage measured at the generator phase C output. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR AVERAGE AC RMS CURRENT 
$0065 (101) - 1 REGISTER (2 BYTES) LONG - READ 
Average RMS current measured at the generator output. 

RESOLUTION OFFSET DATA RANGE 
1 A / bit 0 A 0 to 64255 A 

 

 

GENERATOR PHASE A AC RMS CURRENT 
$006F (111) - 1 REGISTER (2 BYTES) LONG - READ 
RMS current measured at the generator phase A output. 

RESOLUTION OFFSET DATA RANGE 
1 A / bit 0 A 0 to 64255 A 
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GENERATOR PHASE B AC RMS CURRENT 
$0070 (112) - 1 REGISTER (2 BYTES) LONG - READ 
RMS current measured at the generator phase B output. 

RESOLUTION OFFSET DATA RANGE 
1 A / bit 0 A 0 to 64255 A 

 

GENERATOR PHASE C AC RMS CURRENT 
$0071 (113) - 1 REGISTER (2 BYTES) LONG - READ 
RMS current measured at the generator phase C output. 

RESOLUTION OFFSET DATA RANGE 
1 A / bit 0 A 0 to 64255 A 

 

GENERATOR OVERALL POWER FACTOR 
$0067 (103) - 1 REGISTER (2 BYTES) LONG - READ 
The average power factor of the generator. See APPENDIX A for a programming example. 

RESOLUTION OFFSET DATA RANGE 
1/16384 / bit -1.0 -1.0 to 1.0 

 

GENERATOR OVERALL POWER FACTOR LAGGING 
$0068 (104) - 1 REGISTER (2 BYTES) LONG - READ 
Lead/lag status for generator average power factor. 

BIT DEFINITIONS: 
00 = Power factor leading 

01 = Power factor lagging 

10 = Error 

11 = Not available 

 

GENERATOR TOTAL PERCENT KW 
$0069 (105) - 1 REGISTER (2 BYTES) LONG - READ 
Total real power delivered by the generator, as a percentage of generator rated power. 

 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251 % -251 to 250.99 % 

 

GENERATOR TOTAL REAL POWER 
$006A (106) - 2 REGISTERS (4 BYTES) LONG - READ 
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Total real power delivered by the generator. 

RESOLUTION OFFSET DATA RANGE 
1 W / bit -2000000000 W -2000000000 to +2211081215 W

 

GENERATOR PHASE A REAL POWER 
$0075 (117) - 2 REGISTERS (4 BYTES) LONG - READ 
The real power delivered by phase A of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 W / bit -2000000000 W -2000000000 to +2211081215 W

GENERATOR PHASE B REAL POWER 
$0077 (119) - 2 REGISTERS (4 BYTES) LONG - READ 
The real power delivered by phase B of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 W / bit -2000000000 W -2000000000 to +2211081215 W

 

GENERATOR PHASE C REAL POWER 
$0079 (121) - 2 REGISTERS (4 BYTES) LONG - READ 
The real power delivered by phase C of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 W / bit -2000000000 W -2000000000 to +2211081215 W

 

GENERATOR PHASE A APPARENT POWER 
$007B (123) - 2 REGISTERS (4 BYTES) LONG - READ 
The apparent power delivered by phase A of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 VA / bit -2000000000 VA -2000000000 to +2211081215 VA

 

GENERATOR PHASE B APPARENT POWER 
$007D (125) - 2 REGISTERS (4 BYTES) LONG - READ 
The apparent power delivered by phase B of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 VA / bit -2000000000 VA -2000000000 to +2211081215 VA

GENERATOR PHASE C APPARENT POWER 
$007F (127) - 2 REGISTERS (4 BYTES) LONG - READ 
The apparent power delivered by phase C of the generator. 
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RESOLUTION OFFSET DATA RANGE 
1 VA / bit -2000000000 VA -2000000000 to +2211081215 VA

 

GENERATOR PHASE A REACTIVE POWER 
$0081 (129) - 2 REGISTERS (4 BYTES) LONG - READ 
The reactive power delivered by phase A of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 VAr / bit -2000000000 VAr -2000000000 to +2211081215 VAr 

 

GENERATOR PHASE B REACTIVE POWER 
$0083 (131) - 2 REGISTERS (4 BYTES) LONG - READ 
The reactive power delivered by phase B of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 VAr / bit -2000000000 VAr -2000000000 to +2211081215 VAr 

 

GENERATOR PHASE C REACTIVE POWER 
$0085 (133) - 2 REGISTERS (4 BYTES) LONG - READ 
The reactive power delivered by phase C of the generator. 

RESOLUTION OFFSET DATA RANGE 
1 VAr / bit -2000000000 VAr -2000000000 to +2211081215 VAr 

 

GENERATOR PHASE A POWER FACTOR 
$0087 (135) - 1 REGISTER (2 BYTES) LONG - READ 
The power factor of phase A of the generator. 

RESOLUTION OFFSET DATA RANGE 
1/16384 / bit -1.0 -1.0 to 1.0 

 

GENERATOR PHASE B POWER FACTOR 
$0088 (136) - 1 REGISTER (2 BYTES) LONG - READ 
The power factor of phase B of the generator. 

RESOLUTION OFFSET DATA RANGE 
1/16384 / bit -1.0 -1.0 to 1.0 

 

 

GENERATOR PHASE C POWER FACTOR 
$0089 (137) - 1 REGISTER (2 BYTES) LONG - READ 
The power factor of phase C of the generator. 
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RESOLUTION OFFSET DATA RANGE 
1/16384 / bit -1.0 -1.0 to 1.0 

 

GENERATOR TOTAL APPARENT POWER 
$008A (138) - 2 REGISTERS (4 BYTES) LONG - READ 
The total apparent power delivered by the generator. 

RESOLUTION OFFSET DATA RANGE 

1 VA / bit -2000000000 VA -2000000000 to 
+2211081215 VA 

 

GENERATOR TOTAL PERCENT KVA 
$008C (140) - 1 REGISTER (2 BYTES) LONG - READ 
The total apparent power delivered by the generator, as a percentage of generator rated 
apparent power. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251 % -251 to 250.99 % 

 

GENERATOR TOTAL REACTIVE POWER 
$008D (141) - 2 REGISTERS (4 BYTES) LONG - READ 
The total reactive power delivered by the generator. 

 

RESOLUTION OFFSET DATA RANGE 
1 VAr / bit -2000000000 VAr -2000000000 to +2211081215 VAr 

 

GENERATOR TOTAL PERCENT KVAR 
$008F (143) - 1 REGISTER (2 BYTES) LONG - READ 
The total reactive power delivered by the generator, as a percentage of generator rated reactive 
power. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251 % -251 to 250.99 % 

 

GENERATOR TOTAL KW HOURS EXPORT 
$0090 (144) - 2 REGISTERS (4 BYTES) LONG - READ 
The total kilowatt-hours that have been exported by the generator. 

RESOLUTION OFFSET DATA RANGE 
1 kWh / bit 0 kWh 0 to 4211081215 kWh 
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GENERATOR TOTAL KVAR HOURS EXPORT 
$0092 (146) - 2 REGISTERS (4 BYTES) LONG - READ 
The total kilovar-hours that have been exported by the generator. 

RESOLUTION OFFSET DATA RANGE 
1 kVArh / bit 0 kVArh 0 to 4211081215 kVArh 

 

GENERATOR PHASE A POWER FACTOR LAGGING 
$009F (159) - 1 REGISTER (2 BYTES) LONG - READ 
Lead/lag status for generator phase A power factor. 

BIT DEFINITIONS: 
00 = Power factor leading 

01 = Power factor lagging 

10 = Error 

11 = Not available 

 

GENERATOR PHASE B POWER FACTOR LAGGING 
$00A0 (160) - 1 REGISTER (2 BYTES) LONG - READ 
Lead/lag status for generator phase B power factor. 

BIT DEFINITIONS: 
00 = Power factor leading 

01 = Power factor lagging 

10 = Error 

11 = Not available 

 

GENERATOR PHASE C POWER FACTOR LAGGING 
$00A1 (161) - 1 REGISTER (2 BYTES) LONG - READ 
Lead/lag status for generator phase C power factor. 

BIT DEFINITIONS: 
00 = Power factor leading 

01 = Power factor lagging 

10 = Error 

11 = Not available 

 

DESIRED GENSET OUTPUT VOLTAGE 
$0421 (1057) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 
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The desired RMS voltage to be delivered by the genset. 

RESOLUTION OFFSET DATA RANGE 
1 V / bit 0 V 0 to 64255 V 

 

GENERATOR FREQUENCY WITHIN LIMITS 
$042B (1067) - 1 REGISTER (2 BYTES) LONG - READ 

Indicates whether the generator frequency is below the threshold for a generator over 
frequency shutdown and above the threshold for a generator under frequency shutdown. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

GENERATOR VOLTAGE WITHIN LIMITS 
$042C (1068) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the generator voltage is below the threshold for a generator over voltage 
shutdown and above the threshold for a generator under voltage shutdown. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

21.5 EXTERNAL DEVICE PARAMETERS 
The SCADA data link allows monitoring of not only parameters internally generated or sensed 
by the EMCP 3 GSC, but also of parameters transmitted from other devices over the J1939 data 
link.  These may include the engine ECM, the thermocouple module, or any other supported 
module on the J1939 network(s). 

Furthermore, there are parameters available from the EMCP 3 GSC to indicate what optional 
modules are currently in communication with the EMCP 3 GSC via the Primary or Accessory 
J1939 data link.  These parameters could be monitored, for example, to determine which EVENT 
LOGS to read. 

GENSET CONTROL ONLINE 
$0442 (1090) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the EMCP 3 GSC is on the communication network. This will always be True. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

ENGINE CONTROL ONLINE 
$0443 (1091) - 1 REGISTER (2 BYTES) LONG - READ 



184 

21  SCADA Parameter Information  

Indicates whether the engine ECM is in communication with the EMCP 3 GSC via J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

SECONDARY ENGINE CONTROL ONLINE 
$0444 (1092) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the secondary engine ECM is in communication with the EMCP 3 GSC via 
J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

EXTERNAL I/O #1 ONLINE 
$0445 (1093) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the DIO module instance #1 is in communication with the EMCP 3 GSC via 
J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

EXTERNAL I/O #2 ONLINE 
$0446 (1094) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the DIO module instance #2 is in communication with the EMCP 3 GSC via 
J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

EXTERNAL I/O #3 ONLINE 
$0447 (1095) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the DIO module instance #3 is in communication with the EMCP 3 GSC via 
J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 
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EXTERNAL I/O #4 ONLINE 
$0448 (1096) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the DIO module instance #4 is in communication with the EMCP 3 GSC via 
J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

DIGITAL AVR ONLINE 
$0449 (1097) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the digital AVR module is in communication with the EMCP 3 GSC via J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

RTD MODULE ONLINE 
$044A (1098) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the RTD module is in communication with the EMCP 3 GSC via J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

THERMOCOUPLE #1 ONLINE 
$044B (1099) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the thermocouple module instance #1 is in communication with the EMCP 3 
GSC via J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

THERMOCOUPLE #2 ONLINE 
$044C (1100) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates whether the thermocouple module instance #2 is in communication with the EMCP 3 
GSC via J1939. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 
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AVR BIAS PERCENT 
$0422 (1058) - 1 REGISTER (2 BYTES) LONG - READ 
The percentage bias being applied to the voltage regulator desired genset output voltage, as a 
percentage of the Maximum Generator Voltage Output Bias Percentage setpoint.  This will 
increment by 0.5% each time the Voltage Adjust up or down arrow is pressed on the EMCP 3.2 
See APPENDIX A for a programming example. 

{Voltage Regulator Desired Genset Output Voltage} = {‘Desired Genset Output Voltage’ 
setpoint} x (1 + {‘Maximum Generator Voltage Output Bias Percentage’ setpoint} x (1 + {‘AVR 
Bias Percent’ register} ) ) 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

AVR BIAS PERCENT INCREMENT COMMAND 
$0423 (1059) - 1 REGISTER (2 BYTES) LONG - WRITE 
Increments the percentage bias to be applied to the Automatic Voltage Regulator.  For more 
information on these commands, refer to the Programming Examples Chapter. See APPENDIX 
A for a programming example. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

SPEED BIAS PERCENT 
$0425 (1061) - 1 REGISTER (2 BYTES) LONG - READ 
Read the percentage bias being applied to the speed command output.  This is a percent of the 
Maximum Engine Speed Bias setpoint.  This will increment by 0.5% each time the Speed Adjust 
left or right arrow is pressed on the EMCP 3 GSC display. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

SPEED BIAS PERCENT INCREMENT COMMAND 
$0426 (1062) - 1 REGISTER (2 BYTES) LONG - WRITE 
Increments the percentage bias being applied to the speed command output. For more 
information on these commands, refer to the Programming Examples Chapter. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

GENERATOR FRONT BEARING TEMPERATURE FROM DATA LINK 
$0095 (149) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of the bearing inside the alternator. This is the right or front bearing.  

Applies to EMCP 3.3 only 
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RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

GENERATOR REAR BEARING TEMPERATURE FROM DATA LINK 
$0096 (150) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the bearing inside the alternator. This is the left or rear bearing. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

GENERATOR PHASE A WINDING TEMPERATURE FROM DATA LINK 
$0097 (151) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the Phase A winding inside the alternator. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

GENERATOR PHASE B WINDING TEMPERATURE FROM DATA LINK 
$0098 (152) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the Phase B winding inside the alternator. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

GENERATOR PHASE C WINDING TEMPERATURE FROM DATA LINK 
$0099 (153) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the Phase C winding inside the alternator. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

 

ENGINE OIL PRESSURE FROM DATA LINK 
$00D9 (217) - 1 REGISTER (2 BYTES) LONG - READ 
Gage pressure of oil in engine lubrication system as broadcast on the J939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 
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ENGINE COOLANT TEMPERATURE FROM DATA LINK 
$00DB (219) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of liquid found in engine cooling system, as broadcast on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

CYLINDER #1 EXHAUST PORT TEMPERATURE FROM DATA LINK (THROUGH) 
CYLINDER #20 EXHAUST PORT TEMPERATURE FROM DATA LINK 
$00DD (221) THROUGH $00F0 (240) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature at the cylinder exhaust port of the engine, as received from another module on the 
J1939 Data Link. 

CYLINDER NUMBER REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $00DD 221 
2 $00DE 222 
3 $00DF 223 
4 $00E0 224 
5 $00E1 225 
6 $00E2 226 
7 $00E3 227 
8 $00E4 228 
9 $00E5 229 
10 $00E6 230 
11 $00E7 231 
12 $00E8 232 
13 $00E9 233 
14 $00EA 234 
15 $00EB 235 
16 $00EC 236 
17 $00ED 237 
18 $00EE 238 
19 $00EF 239 
20 $00F0 240 

 

All have same data structure. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

EXHAUST MANIFOLD #1 TEMPERATURE FROM DATA LINK 
$00F1 (241) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 
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Temperature of combustion byproducts within the left engine exhaust manifold, as received 
from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

EXHAUST MANIFOLD #2 TEMPERATURE FROM DATA LINK 
$00F2 (242) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of combustion byproducts within the right engine exhaust manifold, as received 
from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

INTAKE MANIFOLD #1 TEMPERATURE FROM DATA LINK 
$00F3 (243) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of pre-combustion air found in intake manifold #1 of engine air supply system, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

INTAKE MANIFOLD #2 TEMPERATURE FROM DATA LINK 
$00F4 (244) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of pre-combustion air found in intake manifold #2 of engine air supply system, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

ENGINE OIL TEMPERATURE FROM DATA LINK 
$00F5 (245) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the engine lubricant, as received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

ENGINE FUEL TEMPERATURE FROM DATA LINK 
$00F6 (246) - 1 REGISTER (2 BYTES) LONG - READ 
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Applies to EMCP 3.3 only 

Temperature of the engine fuel as received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

FUEL PRESSURE FROM DATA LINK 
$00F7 (247) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Gage pressure of fuel in system as delivered from supply pump to the injection pump, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

CRANKCASE PRESSURE FROM DATA LINK 
$00F8 (248) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Gage pressure inside engine crankcase, as received from another module on the J1939 Data 
Link. 

RESOLUTION OFFSET DATA RANGE 
1 / 128 kPa / bit -250 kPa -250 to 251.99 kPa 

 

BOOST PRESSURE FROM DATA LINK 
$00F9 (249) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Gage pressure of air measured downstream on the compressor discharge side of the 
turbocharger, as received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

OIL FILTER DIFFERENTIAL PRESSURE FROM DATA LINK 
$00FB (251) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Change in engine oil pressure, measured across the filter, due to the filter and any accumulation 
of solid or semisolid material on or in the filter, as received from another module on the J1939 
Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 
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FUEL FILTER DIFFERENTIAL PRESSURE FROM DATA LINK 
$00FC (252) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Change in fuel delivery pressure, measured across the filter, due to accumulation of solid or 
semisolid matter on the filter element, as received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

AIR FILTER 1 DIFFERENTIAL PRESSURE FROM DATA LINK 
$00FD (253) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Change in engine air system pressure, measured across the filter, due to the filter and any 
accumulation of solid foreign matter on or in the filter, as received from another module on the 
J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
1 / 128 kPa / bit -250 kPa -250 to 251.99 kPa 

 

TOTAL FUEL CONSUMPTION FROM DATA LINK 
$00FE (254) - 2 REGISTERS (4 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Accumulated amount of fuel used during engine operation, as received from another module on 
the J1939 Data Link.. 

RESOLUTION OFFSET DATA RANGE 
0.5 L / bit 0 L 0 to 2105540607.5 L 

 

INSTANTANEOUS FUEL CONSUMPTION FROM DATA LINK 
$0100 (256) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Amount of fuel used by engine per unit time, as received from another module on the J1939 
Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.05 L / h per bit 0 L/h 0 to 3212.75 L/h 

 

ATMOSPHERIC PRESSURE FROM DATA LINK 
$0101 (257) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Absolute air pressure of the atmosphere, as received from another module on the J1939 Data 
Link. 
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RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

FUEL LEVEL FROM DATA LINK 
$0102 (258) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Ratio of volume of fuel to the total volume of fuel tank, as received from another module on the 
J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.0078125 % / bit -251% -251 to 250.99 % 

 

NET BATTERY CURRENT FROM DATA LINK 
$0103 (259) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Net flow of electrical current into or out of the battery or batteries, as received from another 
module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
1 A / bit -125 A -125 to 125 A 

 

TURBOCHARGER 1 COMPRESSOR INLET TEMPERATURE 
$081A (2074) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the air entering the compressor side of the turbocharger, as received from 
another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

 

TURBOCHARGER 1 TURBINE INLET TEMPERATURE 
$081E (2078) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products entering the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 1 TURBINE OUTLET TEMPERATURE 
$081F (2079) - 1 REGISTER (2 BYTES) LONG - READ 
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Applies to EMCP 3.3 only 

Temperature of the combustion by-products exiting the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 2 COMPRESSOR INLET TEMPERATURE 
$081B (2075) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the air entering the compressor side of the turbocharger, as received from 
another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 2 TURBINE INLET TEMPERATURE 
$0820 (2080) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products entering the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 2 TURBINE OUTLET TEMPERATURE 
$0821 (2081) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products exiting the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 3 COMPRESSOR INLET TEMPERATURE 
$081C (2076) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the air entering the compressor side of the turbocharger, as received from 
another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 
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TURBOCHARGER 3 TURBINE INLET TEMPERATURE 
$0822 (2082) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products entering the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 3 TURBINE OUTLET TEMPERATURE 
$0823 (2083) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products exiting the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 4 COMPRESSOR INLET TEMPERATURE 
$081D (2077) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the air entering the compressor side of the turbocharger, as received from 
another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 4 TURBINE INLET TEMPERATURE 
$0824 (2084) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products entering the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

TURBOCHARGER 4 TURBINE OUTLET TEMPERATURE 
$0825 (2085) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of the combustion by-products exiting the turbine side of the turbocharger, as 
received from another module on the J1939 Data Link. 
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RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

EXHAUST TEMPERATURE FROM DATA LINK 
$0826 (2086) - 1 REGISTER (2 BYTES) LONG - READ 
Applies to EMCP 3.3 only 

Temperature of combustion byproducts leaving the engine, as received from another module 
over the J1939 data link. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

21.6 GENERATOR SET STATE CONTROL 
Remote control of the generator set is accomplished by reading from a set of status registers, 
and writing to a set of control registers. 

AUTOMATIC START/STOP STATE 
$00CE (206) - 1 REGISTER (2 BYTES) LONG - READ 
Current state of the Automatic Start/Stop sequence. 

BIT DEFINITIONS: 
0000 ($0000) = INIT 

0001 ($0001) = PRE_CRANK 

0010 ($0002) = STARTING 

0011 ($0003) = RUNNING 

0100 ($0004) = PRE_COOLDOWN 

0101 ($0005) = COOLDOWN 

0110 ($0006) = STOPPING 

0111 ($0007) = STOPPED 

1000 ($0008) = IDLING 

BYPASS COOLDOWN 
$012C (300) - 1 REGISTER (2 BYTES) LONG - WRITE 
Command to bypass remaining cooldown duration and immediately stop engine. 

This is applicable only when the engine is in the Cooldown state.  Setting this has the same 
functionality as pressing and holding the STOP key (and verifying with Enter) on the EMCP 3.2  
The cooldown bypass command is retained until cooldown is re-enabled by writing 00 to this 
register.  If the EMCP 3 GSC undergoes a power cycle, that will also clear this register and re-
enable the cooldown. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 
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ENGINE OPERATING MODE 
$012D (301) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates current desired mode of operation of the engine generator set. 

This parameter indicates the status corresponding to the Run, Auto, and Stop keys on the 
EMCP 3.2  To change the operating mode, see the Engine Operating Mode Command 
parameter. 

BIT DEFINITIONS: 
00 ($0000) = STOP 

01 ($0001) = AUTO 

10 ($0002) = RUN 

 

ENGINE OPERATING MODE COMMAND 
$012E (302) - 1 REGISTER (2 BYTES) LONG - WRITE 
SCADA command to change of desired mode of operation of the engine generator set.  Writing 
to this register has the same functionality as pressing the corresponding key (Run, Auto, or 
Stop) on the EMCP 3.2  To read the current mode, see the Engine Operating Mode parameter. 

BIT DEFINITIONS: 
00 ($0000) = STOP 

01 ($0001) = AUTO 

10 ($0002) = RUN 

ENGINE STATUS 
$041D (1053) - 1 REGISTER (2 BYTES) LONG - READ 
Current operating state of the engine generator set. See APPENDIX A for a programming 
example. 

BIT DEFINITIONS: 
000 ($0000) = NOT READY TO GO 

001 ($0001) = GOING IN AUTO 

010 ($0002) = GOING IN RUN 

011 ($0003) = READY IN AUTO 

100 ($0004) = STOPPING IN AUTO 

101 ($0005) = STOPPING NOT READY TO GO 

 

COOLDOWN DURATION REMAINING 
$041E (1054) - 1 REGISTER (2 BYTES) LONG - READ 
Time remaining in cooldown until engine is stopped.  This value is only meaningful while the 
engine is in the Cooldown state. 

RESOLUTION OFFSET DATA RANGE 
1 second / bit 0 seconds 0 to 64255 seconds 
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REMOTE INITIATE COMMAND 
$041F (1055) - 1 REGISTER (2 BYTES) LONG - WRITE 
When the control is in Auto mode, this commands the engine to Start when TRUE and Stop 
when FALSE. 

The Remote Initiate is also assigned to a digital input switch. Either the digital input going active 
or this SCADA command going TRUE will trigger an automatic start if the Engine Operating 
Mode is Auto.  This SCADA command is unaffected by the digital input state configuration. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

EMERGENCY STOP COMMAND 
$0420 (1056) - 1 REGISTER (2 BYTES) LONG - WRITE 
Will cause the engine to immediately stop without cooling down. 

Emergency Stop is also assigned to a switch for digital input. Either the digital input going active 
or this SCADA command going TRUE will trigger an emergency stop event.  This SCADA 
command is unaffected by the digital input state configuration. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

21.7 TIMERS AND COUNTERS 
The EMCP 3.2 and 3.3 have a real-time clock and counters that provide energy-related and 
service-related information. 

The EMCP 3 GSC calculates real and reactive energy provided by the generator set by 
measuring the power provided by the generator set over the amount of time the generator set is 
providing the power. 

The EMCP 3 GSC provides service-related information such as the number of crank and start 
attempts and successes, and allows resetting of these counters.  It also counts down to a 
recommended service interval, and reports the countdown in weeks, days, and hours.  Service 
personnel can reset the service interval counter to restart the countdown at the end of a service 
call. 

ENGINE OPERATING HOURS 
$00CC (204) - 2 REGISTERS (4 BYTES) LONG - READ 
Accumulated time that the engine is running. 

RESOLUTION OFFSET DATA RANGE 
0.05 hour / bit 0 hr 0 to 210554060.75 hour 
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SERVICE MAINTENANCE INTERVAL HOURS REMAINING 
$00D2 (210) - 1 REGISTER (2 BYTES) LONG - READ 
Maximum time in operation until the next service inspection is required.  This number is 
negative if a service inspection is overdue. 

RESOLUTION OFFSET DATA RANGE 
1 hr / bit -32127 hr -32127 to 32128 hr 

 

SERVICE MAINTENANCE INTERVAL DAYS REMAINING 
$00D4 (212) - 1 REGISTER (2 BYTES) LONG - READ 
Maximum calendar days until the next service inspection is required.  This number is negative if 
a service inspection is overdue. 

RESOLUTION OFFSET DATA RANGE 
1 day / bit -32127 days -32127 to 32128 days 

 

SERVICE MAINTENANCE INTERVAL WEEKS REMAINING 
$012B (299) - 1 REGISTER (2 BYTES) LONG - READ 
The number of full calendar weeks until the next service inspection is required. This number is 
negative if a service inspection is overdue. 

RESOLUTION OFFSET DATA RANGE 
1 week / bit -125 weeks -125 to 125 weeks 

 

 

NUMBER OF CRANK ATTEMPTS 
$00D5 (213) - 2 REGISTERS (4 BYTES) LONG - READ 
Accumulated number of crank attempts made by the engine. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 4211081215 

 

NUMBER OF SUCCESSFUL STARTS 
$00D7 (215) - 2 REGISTERS (4 BYTES) LONG - READ 
Accumulated number of successful starts of the engine. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 4211081215 

 

REAL TIME CLOCK 
$0384 (900) - 3 REGISTERS (6 BYTES) LONG - READ 
Clock containing year, month, day, hour, minute, and second information. 
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BYTE RESOLUTION OFFSET DATA RANGE 

5 1 year / bit 1985 years 1985 to 2235 years 
4 0.25 days / bit 0.75 days (12:00-6:00am on day 1 = $01) 0 to 62.5 days 
3 1 month / bit 1 month (Jan = $01) 0 to 250 months 
2 1 hour / bit 0 hours (midnight = $00) 0 to 250 hours 
1 1 minute / bit 0 minutes (HH:00 = $00) 0 to 250 minutes 
0 0.25 seconds / bit 0 seconds (HH:MM:00 = $00) 0 to 62.5 seconds 

 

DATA INTERPRETATION EXAMPLE 
The 1985 year offset implies that $14 in byte 5 translates to 20 years past 1985, or year 2005.  
The day offset implies that $1F (31) in byte 4 translates to the 8th day of the month (and the third 
quarter of the day – noon to 6pm).  One month offset implies that $07 in byte 3 translates to the 
seventh month, July. 

Zero hour offset implies that $00 in byte 2 translates to 12:00 midnight, and with the 24-hour 
format, $0D translates to 13:00 or 1:00 pm.  Zero minute offset implies that $05 in byte 1 
translates to 5 minutes past the hour (i.e. 12:05pm).  Zero second offset implies that $4D (77) in 
byte 0 translates to 19 and a quarter seconds past the minute (i.e. 12:05:19 pm). 

Therefore, $4D 05 0D 07 1F 14 is 1:05:19pm on July 8, 2005. 

 

UPDATE REAL TIME CLOCK COMMAND 
$0387 (903) - 3 REGISTERS (6 BYTES) LONG - WRITE 
SCADA command to change the real time clock information. 

Date and time data is entered in the same format as the Real Time Clock read parameter. 

 

RESET CRANK ATTEMPT COUNTER 
$0404 (1028) - 1 REGISTER (2 BYTES) LONG - WRITE 
Resets the accumulated number of crank attempts made by the engine. 

Write $AA55 followed by $55AA within 2 seconds to reset the counter to zero. 

RESET SUCCESSFUL START COUNTER 
$0405 (1029) - 1 REGISTER (2 BYTES) LONG - WRITE 
Resets the accumulated number of successful starts of the engine. 

Write $AA55 followed by $55AA within 2 seconds to reset the counter to zero. 

RESET KW HOUR METER 
$0406 (1030) - 1 REGISTER (2 BYTES) LONG - WRITE 
Resets the total kilowatt-hours that have been exported by the generator. 

Write $AA55 followed by $55AA within 2 seconds to reset the meter to zero. 

 



200 

21  SCADA Parameter Information  

RESET KVAR HOUR METER 
$0407 (1031) - 1 REGISTER (2 BYTES) LONG - WRITE 
Resets the total kilovar-hours that have been exported by the generator. 

Write $AA55 followed by $55AA within 2 seconds to reset the meter to zero. 

RESET SERVICE INTERVAL COUNTER 
$0408 (1032) - 1 REGISTER (2 BYTES) LONG - WRITE 
Resets the countdown until the next service inspection is required. This is usually performed at 
the end of a service call. 

Write $AA55 followed by $55AA within 2 seconds to reset the counter  to zero.   

21.8 EVENT SYSTEM 
The EMCP 3 GSC displays both internal events and those transmitted over the J1939 data link.  
Over SCADA, the status of the warning and shutdown lamps on the display can be viewed, and 
events can be acknowledged.  Events can be acknowledged individually or as a group, and the 
event count can be read.  Details of both EMCP 3 GSC and supported optional module events 
can be read over SCADA. 

The Event System as accessible over SCADA is very similar to the Event System on the EMCP 
3.2  However, there is one significant difference: The list of events as read over SCADA is not 
sorted in order of event priority.  Therefore, in order to find the details of any particular event, all 
20 registers must first be read and the particular event must be found. 

ACKNOWLEDGE ALL EVENTS COMMAND 
$0130 (304) - 1 REGISTER (2 BYTES) LONG - WRITE 
SCADA command to acknowledge all events, similar to pressing the Alarm Acknowledge key on 
the control. 

Each time a TRUE is written to this register, all of the events are momentarily acknowledged. 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

 

SYSTEM EVENT COUNT 
$014E (334) - 1 REGISTER (2 BYTES) LONG - READ 
Number of system events (present or active). 

Bits 15:8 UNUSED 

Bits 7:0 Count of Present and Active Events 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 99 
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SYSTEM EVENT LAMP STATUS 
$014F (335) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates the status of the amber and red event status lamps on the control. 

The Amber lamp being on signifies a warning event, and the Red lamp being on signifies a 
shutdown event.  This status parameter does not distinguish between a flashing lamp and a 
solid lamp. 

Bits 15:4 UNUSED 

Bits 3:2 Amber Lamp Status: Bits 00 = off, 01 = on 

Bits 1:0 Red Lamp Status: Bits 00 = off, 01 = on 

 

LOG ENTRY INDEX 
$0409 (1033) - 1 REGISTER (2 BYTES) LONG - WRITE 
Selects the index of the genset control event log to be read from Log Entry Modbus register. 

This is a legacy parameter, and has been superseded by the Module Event Log Entry # 
parameters. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 19 

 

LOG ENTRY 
$040A (1034) - 14 REGISTERS (28 BYTES) LONG - READ 
Reads the entry of the Genset Control Log as specified by the Log Entry Index Modbus register. 

For a list of the SPN/FMI combinations supported, please refer to the Systems Operation, 
Troubleshooting, Testing and Adjusting manual. 

(Register numbers listed below are offsets from the starting register number of this parameter, 
given above). 

This is a legacy parameter, and has been superseded by the Module Event Log Entry # 
parameters. 

Register 13 = Log Entry Index (for data format, see Log Entry Index parameter) 

Register 12:11 = SPN/FMI  

Bits 31:24 = UNUSED 

Bits 23:5 = SPN 

Bits 4:0 = FMI 

Register 10 = Flags / Count  

Bits 15:12 UNUSED 

Bits 11:8 Event Status: 

Bits 0000 = Inactive, 0100 = Active, 0101 = Present, 1111 = Unavailable 

Bits 7:0 Occurrence Count 
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Register 9:8 = First Hourmeter 

RESOLUTION OFFSET DATA RANGE 
0.05 hour / bit 0 hr 0 to 210554060.75 hour 

 

Register 7:6 = Last Hourmeter 

 

RESOLUTION OFFSET DATA RANGE 
0.05 hour / bit 0 hr 0 to 210554060.75 hour 

 

Register 5:3 = First Timestamp  

(for data format, see Real Time Clock parameter under Timers and Counters Chapter) 
 

Register 2:0 = Last Timestamp  

(for data format, see Real Time Clock parameter under Timers and Counters Chapter) 

RESET EVENT 
$0418 (1048) - 2 REGISTERS (4 BYTES) LONG - WRITE 
SCADA command to reset a single EMCP 3 GSC interval event, identified by the SPN and FMI 
numbers.   

For a list of the SPN/FMI combinations supported, please refer to the Systems Operation, 
Troubleshooting, Testing and Adjusting manual. 

Bits 31:24 = UNUSED 

Bits 23:5 = SPN 

Bits 4:0 = FMI 

EVENT LOG MODULE SELECTION COMMAND  
$05DA (1498) - 1 REGISTERS (2 BYTES) LONG - WRITE 
Write a value to this register to select which module events are currently accessible via the 
Module Event Log Entry # parameters (registers 1500 through 1576).  Writing a value to this 
register changes the value of the Event Log Module Selection parameter (register 1499). 

MODULE DEFINITIONS: 
 

0 = GENSET CONTROL 7 = DIGITAL AVR 

1 = ENGINE CONTROL 8 = RTD MODULE 

2 = SECONDARY ENGINE CONTROL 9 = THERMOCOUPLE MODULE #1 

3 = EXTERNAL I/O #1 10 = THERMOCOUPLE MODULE #2 

4 = EXTERNAL I/O #2  

EVENT LOG MODULE SELECTION 
$05DB (1499) - 1 REGISTERS (2 BYTES) LONG - READ 



203 

21  SCADA Parameter Information  

Read this register to determine which module events are currently accessible via the Module 
Event Log Entry # parameters (registers 1500 through 1576). 

Module definitions are the same as for the Event Log Module Selection Command parameter 
(register 1498). 

MODULE EVENT LOG ENTRY 1 (THROUGH) MODULE EVENT LOG ENTRY 20 
$05DC (1500) THROUGH $06E6 (1766) - 14 REGISTERS (28 BYTES) LONG - READ 
Reads the corresponding entry of the Event Log for the module specified in the Event Log 
Module Selection register. 

MODULE EVENT LOG 
ENTRY NUMBER 

REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $05DC 1500 
2 $05EA 1514 
3 $05F8 1528 
4 $0606 1542 
5 $0614 1556 
6 $0622 1570 
7 $0630 1584 
8 $063E 1598 
9 $064C 1612 

10 $065A 1626 
11 $0668 1640 
12 $0676 1654 
13 $0684 1668 
14 $0692 1682 
15 $06A0 1696 
16 $06AE 1710 
17 $06BC 1724 
18 $06CA 1738 
19 $06D8 1752 
20 $06E6 1766 

 

All of these parameters have the same data structure.  Register numbers are offsets from the 
base register address given above: 

Register 13 = Log Entry Index (0 through 19) 

Register 12:11 = SPN/FMI  

Bits 31:24 = UNUSED 

Bits 23:5 = SPN 

Bits 4:0 = FMI 

Register 10 = Flags / Count  

Bits 15:12 UNUSED 

Bits 11:8 Event Status: 0000 = Inactive, 0100 = Active, 0101 = Present, 1111 = 
Unavailable 
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Bits 7:0 Occurrence Count 

Register 9:8 = First Hourmeter 

RESOLUTION OFFSET DATA RANGE 
0.05 hour / bit 0 hr 0 to 210554060.75 hours 

 

Register 7:6 = Last Hourmeter 
(same data format as First Hourmeter) 

Register 5:3 = First Timestamp 
(same data format as Real Time Clock parameter) 

BYTE RESOLUTION OFFSET DATA RANGE 
5 1 year / bit 1985 years 1985 to 2235 years 
4 0.25 days / bit 0.75 days 0 to 62.5 days 
3 1 month / bit 0 months 0 to 250 months 
2 1 hour / bit 0 hours 0 to 250 hours 
1 1 minute / bit 0 minutes 0 to 250 minutes 
0 0.25 seconds / bit 0 seconds 0 to 62.5 seconds 

 

Register 2:0 = Last Timestamp  
(same data format as First Timestamp) 

For an example of the use of the Event Log Module Selection parameter and the Module Event 
Log Entry # parameters, see page 202. 

 

EMERGENCY SHUTDOWN OVERRIDE LOG ENTRY 1 (THROUGH) EMERGENCY 
SHUTDOWN OVERRIDE LOG ENTRY 10 
$0514 (1300) THROUGH $056E (1390) - 10 REGISTERS (20 BYTES) LONG - READ 
Reads the corresponding entry of the Emergency Shutdown Override Log, which records the 
past 20 times Emergency Shutdown Override mode was activated. 

Emergency Shutdown Override is an optional feature. 

MODULE EVENT LOG ENTRY 
NUMBER 

REGISTER ADDRESS 
(HEX) 

REGISTER ADDRESS 
(DECIMAL) 

1 $0514 1300 
2 $051E 1310 
3 $0528 1320 
4 $0532 1330 
5 $053C 1340 
6 $0546 1350 
7 $0550 1360 
8 $055A 1370 
9 $0564 1380 

10 $056E 1390 
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All of these parameters have the same data structure.  Register numbers are offsets from the 
base register address given above: 

Register 9:8 = Last Hourmeter 

RESOLUTION OFFSET DATA RANGE 
0.05 hour / bit 0 hr 0 to 210554060.75 hours 

 

Register 7:5 = Last Timestamp 
(same data format as Real Time Clock parameter) 

BYTE RESOLUTION OFFSET DATA RANGE 
5 1 year / bit 1985 years 1985 to 2235 years 
4 0.25 days / bit 0.75 days 0 to 62.5 days 
3 1 month / bit 0 months 0 to 250 months 
2 1 hour / bit 0 hours 0 to 250 hours 
1 1 minute / bit 0 minutes 0 to 250 minutes 
0 0.25 seconds / bit 0 seconds 0 to 62.5 seconds 

 

Register 4:3 = First Hourmeter 
(same data format as Last Hourmeter) 

Register 2:0 = First Timestamp  
(same data format as Last Timestamp) 

21.9 ENGINE MONITORING 
The EMCP 3 GSC can communicate some standard engine parameters over the data link. 

ENGINE OIL PRESSURE 
$00C8 (200) - 1 REGISTER (2 BYTES) LONG - READ 
Gage pressure of oil in engine lubrication system as provided by oil pump. 

RESOLUTION OFFSET DATA RANGE 
0.125 kPa / bit 0 kPa 0 to 8031.875 kPa 

 

ENGINE COOLANT TEMPERATURE 
$00C9 (201) - 1 REGISTER (2 BYTES) LONG - READ 
Temperature of liquid found in engine cooling system. 

RESOLUTION OFFSET DATA RANGE 
0.03125 C / bit -273 C -273 to 1735 C 

 

ENGINE RPM 
$00CB (203) - 1 REGISTER (2 BYTES) LONG - READ 
Actual engine speed, calculated over a minimum crankshaft angle of 720 degrees divided by the 
number of cylinders. 
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RESOLUTION OFFSET DATA RANGE 
0.125 rpm / bit 0 rpm 0 to 8031.875 rpm 

 

REQUESTED ENGINE SPEED 
$0424 (1060) - 1 REGISTER (2 BYTES) LONG - READ 
Engine speed currently being requested by the EMCP 3 GSC genset control. 

RESOLUTION OFFSET DATA RANGE 
0.125 rpm / bit 0 rpm 0 to 8031.875 rpm 

 

ENGINE PROTECTION HAS SHUT DOWN ENGINE FROM DATA LINK 
$04FB (1275) - 1 REGISTER (2 BYTES) LONG - READ 
Indicates that the engine protection system has shut down the engine, as opposed to the engine 
shutting down based on a command from the EMCP 3.2 

BIT DEFINITIONS: 
00 = FALSE 

01 = TRUE 

MANUAL FUEL PRIMING DURATION REMAINING 
$082B (2091) - 1 REGISTER (2 BYTES) LONG - READ 
Time remaining in manual fuel priming, in seconds. 

RESOLUTION OFFSET DATA RANGE 
1 second / bit 0 seconds 0 to 64255 seconds 

 

21.10 EMCP 3 GSC SETPOINTS 
All of the configuration possible at the EMCP 3 GSC can be done over the data link, by reading 
from and writing to EMCP 3 GSC setpoints.  As on the display, each setpoint has a minimum 
security level required to change it associated with it.  This required security level can be read 
by reading the Setpoint Information register for a particular setpoint. 

Setpoints are grouped in the EMCP 3 GSC into Blocks.  These Blocks are actually pieces of 
software that, in some cases, may occur more than once in the software.  Blocks are uniquely 
identified by the combination of their Block Number and Instance Number, and this unique 
identifier is called the Block ID.   

This, in combination with a Setpoint Number that identifies the setpoint within that block, is 
called the Setpoint ID.  This Setpoint ID uniquely identifies a setpoint in the EMCP 3 GSC.  See 
FIGURE 107 for a sample illustration of this concept. 

Note that Instance Number and Setpoint Number start from zero.  Therefore, the 1st setpoint, 
shown in the figure as Setpoint #1, actually has the hexadecimal address of $00.   

The same holds for instance numbers, where the first instance is enumerated as 00$. 
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FIGURE 107: STRUCTURE OF SETPOINT ID 

To read a setpoint data or related information, first the Setpoint ID for Read parameter must be 
set to the appropriate Setpoint ID.   

Then, either the Setpoint Information parameter or Setpoint Data Value parameter can be read.  
Setpoint Information contains various pieces of information regarding the setpoint, as detailed 
below.   

To write to a setpoint, the Setpoint Write parameter must be sent, which contains both the 
Setpoint ID and the data value.   

Immediately prior to reading setpoint information, the Setpoint ID field should be checked to 
verify that the correct setpoint is being read. 

The Setpoint ID and Setpoint Information parameters contain multiple pieces of information, and 
span multiple Modbus registers.  The registers may be read separately, but caution should be 
taken to maintain integrity of the data being read. 

The list of blocks supported on the EMCP 3 GSC are given in APPENDIX C. 

The list of setpoints as well as security and data format information are given in APPENDIX D. 

For the setpoints which use Setpoint Value Lists, the list of values and their meanings is given in 
APPENDIX E. 

SETPOINT DATA TYPE 
Setpoints have minimum and maximum engineering values, as given in the MIN and MAX fields 
of the table in APPENDIX C. They are stored with a maximum resolution as listed in the 
RESOLUTION field. The parameters can take on non-integer values in some cases, so in order 
to be stored as integer data types, are scaled (bit-shifted) by the number of bits listed in the 
SCALING field. 
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Setpoints are stored as a 32-bit signed integer value, using 2’s complement to represent 
negative values.  This is a standard data type in computer programming, termed INT32.  It can 
represent integer values from negative 2,147,483,648 to positive 2,147,483,647; that is, 
hexadecimal $ 80 00 00 00 to $ 7F FF FF FF.  Other conversion examples: 

Decimal -1 = $ FF FF FF FF 

Decimal 0 = $ 00 00 00 00 

Decimal 1000 = $ 00 00 03 E8 

Decimal -1000 = $ FF FF FC 18 

 

REGISTER_VALUE = 2RESOLUTION * ENGINEERING_VALUE 

ENGINEERING VALUE = (0.5)RESOLUTION * REGISTER_VALUE 

For a setpoint interpretation and calculation example, see Setpoint Interpretation and 
Calculation Chapter APPENDIX D. 

 

SETPOINT ID FOR READ 
$03EA (1002) - 3 REGISTERS (6 BYTES) LONG - WRITE 
Specifies the ID for the setpoint to be read by the Setpoint Information Modbus register or the 
Setpoint Data Value Modbus register. See APPENDIX A for a programming example. 

(Register numbers listed below are offsets from the starting register number of this parameter, 
given above). 

Register 2:1 = Block ID 

Register 0 = Setpoint Number 

SETPOINT INFORMATION 
$03ED (1005) - 12 REGISTERS (24 BYTES) LONG - READ 
Reads the setpoint information structure associated with the setpoint specified by the Setpoint 
ID for Read Modbus register, see APPENDIX A: SCADA Programming Examples. 

(Register numbers listed below are offsets from the starting register number of this parameter, 
given above). 

Register 11:9 = Setpoint ID 

Register 8 = Access Level needed to modify 

Register 7:6 = Value 

Register 5:4 = Minimum 

Register 3:2 = Maximum 

Register 1:0 = Resolution 

SETPOINT WRITE 
$03F9 (1017) - 5 REGISTERS (10 BYTES) LONG - WRITE 
Writes a specific Setpoint ID and value to change a setpoint. 
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(Register numbers listed below are offsets from the starting register number of this parameter, 
given above). 

Register 4:2 = Setpoint ID 
Register 1:0 = New Value 

SETPOINT DATA VALUE 
$03FE (1022) - 2 REGISTERS (4 BYTES) LONG - READ 
Reads the value of the setpoint specified by the Setpoint ID for Read Modbus register. 

21.11 MISCELLANEOUS  

BATTERY VOLTAGE 
$00CA (202) - 1 REGISTER (2 BYTES) LONG - READ 
Measured electrical potential of the battery voltage at the control. 

The EMCP 3 GSC can report the voltage of the supply that is powering it over the data link by 
means of the Battery Voltage parameter.  This is usually the cranking battery or batteries.  Note 
that the voltage is read at the EMCP, not at the battery terminals.  For high power draw cases, 
this voltage may be noticeably lower than the voltage at the battery terminals. See APPENDIX A 
for a programming example. 

RESOLUTION OFFSET DATA RANGE 
0.05 V / bit 0 V 0 to 3212.75 V 

 

LAMP TEST COMMAND 
$012F (303) - 1 REGISTER (2 BYTES) LONG - WRITE 
Commands the control to conduct a lamp/display test of the EMCP 3  GSC.  Writing TRUE turns 
on all of the LEDs, but does not darken the LCD display on the control panel, as the Lamp Test 
button on the control panel does.  To end the lamp test, a FALSE must be written to this 
register. 

RESOLUTION OFFSET DATA RANGE 
1 / bit 0 0 to 1 

BIT DEFINITIONS: 
00 = FALSE 
01 = TRUE 

 

CONTROL SERIAL NUMBER 
$04FC (1276) - 6 REGISTERS (12 BYTES) LONG - READ 
Reads the SERIAL NUMBER of the EMCP 3  GSC. This is the number that is label printed on the 
back cover of the control panel.  See FIGURE 108. 

 
BYTE 0: Character count 
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BYTES 1-11: ASCII data, characters $30 through $5A valid (numbers and capital letters).  
String terminates with a NULL character ($00). 

 
EXAMPLE: Reading the Control Serial Number would return the following: 
$0A31 3738 3342 3030 3648 5100 

 

 
FIGURE 108: SAMPLE CONTROL SERIAL NUMBER ON EMCP 3 GSC LABEL 
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APPENDIX A   SCADA PROGRAMMING EXAMPLES 
In the following examples, the EMCP 3 GSC SCADA Data Link Slave Address setpoint is 
assumed to be set to 01.  The last 2 bytes (shown as xx xx in this Chapter) of each message 
consist of the CRC. The CRC is typically automatically generated and checked by SCADA 
communication software, and therefore is not discussed below.   

These are only examples of specific conditions and the responses from the control under those 
conditions, and are not intended to represent the complete functionality of the control or all the 
possible conditions that can result in these responses.  In particular, Exception Responses or 
other error conditions are not considered here. 

READING DATA REGISTERS 
BATTERY VOLTAGE 
REQUEST: $ 01 03 00 C9 00 01 XX XX 
$ 01 = slave address of EMCP 3 GSC 

$ 03 = function code (Read Registers). 

$ 00 C9  (1 bit offset)  $ 00 CA = Battery Voltage. 

$ 00 01 = register count (1 register). 

 
Reply:  $ 01 03 02 01 FD xx xx 

 $ 01 = slave address of EMCP 3 GSC 

$ 03 = function code (Read Registers). 

$ 02 = byte count (2 bytes – 1 register). 

$ 01 FD = 509. 509 * 0.05 V/bit = 25.45V. 

 

GENERATOR OVERALL POWER FACTOR 
Request: $ 01 03 00 66 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (Read Registers) 

 $ 00 66  (1 bit offset)  $00 67 = Generator Overall Power Factor. 

 $ 00 01 = register count (1 register) 

Reply:  $ 01 03 02 80 00 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

$ 03 = function code (Read Registers) 

$ 02 = byte count (2 bytes = 1 register) 

$ 80 00 = 32768. 32768 * (1 / 16384) - 1.0 = 1.0 PF. 

It may be convenient to consider these equations when converting between engineering units 
and stored data: 

ENGINEERING_DATA = ( STORED_DATA * RESOLUTION ) + OFFSET 
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STORED_DATA = ( ENGINEERING_DATA - OFFSET ) / RESOLUTION 

ENGINE STATUS 
Let’s consider the reply under two different conditions to the following request for Engine Status. 

Request: $ 01 03 04 1C 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 1C  (1 bit offset)  $ 04 1D  Engine Status 

Condition 1 
If the engine RPM is set to 15 and the mode is Auto and there is not a remote start signal from 
any source, then the EMCP 3 GSC display reads Stopping, and the following is the reply to the 
above Modbus request: 

 
Reply (1): $ 01 03 02 00 03 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (Read Register) 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 00 03 = 3 = Ready in Auto 

The Engine Status is Ready in Auto because the engine RPM is below the Crank Terminate 
RPM setpoint.  (The minimum value of the Crank Terminate setpoint is 100 rpm). 

Condition 2 
 If the engine RPM is set to zero, the mode to Stop, and the oil pressure below 80kPa, then the 
EMCP 3 GSC display reads Stopped, and the following is the reply to the above Modbus 
request. 

 
Reply (2): $ 01 03 02 00 00 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (Read Register) 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 00 00 = 0 = Not Ready to Go 

The Engine Status is Not Ready to Go, which indicates that the control is in Stop mode, and is 
not ready to be started via a Remote Initiate command. 

SCADA SECURITY LEVELS 
This example demonstrates setting a password, and then entering the password to gain access 
to a certain SCADA security level.  There are also some examples given of valid versus invalid 
passwords. 

Assume the EMCP 3 GSC contains default values.  By default, all three passwords (SCADA, 
Level 1, and Level 2) are disabled.   

Read and verify the current security level: 
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Step 1: Verify current security level 

Request: $ 01 03 02 DB 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 02 DB  (1 bit offset)  $ 02 DC  Current Security Level 

Reply:  $ 01 03 02 00 02 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 00 02 = security access level 2. 

This is correct.  It should be at level 2, because no passwords exist.  Now, enter a SCADA 
password as well as a new level 1 password.  It will set the SCADA password to 123, which is 
$313233.   

Set the new level 1 password to 1, which is $31: 

 
Step 2: Set a new level 1 password 

Request: $ 01 10 02 C3 00 08 10 31 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 10 = function code (write multiple registers) 

 $ 02 C3  (1 bit offset)  $ 02 C4  Level 1 Password 

 $ 00 08 = register count (8) 

 $ 10 = byte count (16) 

$ 31 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 = data (1, followed by 15 spaces) 

Reply:  $ 01 10 02 C3 00 08 xx xx 

 $ 02 C3  (1 bit offset)  $ 02 C4  Level 1 Password 

 $ 00 08 = register count (8) 

 
Step 3: Set a new SCADA password 

Request: $ 01 10 02 D3 00 08 10 31 32 33 20 20 20 20 20 20 20 20 20 20 20 20 20 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 10 = function code (write multiple registers) 

 $ 02 D3  (1 bit offset)  $ 02 D4  SCADA Password 

 $ 00 08 = register count (8) 

 $ 10 = byte count (16) 

$ 31 32 33 20 20 20 20 20 20 20 20 20 20 20 20 20 = data (123, followed by 13 spaces) 

Reply:  $ 01 10 02 C3 00 08 xx xx 

 $ 02 C3  (1 bit offset)  $ 02 C4  Level 1 Password 

 $ 00 08 = register count (8) 
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Now, wait for the duration of the Level 0 Timeout, which is 10 minutes, without doing any writes 
over SCADA.  Repeat Step 1 to verify that the current security level is now zero.  The reply 
should be as follows: 

Reply:  $ 01 03 02 00 00 xx xx 

 
The level is now zero.  Now, disconnect from SCADA completely (i.e. no reads nor writes) for 
the duration of the SCADA Timeout, which depends on the SCADA Data Link Connect Timeout 
Interval setpoint.  If the timeout interval is set to the default of 30 seconds, then wait for 30 
seconds, and then reconnect.  Repeating Step 1, the reply should be as follows: 

Reply:  $ 01 03 02 FF FF xx xx 

 
This is the correct response.  No read or write can be done to any register since the SCADA 
access has timed out, with a couple of exceptions such as the Write Access Password register.  
Knowing the password to any level, it can be entered and therefore, be granted access to 
SCADA.  Now, enter the SCADA password that we set in Step 3: 

 
Step 4: Enter SCADA password to gain level 0 access 

Request: $ 01 10 02 BB 00 08 10 31 32 33 20 20 20 20 20 20 20 20 20 20 20 20 20 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 10 = function code (write multiple registers) 

 $ 02 D3  (1 bit offset)  $ 02 D4  Write Access Password 

 $ 00 08 = register count (8) 

 $ 10 = byte count (16) 

$ 31 32 33 20 20 20 20 20 20 20 20 20 20 20 20 20 = data (123, followed by 13 spaces) 

Reply:  $ 01 10 02 BB 00 08 xx xx 

 $ 02 C3  (1 bit offset)  $ 02 C4  Write Access Password 

 $ 00 08 = register count (8) 

 
Again, repeat Step 1 to verify the current security level. 

Reply:  $ 01 03 02 00 00 xx xx 

 
This verifies that the SCADA password worked, and did indeed give access to level 0 security.  
Notice that the level did not increase to 1 or 2 because a level 1 password is set.  If the level 1 
password is entered, access level 2 would be granted because there is no level 2 password set. 

MORE NOTES ON SCADA PASSWORDS 
Note that the SCADA password is stored as a numeric value.  The password is right-justified in 
the field shown on the EMCP 3 GSC , and left-justified when set/written over SCADA, but it is 
numerically the same (00000001 is the same as 1_______ -- 1 with seven spaces after it).  Just 
as with any number, leading zeros get dropped, and trailing zeros are kept (so 01 is stored as 1, 
but 10 is stored as 10). 
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Also, the first space terminates the string, so an entry of 12 3 (space between the 2 and the 3) 
will return an exception because only spaces (or nulls, after the first 8 bytes) are accepted after 
the first space. 

SETPOINT INTERPRETATION AND CALCULATION 
This example lays out the method of reading and writing to setpoints, including the data 
conversion between the register data and engineering value. 

Let us consider Block # 1 Setpoint # 2, Low Engine Oil Pressure Warning Event Threshold.   

Reading the value, you may get: 

$ 00 A0 00 00 

That corresponds to a decimal value of 655,360. 

Now look at the SCALING and divide by 212 to get a decimal value of 360. 

The current setpoint for Low Engine Oil Pressure Warning Event Threshold is then 360 kPa. 

 
For example: to change the Low Engine Oil Pressure Warning Event Threshold to 327.8 kPa: 

 

1. Check the RESOLUTION. The setpoint will be rounded to the nearest 1 kPa (round 
327.8 kPa to 328 kPa). 

2. Next, make sure it is within the MIN and MAX range (34 to 690).  It is (328 kPa). 

3. Look at the SCALING and multiply by 212 to get a decimal value of 1,343,488. 

4. Convert it to 32-bit signed integer (see Setpoint Data Type Chapter 0) to get: $ 00 14 
80 00 

5. Write this value to the New Value registers of the Setpoint Write parameter. 

READING AND WRITING AVR REGISTERS AND SETPOINTS 
This example demonstrates the data link commands to read setpoints, read registers, and write 
to registers.  Furthermore, it illustrates the functionality of integration with an external Automatic 
Voltage Regulator. 

Check the Maximum Generator Voltage Output Bias Percentage setpoint.  This could be done 
via the display but, read the setpoint via Modbus instead.   

To begin, select the setpoint that is to be read, by writing the Setpoint ID to the Setpoint ID for 
Read register. 

Request: $ 01 06 03 E9 00 03 06 00 6C 00 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 06 = function code (write multiple registers) 

 $ 03 E9  (1 bit offset)  $ 03 EA  Setpoint ID for Read 

 $ 00 03 = register count 

 $ 06 = byte count (2 bytes = 1 register) 
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 $ 00 6C 00 = setpoint # 1, block # 108, instance # 1 = Maximum Generator Voltage 
Output Bias Percentage 

Reply:  $ 01 06 03 E9 00 03 xx xx 

 $ 03 E9  (1 bit offset)  $ 03 EA  Setpoint ID for Read 

 $ 00 03 = register count 

 
The reply confirms that the write was successful.  Read the portion of the Setpoint Information 
register span that contains the Value.  This is register offsets 7:6 of the Setpoint Information 
register, or registers 1011 and 1012. 

Request: $ 01 03 03 F2 00 02 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read registers) 

 $ 03 F2  (1 bit offset)  $ 03 F3  Setpoint Information: Value 

 $ 00 02 = register count (Setpoint Information: Value is 2 registers long) 

Reply:  $ 01 03 04 00 14 00 00 xx xx 

 $ 04 = byte count (2 bytes = 1 register) 

 $ 00 14 00 00  1,310,720  (divide by 2^16)  20% max bias 

So the Maximum Generator Voltage Output Bias Percentage is 20%.  Read the AVR Bias 
Percent and the Desired Genset Output Voltage before any bias is applied. 

 
Request: $ 01 03 04 21 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 21  (1 bit offset)  $ 04 22  AVR Bias Percent 

 $ 00 01 = register count 

Reply:  $ 01 03 02 7D 80 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 7D 80  32128  251%  (-251% offset)  0.0% bias 

Request: $ 01 03 04 20 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 20  (1 bit offset)  $ 04 21  Desired Genset Output Voltage 

 $ 00 01 = register count 

Reply:  $ 01 03 02 01 E0 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 01 E0  480V desired 
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To adjust the voltage, navigate to the Control menu and press the up arrow ten times, re-read 
the AVR Bias Percent register. 

Request: $ 01 03 04 21 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 21  (1 bit offset)  $ 04 22  AVR Bias Percent 

 $ 00 01 = register count 

Reply:  $ 01 03 02 80 00 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 80 00  32768  256%  (-251% offset)  5.0% bias 

 
This verifies that each key-press adjusts the percentage by 0.5% (since we did ten key-
presses).  Now we can check the actual voltage command that is sent to the AVR by reading 
the Desired Genset Output Voltage register. 

 
Request: $ 01 03 04 20 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 20  (1 bit offset)  $ 04 21  Desired Genset Output Voltage 

 $ 00 01 = register count 

Reply:  $ 01 03 02 01 E5 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 01 E5  485V desired 

This is correct. because the AVR Bias Percent represents a percentage of the Maximum 
Generator Voltage Output Bias Percentage, which was 20%,  the overall bias percentage is 5% 
(AVR Bias Percent) of 20%, which is 1%.  

Therefore; 101% of 480V is 484.8V, which rounds up to 485V. 

Using the AVR Bias Percent Increment Command Modbus register, re-adjust the desired 
voltage to nominal, which is 480V.  This time however, we want to increment the bias by -1% 
(negative one percent) since the current bias is 1%. 

 
Request: $ 01 06 04 22 7D 00 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 06 = function code (write single register) 

 $ 04 22  (1 bit offset)  $ 04 23  AVR Bias Percent Increment Command 

 $ 7D 00 = 32000  (divide by 128) = 250  (-251 offset)  -1% 

Reply:  $ 01 06 04 22 7D 00 xx xx 

 $ 04 22 – echo of address 
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 $ 7D 00 – echo of data 

 
Finally, re-check the AVR Bias Percent to verify that the bias has returned to zero. 

 
Request: $ 01 03 04 21 00 01 xx xx 

 $ 01 = slave address of EMCP 3 GSC 

 $ 03 = function code (read register) 

 $ 04 21  (1 bit offset)  $ 04 22  AVR Bias Percent 

 $ 00 01 = register count 

Reply:  $ 01 03 02 7D 80 xx xx 

 $ 02 = byte count (2 bytes = 1 register) 

 $ 7D 80  32128  251%  (-251% offset)  0.0% bias 
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APPENDIX D  Setpoint Information For Configuration 

APPENDIX B   ALPHABETIC REFERENCE OF MODBUS REGISTERS 
 
Below is a quick-reference chart of the Modbus parameters detailed in this document. It 
contains the decimal register address, number of registers the parameter spans, parameter 
name, parameter description, and Chapter location for the information about that parameter. 
 

TABLE 23: MODBUS CHAPTER TITLE INDEX 

MODBUS CHAPTER TITLE CHAPTER 
EVENT SYSTEM  21.8 

EXTERNAL DEVICE PARAMETERS  21.5 

SPARE ANALOG INPUT  21.2 

GENERATOR SET STATE CONTROL  21.6 

MISCELLANEOUS  21.11 

DATA LINK SECURITY 21.1 

GENERATOR AC PARAMETERS 21.4 

DISCRETE INPUTS AND OUTPUTS 21.3 

ENGINE MONITORING  21.9 

TIMERS AND COUNTERS 21.7 

EMCP 3 GSC SETPOINTS 21.10 

 

TABLE 24: MODBUS REGISTERS CHAPTER INDEX 

ALPHABETIC REFERENCE OF MODBUS REGISTERS 
ADDRESS PARAMETER NAME CHAPTER 

304 Acknowledge All Events Command 21.8 

253 Air Filter 1 Differential Pressure from Data Link 21.5 

810 Air Filter 1 Differential Pressure from I/O Pin 21.2 

814 Ambient Air Temperature from I/O Pin 21.2 

257 Atmospheric Pressure from Data Link 21.5 

206 Automatic Start/Stop State 21.6 

1058 AVR Bias Percent 21.5 

1059 AVR Bias Percent Increment Command 21.5 

202 Battery Voltage 21.11 

249 Boost Pressure from Data Link 21.5 

300 Bypass Cooldown 21.6 

1276 Control S/N 21.11 

1054 Cooldown Duration Remaining 21.6 

248 Crankcase Pressure from Data Link 21.5 

732 Current Security Level 21.1 

221 Cylinder #1 Exhaust Port Temperature from Data Link 21.5 
222 Cylinder #2 Exhaust Port Temperature from Data Link 21.5 
223 Cylinder #3 Exhaust Port Temperature from Data Link 21.5 
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ALPHABETIC REFERENCE OF MODBUS REGISTERS 
ADDRESS PARAMETER NAME CHAPTER 

224 Cylinder #4 Exhaust Port Temperature from Data Link 21.5 
225 Cylinder #5 Exhaust Port Temperature from Data Link 21.5 
226 Cylinder #6 Exhaust Port Temperature from Data Link 21.5 
227 Cylinder #7 Exhaust Port Temperature from Data Link 21.5 
228 Cylinder #8 Exhaust Port Temperature from Data Link 21.5 
229 Cylinder #9 Exhaust Port Temperature from Data Link 21.5 
230 Cylinder #10 Exhaust Port Temperature from Data Link 21.5 
231 Cylinder #11 Exhaust Port Temperature from Data Link 21.5 
232 Cylinder #12 Exhaust Port Temperature from Data Link 21.5 
233 Cylinder #13 Exhaust Port Temperature from Data Link 21.5 
234 Cylinder #14 Exhaust Port Temperature from Data Link 21.5 
235 Cylinder #15 Exhaust Port Temperature from Data Link 21.5 
236 Cylinder #16 Exhaust Port Temperature from Data Link 21.5 
237 Cylinder #17 Exhaust Port Temperature from Data Link 21.5 
238 Cylinder #18 Exhaust Port Temperature from Data Link 21.5 
239 Cylinder #19 Exhaust Port Temperature from Data Link 21.5 
240 Cylinder #20 Exhaust Port Temperature from Data Link 21.5 

1057 Desired Genset Output Voltage 21.4 

1097 Digital AVR Online 21.5 

600 Digital Input #1 Active State 21.3 

601 Digital Input #2 Active State 21.3 
602 Digital Input #3 Active State 21.3 
603 Digital Input #4 Active State 21.3 
604 Digital Input #5 Active State 21.3 
605 Digital Input #6 Active State 21.3 
606 Digital Input #7 Active State 21.3 
607 Digital Input #8 Active State 21.3 
624 Digital Output #1 Active State 21.3 
625 Digital Output #2 Active State 21.3 
628 Digital Selector #1 Activate Command 21.3 
638 Digital Selector #1 Commanded Value 21.3 
629 Digital Selector #2 Activate Command 21.3 
639 Digital Selector #2 Commanded Value 21.3 
630 Digital Selector #3 Activate Command 21.3 
640 Digital Selector #3 Commanded Value 21.3 
631 Digital Selector #4 Activate Command 21.3 
641 Digital Selector #4 Commanded Value 21.3 
632 Digital Selector #5 Activate Command 21.3 
642 Digital Selector #5 Commanded Value 21.3 
633 Digital Selector #6 Activate Command 21.3 
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ALPHABETIC REFERENCE OF MODBUS REGISTERS 
ADDRESS PARAMETER NAME CHAPTER 

643 Digital Selector #6 Commanded Value 21.3 
634 Digital Selector #7 Activate Command 21.3 
644 Digital Selector #7 Commanded Value 21.3 
635 Digital Selector #8 Activate Command 21.3 
645 Digital Selector #8 Commanded Value 21.3 
636 Digital Selector #9 Activate Command 21.3 
646 Digital Selector #9 Commanded Value 21.3 
637 Digital Selector #10 Activate Command 21.3 
647 Digital Selector #10 Commanded Value 21.3 

1300 Emergency Shutdown Override Log Entry 1 21.8 
1310 Emergency Shutdown Override Log Entry 2 21.8 
1320 Emergency Shutdown Override Log Entry 3 21.8 
1330 Emergency Shutdown Override Log Entry 4 21.8 
1340 Emergency Shutdown Override Log Entry 5 21.8 
1350 Emergency Shutdown Override Log Entry 6 21.8 
1360 Emergency Shutdown Override Log Entry 7 21.8 
1370 Emergency Shutdown Override Log Entry 8 21.8 
1380 Emergency Shutdown Override Log Entry 9 21.8 
1390 Emergency Shutdown Override Log Entry 10 21.8 
1056 Emergency Stop Command 21.6 

1091 Engine Control Online 21.5 

807 Engine Coolant Level from I/O Pin 21.2 

201 Engine Coolant Temperature 21.9 

219 Engine Coolant Temperature from Data Link 21.5 
246 Engine Fuel Temperature from Data Link 21.5 
806 Engine Oil Level from I/O Pin 21.2 

200 Engine Oil Pressure 21.9 

217 Engine Oil Pressure from Data Link 21.5 
245 Engine Oil Temperature from Data Link 21.5 
800 Engine Oil Temperature from I/O Pin 21.2 

204 Engine Operating Hours 21.7 

301 Engine Operating Mode 21.6 
302 Engine Operating Mode Command 21.6 

1275 Engine Protection has Shut Down Engine 21.9 
203 Engine rpm 21.9 

1053 Engine Status 21.6 

1499 Event Log Module Selection 21.8 
1498 Event Log Module Selection Command 21.8 
241 Exhaust Manifold #1 Temperature from Data Link 21.5 
242 Exhaust Manifold #2 Temperature from Data Link 21.5 
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ADDRESS PARAMETER NAME CHAPTER 

2086 Exhaust Temperature from Data Link 21.5 
801 Exhaust Temperature from I/O Pin 21.2 

1093 External I/O #1 Online 21.5 
1094 External I/O #2 Online 21.5 
1095 External I/O #3 Online 21.5 
1096 External I/O #4 Online 21.5 
805 External Tank Fuel Level from I/O Pin 21.2 
808 Fire Extinguisher Pressure from I/O Pin 21.2 
252 Fuel Filter Differential Pressure from Data Link 21.5 

811 Fuel Filter Differential Pressure from I/O Pin 21.2 

258 Fuel Level from Data Link 21.5 

804 Fuel Level from I/O Pin 21.2 

247 Fuel Pressure from Data Link 21.5 

101 Generator Average AC RMS Current 21.4 
102 Generator Average AC RMS Frequency 21.4 
100 Generator Average Line-Line AC RMS Voltage 21.4 
163 Generator Average Line-Line AC RMS Voltage Percent 21.4 
148 Generator Average Line-Neutral AC RMS Voltage 21.4 

1067 Generator Frequency within Limits 21.4 
149 Generator Front Bearing Temperature from Data Link 21.5 

103 Generator Overall Power Factor 21.4 
104 Generator Overall Power Factor Lagging 21.4 
111 Generator Phase A AC RMS Current 21.4 
123 Generator Phase A Apparent Power 21.4 
108 Generator Phase A Line-Line AC RMS Voltage 21.4 
114 Generator Phase A Line-Neutral AC RMS Voltage 21.4 
135 Generator Phase A Power Factor 21.4 
159 Generator Phase A Power Factor Lagging 21.4 
129 Generator Phase A Reactive Power 21.4 
117 Generator Phase A Real Power 21.4 
151 Generator Phase A Winding Temperature from Data 

Link 21.5 

112 Generator Phase B AC RMS Current 21.4 
125 Generator Phase B Apparent Power 21.4 
109 Generator Phase B Line-Line AC RMS Voltage 21.4 
115 Generator Phase B Line-Neutral AC RMS Voltage 21.4 
136 Generator Phase B Power Factor 21.4 
160 Generator Phase B Power Factor Lagging 21.4 
131 Generator Phase B Reactive Power 21.4 
119 Generator Phase B Real Power 21.4 
152 Generator Phase B Winding Temperature from Data 

Link 21.5 
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113 Generator Phase C AC RMS Current 21.4 
127 Generator Phase C Apparent Power 21.4 
110 Generator Phase C Line-Line AC RMS Voltage 21.4 
116 Generator Phase C Line-Neutral AC RMS Voltage 21.4 
137 Generator Phase C Power Factor 21.4 
161 Generator Phase C Power Factor Lagging 21.4 
133 Generator Phase C Reactive Power 21.4 
121 Generator Phase C Real Power 21.4 
153 Generator Phase C Winding Temperature from Data 

Link 21.5 
150 Generator Rear Bearing Temperature from Data Link 21.5 
162 Generator Rear Bearing Temperature from I/O Pin 21.2 

138 Generator Total Apparent Power 21.4 
146 Generator Total kVAr Hours Export 21.4 
144 Generator Total kW Hours Export 21.4 
140 Generator Total Percent kVA 21.4 
143 Generator Total Percent kVAr 21.4 
105 Generator Total Percent kW 21.4 
141 Generator Total Reactive Power 21.4 
106 Generator Total Real Power 21.4 

1068 Generator Voltage within Limits 21.4 
1090 Genset Control Online 21.5 
256 Instantaneous Fuel Consumption from Data Link 21.5 
243 Intake Manifold #1 Temperature from Data Link 21.5 
244 Intake Manifold #2 Temperature from Data Link 21.5 
310 Key Press 21.1 

303 Lamp Test Command 21.11 

802 Left Manifold Exhaust Temperature from I/O Pin 21.2 

708 Level 1 Password 21.1 
716 Level 2 Password 21.1 
734 Level 3 Password Phone In Prompt 21.1 

1034 Log Entry 21.8 
1033 Log Entry Index 21.8 
2091 Manual Fuel Priming Duration Remaining 21.9 

1500 Module Event Log Entry 1 21.8 
1514 Module Event Log Entry 2 21.8 
1528 Module Event Log Entry 3 21.8 
1542 Module Event Log Entry 4 21.8 
1556 Module Event Log Entry 5 21.8 
1570 Module Event Log Entry 6 21.8 
1584 Module Event Log Entry 7 21.8 
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1598 Module Event Log Entry 8 21.8 
1612 Module Event Log Entry 9 21.8 
1626 Module Event Log Entry 10 21.8 
1640 Module Event Log Entry 11 21.8 
1654 Module Event Log Entry 12 21.8 
1668 Module Event Log Entry 13 21.8 
1682 Module Event Log Entry 14 21.8 
1696 Module Event Log Entry 15 21.8 
1710 Module Event Log Entry 16 21.8 
1724 Module Event Log Entry 17 21.8 
1738 Module Event Log Entry 18 21.8 
1752 Module Event Log Entry 19 21.8 
1766 Module Event Log Entry 20 21.8 
259 Net Battery Current from Data Link 21.5 

213 Number of Crank Attempts 21.7 
215 Number of Successful Starts 21.7 
251 Oil Filter Differential Pressure from Data Link 21.5 

809 Oil Filter Differential Pressure from I/O Pin 21.2 

900 Real Time Clock 21.7 

616 Relay Output #1 Active State 21.3 
617 Relay Output #2 Active State 21.3 
618 Relay Output #3 Active State 21.3 
619 Relay Output #4 Active State 21.3 
620 Relay Output #5 Active State 21.3 
621 Relay Output #6 Active State 21.3 
622 Relay Output #7 Active State 21.3 
623 Relay Output #8 Active State 21.3 

1055 Remote Initiate Command 21.6 

1060 Requested Engine Speed 21.9 

1028 Reset Crank Attempt Counter 21.7 

1048 Reset Event 21.8 

1031 Reset kVAr Hour Meter 21.7 
1030 Reset kW Hour Meter 21.7 
1032 Reset Service Interval Counter 21.7 
1029 Reset Successful Start Counter 21.7 
803 Right Manifold Exhaust Temperature from I/O Pin 21.2 

1098 RTD Module Online 21.5 

724 SCADA Password 21.1 

1092 Secondary Engine Control Online 21.5 

212 Service Maintenance Interval Days Remaining 21.7 
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210 Service Maintenance Interval Hours Remaining 21.7 
299 Service Maintenance Interval Weeks Remaining 21.7 

1022 Setpoint Data Value 21.10 
1002 Setpoint ID for Read 21.10 
1005 Setpoint Information 21.10 
1017 Setpoint Write 21.10 
207 Spare Analog Input Percentage 21.2 
209 Spare Analog Input Pressure 21.2 
208 Spare Analog Input Temperature 21.2 

1061 Speed Bias Percent 21.5 
1062 Speed Bias Percent Increment Command 21.5 
813 Starting Air Pressure from I/O Pin 21.2 

334 System Event Count 21.8 
335 System Event Lamp Status 21.8 

1099 Thermocouple #1 Online 21.5 
1100 Thermocouple #2 Online 21.5 
254 Total Fuel Consumption from Data Link 21.5 

2074 Turbocharger 1 Compressor Inlet Temperature 21.5 
2078 Turbocharger 1 Turbine Inlet Temperature 21.5 
2079 Turbocharger 1 Turbine Outlet Temperature 21.5 
2075 Turbocharger 2 Compressor Inlet Temperature 21.5 
2080 Turbocharger 2 Turbine Inlet Temperature 21.5 
2081 Turbocharger 2 Turbine Outlet Temperature 21.5 
2076 Turbocharger 3 Compressor Inlet Temperature 21.5 
2082 Turbocharger 3 Turbine Inlet Temperature 21.5 
2083 Turbocharger 3 Turbine Outlet Temperature 21.5 
2077 Turbocharger 4 Compressor Inlet Temperature 21.5 
2084 Turbocharger 4 Turbine Inlet Temperature 21.5 
2085 Turbocharger 4 Turbine Outlet Temperature 21.5 
903 Update Real Time Clock Command 21.7 

700 Write Access Password 21.1 
733 Write Current Security Level 21.1 
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APPENDIX C  BLOCKS FOR SETPOINT CONFIGURATION 
 

This appendix contains information on the various software blocks in the EMCP 3 GSC.  Blocks 
are functional groups of setpoints.  Blocks can occur in multiple instances, and in order to 
program a setpoint, the block number as well as the instance number must be referenced. 

These numbers reflect the standard production software.  For custom designed-to-order (DTO) 
software, consult your DTO contact. 
 

TABLE 25: BLOCKS FOR SETPOINT CONFIGURATION 

BLOCK 
# BLOCK NAME 

EMCP 3.2 GSC  
NUMBER OF 
INSTANCES 

EMCP 3.3 GSC  
NUMBER OF 
INSTANCES 

1 Engine Oil Pressure Monitor 1 1 
2 Programmable Cycle Timer 1 1 
4 Engine Coolant Temperature Monitor 1 1 
6 Engine Speed Monitor 1 1 
7 Battery Voltage Monitor 1 1 
8 Engine Operating Hours Monitor 1 1 
9 Crank Attempt/Successful Start Counter 1 1 

10 Engine Protection Events Configuration 1 1 
11 Generator Protection Events Configuration 1 1 
12 Other System Events Configuration 1 1 
17 Diagnostics Configuration 1 1 
18 Automatic Start/Stop 1 1 
19 Generator AC Monitor 1 1 
21 Generator Over/Under Voltage 1 1 
22 Generator Over/Under Frequency 1 1 
23 Generator Over Current 1 1 
24 Generator Reverse Power 0 1 
26 Programmable Trip Point Function 1 1 
34 Utility Breaker Control 0 0 
35 Generator Breaker Control 0 0 
53 Digital Inputs 8 8 
56 Relay Outputs 8 8 
72 Event System 1 1 
75 Electronic Control Module Reduced Power Mode 1 1 
88 Digital Outputs 1 2 
94 Data Link - SCADA 1 1 
96 Enhanced Engine Monitor 0 1 
97 Event Output Functions 1 1 
98 Generator AC Power Monitor 1 1 

100 Service Maintenance Interval 1 1 
102 Governor Desired Engine Speed Request 1 1 
104 Digital Selectors 8 8 
105 Event Input Functions 6 6 
106 Spare Analog Input 1 1 
107 Transfer Switch 0 0 
108 AVR Desired Voltage Request 1 1 
109 Enhanced Generator Monitor 0 1 
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APPENDIX D  SETPOINT INFORMATION FOR CONFIGURATION 
 

TABLE 26: SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

1 1 Engine Oil Pressure Sensor Configuration Lvl 3 0 Setpoint Value List 
  2 Low Engine Oil Pressure Warning Event Threshold Lvl 2 12 34 690 1 kPa 

  3 Low Idle Low Engine Oil Pressure Warning Event 
Threshold Lvl 2 12 34 690 1 kPa 

  4 Low Engine Oil Pressure Warning Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  5 Low Engine Oil Pressure Shutdown Event 
Threshold Lvl 2 12 34 690 1 kPa 

  6 Low Idle Low Engine Oil Pressure Shutdown Event 
Threshold Lvl 2 12 34 690 1 kPa 

  7 Low Engine Oil Pressure Shutdown Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  8 Low Engine Oil Pressure Step Speed Lvl 2 12 400 1800 1 rpm 
  9 Oil Pressure Sensor Map Selection Number Lvl 3 0 1 5 1 N/A 

2 1 Programmable Cycle Timer #1 Activation Day of the 
Week Lvl 1 0 0 127 1 N/A 

  2 Programmable Cycle Timer #1 Activation Start Time Lvl 1 0 00:00 23:59 00:01 hours 
  3 Programmable Cycle Timer #1 Active Time Lvl 1 0 00:01 24:00 00:01 hours 

  4 Programmable Cycle Timer #1 Output #1 Activation 
Configuration Lvl 1 0 Setpoint Value List 

  5 Programmable Cycle Timer #1 Output #2 Activation 
Configuration Lvl 1 0 Setpoint Value List 

4 1 Engine Coolant Temperature Sensor Configuration Lvl 3 0 Setpoint Value List 

  2 High Engine Coolant Temperature Warning Event 
Threshold Lvl 2 12 49 120 1 deg. C 

  3 High Engine Coolant Temperature Warning Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  4 High Engine Coolant Temperature Shutdown Event 
Threshold Lvl 2 12 49 120 1 deg. C 

  5 High Engine Coolant Temperature Shutdown Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  6 Low Engine Coolant Temperature Warning Event 
Threshold Lvl 2 12 0 36 1 deg. C 

  7 Low Engine Coolant Temperature Warning Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  8 Coolant Temperature Sensor Map Selection 
Number Lvl 3 0 1 5 1 N/A 

6 1 Flywheel Teeth Lvl 3 0 95 350 1 N/A 
  2 Engine Over Speed Shutdown Threshold Lvl 3 12 400 4330 1 rpm 
  3 Engine Under Speed Warning Event Threshold Lvl 3 12 400 4330 1 rpm 

  4 Engine Under Speed Warning Event Notification 
Delay Time Lvl 2 4 0.0 20.0 0.1 seconds 

  5 Engine Under Speed Shutdown Event Threshold Lvl 3 12 400 4330 1 rpm 

  6 Engine Under Speed Shutdown Event Notification 
Delay Time Lvl 2 4 0.0 20.0 0.1 seconds 

  7 Engine Speed Sensor Configuration Svc Tool 0 Setpoint Value List 
7 1 High Battery Voltage Warning Event Threshold Lvl 1 12 12 50 0.1 V DC 

  2 High Battery Voltage Warning Event Notification 
Delay Time Lvl 1 4 0 240 1 seconds 

  3 High Battery Voltage Shutdown Event Threshold Lvl 1 12 12.0 50.0 0.1 V DC 

  4 High Battery Voltage Shutdown Event Notification 
Delay Time Lvl 1 4 0 240 1 seconds 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

  5 Low Battery Voltage Warning Event Threshold Lvl 1 12 0.0 25.0 0.1 V DC 

  6 Low Battery Voltage Warning Event Notification 
Delay Time Lvl 1 4 0 240 1 seconds 

  7 Low Battery Charging System Voltage Warning 
Event Threshold Lvl 1 12 0.0 30.0 0.1 V DC 

  8 Low Battery Charging System Voltage Warning 
Event Notification Delay Time Lvl 1 4 0 240 1 seconds 

9 1 Customer Password Security Level to Reset 
Crank/Start Counters Lvl 3 0 0 4 1 N/A 

10 1 Air Damper Closed Event Response Configuration Lvl 2 0 0 266 N/A BitMask† 

  2 High Air Filter Differential Pressure Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask† 

  3 High Air Filter Differential Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  4 Low Air Filter Differential Pressure Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  5 Low Air Filter Differential Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  6 Emergency Stop Activated Event Response 
Configuration Lvl 2 0 8 106 N/A BitMask†

  7 High Engine Coolant Level Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  8 High Engine Coolant Level Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  9 Low Engine Coolant Level Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  10 Low Engine Coolant Level Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  11 High Engine Coolant Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  12 High Engine Coolant Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  13 Low Engine Coolant Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  14 Engine Failure to Start Shutdown Event Response 
Configuration Lvl 2 0 8 106 N/A BitMask†

  15 High Engine Oil Level Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  16 High Engine Oil Level Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  17 Low Engine Oil Level Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  18 Low Engine Oil Level Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  19 Low Engine Oil Pressure Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  20 Low Engine Oil Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask† 

  21 High Engine Oil Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  22 High Engine Oil Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  23 Low Engine Oil Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  24 Low Engine Oil Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  25 Unexpected Engine Shutdown Event Response Lvl 2 0 8 106 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 



229 

APPENDIX D  Setpoint Information For Configuration 

SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

Configuration 

  26 Engine Over Speed Shutdown Event Response 
Configuration Lvl 2 0 8 106 N/A BitMask†

  27 Engine Under Speed Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  28 Engine Under Speed Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  29 High Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  30 High Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  31 Low Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  32 Low Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  33 High Right Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  34 High Right Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  35 Low Right Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  36 Low Right Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  37 High Left Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  38 High Left Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  39 Low Left Exhaust Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  40 Low Left Exhaust Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  41 High Fuel Filter Differential Pressure Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  42 High Fuel Filter Differential Pressure Shutdown 
Event Response Configuration Lvl 2 0 0 110 N/A BitMask†

  43 Low Fuel Filter Differential Pressure Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  44 Low Fuel Filter Differential Pressure Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  45 High Fuel Level Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  46 High Fuel Level  Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask† 

  47 Low Fuel Level Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  48 Low Fuel Level  Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  49 External Tank High Fuel Level Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  50 External Tank High Fuel Level  Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  51 External Tank Low Fuel Level Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  52 External Tank Low Fuel Level  Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  53 Fuel Leak Event Response Configuration Lvl 2 0 0 111 N/A BitMask†

  54 High Engine Oil Filter Differential Pressure Warning 
Event Response Configuration Lvl 2 0 0 99 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

  55 High Engine Oil Filter Differential Pressure 
Shutdown Event Response Configuration Lvl 2 0 0 110 N/A BitMask†

  56 Low Engine Oil Filter Differential Pressure Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  57 Low Engine Oil Filter Differential Pressure 
Shutdown Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  58 Service Maintenance Interval Warning Event 
Response Configuration Svc Tool 0 0 3 N/A BitMask†

  59 High Starting Air Pressure Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  60 High Starting Air Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  61 Low Starting Air Pressure Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  62 Low Starting Air Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  63 High Gas Pressure Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  64 High Gas Pressure Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  65 Low Gas Pressure Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  66 Low Gas Pressure Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  67 Engine Inlet Manifold Charge Combustion Event 
Response Configuration Lvl 3 0 0 511 N/A BitMask†

11 1 High Generator Bearing #1 Temperature Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  2 High Generator Bearing #1 Temperature Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  3 Low Generator Bearing #1 Temperature Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  4 Low Generator Bearing #1 Temperature Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  5 Generator Over Current (Amp) Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  6 Generator Over Current (Amp) Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  7 Generator Over Frequency Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  8 Generator Over Frequency Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  9 Generator Under Frequency Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  10 Generator Under Frequency Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  11 Generator Reverse Power Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  12 Generator Reverse Power Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask† 

  13 Generator Over Voltage Warning Event Response 
Configuration Lvl 2 0 0 99 N/A BitMask†

  14 Generator Over Voltage Shutdown Event Response 
Configuration Lvl 2 0 0 110 N/A BitMask†

  15 Generator Under Voltage Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  16 Generator Under Voltage Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  17 Earth Fault Event Response Configuration Lvl 2 0 0 111 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

  18 High Generator Winding #1 Temperature Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  19 High Generator Winding #1 Temperature Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  20 High Generator Winding #2 Temperature Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  21 High Generator Winding #2 Temperature Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

  22 High Generator Winding #3 Temperature Warning 
Event Response Configuration Lvl 2 0 0 227 N/A BitMask†

  23 High Generator Winding #3 Temperature Shutdown 
Event Response Configuration Lvl 2 0 0 238 N/A BitMask†

12 1 High Ambient Air Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  2 High Ambient Air Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  3 Low Ambient Air Temperature Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  4 Low Ambient Air Temperature Shutdown Event 
Response Configuration Lvl 2 0 0 238 N/A BitMask†

  5 Automatic Transfer Switch in Normal Position Event 
Response Configuration Lvl 2 0 0 259 N/A BitMask†

  6 Automatic Transfer Switch in Emergency Position 
Event Response Configuration Lvl 2 0 0 259 N/A BitMask†

  7 High Battery Voltage Warning Event Response 
Configuration Lvl 1 0 0 99 N/A BitMask†

  8 High Battery Voltage Shutdown Event Response 
Configuration Lvl 1 0 0 110 N/A BitMask†

  9 Low Battery Voltage Warning Event Response 
Configuration Lvl 1 0 0 227 N/A BitMask†

  10 Low Battery Charging System Voltage Warning 
Event Response Configuration Lvl 1 0 0 227 N/A BitMask†

  11 Generator Breaker Failure to Open Event 
Response Configuration Lvl 3 0 0 111 N/A BitMask†

  12 Generator Breaker Failure to Close Event 
Response Configuration Lvl 3 0 0 111 N/A BitMask†

  13 Generator Breaker Open Event Response 
Configuration Lvl 1 0 0 259 N/A BitMask†

  14 Generator Breaker Closed Event Response 
Configuration Lvl 1 0 0 259 N/A BitMask†

  15 Utility Breaker Failure to Open Event Response 
Configuration Lvl 3 0 0 111 N/A BitMask†

  16 Utility Breaker Failure to Close Event Response 
Configuration Lvl 3 0 0 115 N/A BitMask†

  17 Utility Breaker Open Event Response Configuration Lvl 1 0 0 259 N/A BitMask†

  18 Utility Breaker Closed Event Response 
Configuration Lvl 1 0 0 259 N/A BitMask†

  19 Emergency Shutdown Override Mode Active 
Warning Event Response Configuration Lvl 2 0 1 3 N/A BitMask†

  20 Engine in Cooldown Event Response Configuration Lvl 1 0 0 259 N/A BitMask† 

  21 Engine Speed-Generator Output Frequency 
Mismatch Warning Event Response Configuration Lvl 2 0 0 99 N/A BitMask†

  22 High Fire Extinguisher Pressure Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  23 High Fire Extinguisher Pressure Shutdown Event 
Response Configuration Lvl 2 0 0 110 N/A BitMask†

  24 Low Fire Extinguisher Pressure Warning Event 
Response Configuration Lvl 2 0 0 227 N/A BitMask†

  25 Low Fire Extinguisher Pressure Shutdown Event Lvl 2 0 0 238 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

Response Configuration 

  26 Generator Control Not in Automatic Warning Event 
Response Configuration Lvl 1 0 0 259 N/A BitMask†

  27 Loss of Utility Event Response Configuration Lvl 1 0 0 371 N/A BitMask†

  28 Utility to Generator Transfer Failure Warning Event 
Response Configuration Lvl 2 0 0 99 N/A BitMask†

  29 Utility to Generator Transfer Failure Shutdown 
Event Response Configuration Lvl 2 0 0 110 N/A BitMask†

  30 Generator to Utility Transfer Failure Warning Event 
Response Configuration Lvl 2 0 0 115 N/A BitMask†

  31 Generator Breaker Locked Out Warning Event 
Response Configuration Lvl 2 0 0 367 N/A BitMask†

  32 Utility Breaker Locked Out Warning Event 
Response Configuration Lvl 2 0 0 371 N/A BitMask†

  33 Earth Leakage Event Response Configuration Lvl 2 0 0 111 N/A BitMask†

  34 Custom Event #1 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  35 Custom Event #1 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  36 Custom Event #1 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  37 Custom Event #1 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  38 Custom Event #1 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  39 Custom Event #2 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  40 Custom Event #2 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  41 Custom Event #2 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  42 Custom Event #2 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  43 Custom Event #2 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  44 Custom Event #3 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  45 Custom Event #3 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  46 Custom Event #3 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  47 Custom Event #3 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  48 Custom Event #3 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  49 Custom Event #4 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  50 Custom Event #4 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  51 Custom Event #4 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  52 Custom Event #4 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask† 

  53 Custom Event #4 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  54 Custom Event #5 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  55 Custom Event #5 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  56 Custom Event #5 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  57 Custom Event #5 Low Shutdown Event Response Lvl 2 0 0 238 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

Configuration 
  58 Custom Event #5 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  59 Custom Event #6 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  60 Custom Event #6 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  61 Custom Event #6 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  62 Custom Event #6 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  63 Custom Event #6 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  64 Custom Event #7 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  65 Custom Event #7 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  66 Custom Event #7 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  67 Custom Event #7 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  68 Custom Event #7 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  69 Custom Event #8 High Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  70 Custom Event #8 High Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  71 Custom Event #8 Low Warning Event Response 
Configuration Lvl 2 0 0 227 N/A BitMask†

  72 Custom Event #8 Low Shutdown Event Response 
Configuration Lvl 2 0 0 238 N/A BitMask†

  73 Custom Event #8 Event Response Configuration Lvl 2 0 0 511 N/A BitMask†

  122 Utility Breaker System Fault Event Response 
Configuration Lvl 2 0 0 115 N/A BitMask†

  123 EPS Supplying Load Event Response Configuration Lvl 2 0 0 259 N/A BitMask†

17 1 Accessory Data Link Diagnostic Response 
Configuration Svc Tool 0 0 111 N/A BitMask†

  2 Air Filter Differential Pressure Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  3 Ambient Air Temperature Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  4 Digital Output #1 Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  5 Digital Output #2 Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  6 Engine Coolant Level Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  7 Engine Coolant Temperature Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  8 Engine Oil Level Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask† 

  9 Engine Oil Pressure Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  10 Engine Oil Temperature Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  11 Engine Speed Sensor Diagnostic Response 
Configuration Lvl 2 0 8 106 N/A BitMask†

  12 Exhaust Temperature Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  13 Right Exhaust Temperature Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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SETPOINT INFORMATION FOR SETPOINT CONFIGURATION 

BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

  14 Left Exhaust Temperature Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  15 Fire Extinguisher Pressure Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  16 Fuel Filter Differential Pressure Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  17 Fuel Level Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  18 External Tank Fuel Level Sensor Diagnostic 
Response Configuration Lvl 2 0 0 111 N/A BitMask†

  19 Generator Bearing #1 Temperature Sensor 
Diagnostic Response Configuration Lvl 2 0 0 111 N/A BitMask†

  20 Generator Output Sensing System Diagnostic 
Response Configuration Svc Tool 0 0 111 N/A BitMask†

  21 Engine Oil Filter Differential Pressure Sensor 
Diagnostic Response Configuration Lvl 2 0 0 111 N/A BitMask†

  22 Primary Data Link Diagnostic Response 
Configuration Lvl 3 0 0 111 N/A BitMask†

  23 SCADA Data Link Diagnostic Response 
Configuration Lvl 2 0 0 239 N/A BitMask†

  24 Starting Air Pressure Sensor Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  25 Battery Charger Failure Diagnostic Response 
Configuration Lvl 2 0 0 259 N/A BitMask†

  26 Multiple Genset Control Data Link Communication 
Failure Diagnostic Response Configuration Lvl 2 0 1 363 N/A BitMask†

  27 Multiple Genset Control Data Link Configuration 
Error Diagnostic Response Configuration Lvl 2 0 1 363 N/A BitMask†

  28 Control is Offline Multiple Genset Control Data Link 
Diagnostic Response Configuration Lvl 2 0 1 259 N/A BitMask† 

  29 Digital Output #3 Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  30 Digital Output #4 Diagnostic Response 
Configuration Lvl 2 0 0 111 N/A BitMask†

  31 Engine Controller Not Responding Diagnostic 
Response Configuration Lvl 3 0 0 111 N/A BitMask†

18 1 Engine Start Fault Protection Activation Delay Time Lvl 2 4 0 300 1 seconds 
  2 Crank Duration Lvl 2 4 5 300 1 seconds 
  3 Crank Cycle Rest Interval Lvl 2 4 5 300 1 seconds 
  4 Engine Purge Cycle Time Lvl 2 4 0 20 1 seconds 
  5 Maximum Number of Crank Cycles Lvl 2 0 1 20 1 N/A 
  6 Cooldown Duration Lvl 2 12 0 30 1 minutes 
  7 Start Aid Activation Time Lvl 2 4 0 240 1 seconds 
  8 Crank Alert Activation Time Lvl 1 4 0 60 1 seconds 
  9 Crank Terminate RPM Lvl 3 12 100 1000 1 rpm 
  10 Engine Fuel Type Configuration Svc Tool 0 Setpoint Value List 
  11 Fuel Shutoff Solenoid Type Configuration Svc Tool 0 Setpoint Value List 
  12 Engine Type Configuration Svc Tool 0 Setpoint Value List 

  13 Engine Controller J1939 Data Link Support 
Configuration Svc Tool 0 Setpoint Value List 

  14 Engine Cooldown Speed Configuration Lvl 2 0 Setpoint Value List 
  15 Engine Operating State Input Configuration Svc Tool 0 Setpoint Value List 
  16 Engine Idle Operation Enable Status Svc Tool 0 Setpoint Value List 
  17 Engine Fuel Priming Feature Enable Status Svc Tool 0 Setpoint Value List 

19 1 Generator Connection Configuration Lvl 3 0 Setpoint Value List 

  2 Generator Potential Transformer Primary Winding 
Rating Lvl 3 12 1 50000 1 V 

                                                 
† See APPENDIX F  Bitmask Value Lists, on how to set the setpoint value. 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

  3 Generator Potential Transformer Secondary 
Winding Rating Lvl 3 12 1 240 1 V 

  4 Generator Current Transformer Primary Winding 
Rating Lvl 3 12 1 7000 1 A 

  5 Generator Current Transformer Secondary Winding 
Rating Lvl 3 12 1 5 4 A 

  6 Number of Generator Poles Svc Tool 0 0 200 2 N/A 
  7 Generator Rated Frequency Lvl 3 0 Setpoint Value List 
  8 Generator Rated Voltage Lvl 2 12 100 50000 1 V 
  9 Generator Rated Power Lvl 3 12 1 50000 1 kW 
  10 Generator Rated Apparent Power Lvl 3 12 1 50000 1 kVA 

21 1 Generator Over Voltage Warning Event Percentage 
Threshold Lvl 2 16 100 125 1 % 

  2 Generator Over Voltage Warning Event Notification 
Delay Time Lvl 2 4 0 120 1 seconds 

  3 Generator Over Voltage Shutdown Event 
Percentage Threshold Lvl 2 16 100 125 1 % 

  4 Generator Over Voltage Shutdown Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

  5 Generator Under Voltage Warning Event 
Percentage Threshold Lvl 2 16 60 100 1 % 

  6 Generator Under Voltage Warning Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

  7 Generator Under Voltage Shutdown Event 
Threshold Lvl 2 16 60 100 1 % 

  8 Generator Under Voltage Shutdown Event 
Notification Delay Time Lvl 2 4 0 120 N/A seconds 

22 1 Generator Over Frequency Warning Event 
Percentage Threshold Lvl 2 16 80 120 0.1 % 

  2 Generator Over Frequency Warning Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

  3 Generator Over Frequency Shutdown Event 
Percentage Threshold Lvl 2 16 80.0 120.0 0.1 % 

  4 Generator Over Frequency Shutdown Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

  5 Generator Under Frequency Warning Event 
Percentage Threshold Lvl 2 16 80.0 120.0 0.1 % 

  6 Generator Under Frequency Warning Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

  7 Generator Under Frequency Shutdown Event 
Percentage Threshold Lvl 2 16 80.0 120.0 0.1 % 

  8 Generator Under Frequency Shutdown Event 
Notification Delay Time Lvl 2 4 0 120 1 seconds 

23 1 Generator Definite Time Over Current (Amp) 
Warning Event Percentage Threshold Lvl 2 16 80 130 1 % 

  2 Generator Inverse Time Over Current (Amp) 
Shutdown Event Time Multiplier Lvl 2 16 0.05 10.00 0.01 seconds 

  3 Generator Definite Time Over Current (Amp) 
Shutdown Event Percentage Threshold Lvl 2 16 100 300 1 % 

  4 Generator Definite Time Over Current (Amp) 
Shutdown Event Notification Delay Time Lvl 2 4 0.1 20.0 0.1 seconds 

24 1 Generator Reverse Power Warning Event 
Percentage Threshold Lvl 2 16 1 20 1 % 

  2 Generator Reverse Power Warning Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

  3 Generator Reverse Power Shutdown Event 
Percentage Threshold Lvl 2 16 1 20 1 % 

  4 Generator Reverse Power Shutdown Event 
Notification Delay Time Lvl 2 4 0 30 1 seconds 

26 1 Programmable Trip Point Function #1 Trigger 
Condition Lvl 2 0 Setpoint Value List 
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BLK # SP # SETPOINT NAME SECURITY 
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  2 Programmable Trip Point Function #1 Percentage 
Threshold Lvl 2 16 -100 100 1 % 

  3 Programmable Trip Point Function #1 Hysteresis 
Percentage Lvl 2 16 0 100 1 % 

  4 Programmable Trip Point Function #1 Trip 
Activation Delay Time Lvl 2 4 0 120 1 seconds 

  5 Programmable Trip Point Function #1 Trip 
Deactivation Delay Time Lvl 2 4 0 120 1 seconds 

34 1 Utility Breaker Closing Pulse Active Time Lvl 3 4 0.1 10 0.1 seconds 
  2 Utility Breaker Closing Pulse Rest Interval Lvl 3 4 0 60 1 seconds 
  3 Utility Breaker Maximum Closing Time Lvl 3 4 1 120 1 seconds 
  4 Utility Breaker Maximum Opening Time Lvl 3 4 1 20 1 seconds 
  5 Utility Breaker Lockout Configuration Lvl 2 0 Setpoint Value List 
  6 Utility Breaker Type Configuration Lvl 3 0 Setpoint Value List 

  7 Automatic Utility Breaker Control Source 
Configuration Lvl 3 0 Setpoint Value List 

35 1 Generator Breaker Closing Pulse Active Time Lvl 3 4 0.1 10 0.1 seconds 
  2 Generator Breaker Closing Pulse Rest Interval Lvl 3 4 0 60 1 seconds 
  3 Generator Breaker Maximum Closing Time Lvl 3 4 1 120 1 seconds 
  4 Generator Breaker Maximum Opening Time Lvl 3 4 1 20 1 seconds 
  5 Generator Breaker Lockout Configuration Lvl 2 0 Setpoint Value List 
  6 Generator Breaker Type Configuration Lvl 3 0 Setpoint Value List 

  7 Automatic Generator Breaker Control Source 
Configuration Lvl 3 0 Setpoint Value List 

53 1 Digital Input #NN Active State Configuration Lvl 2 0 Setpoint Value List 
56 1 Relay Output #N Active State Configuration read-only 0 Setpoint Value List 

72 1 Event Warning Condition Response Auto Reset 
Enable Status Svc Tool 0 Setpoint Value List 

  2 Event Audible Alert Response Auto Reset Enable 
Status Svc Tool 0 Setpoint Value List 

  3 Event Loss of Utility Response Auto Reset Enable 
Status Svc Tool 0 Setpoint Value List 

  4 Event Breaker #1 Trip Response Auto Reset 
Enable Status Svc Tool 0 Setpoint Value List 

  5 Event Breaker #2 Trip Response Auto Reset 
Enable Status Svc Tool 0 Setpoint Value List 

75 1 Electronic Control Module Reduced Power Mode 
Enable Status Lvl 3 0 Setpoint Value List 

  2 Electronic Control Module Reduced Power Mode 
Delay Time Lvl 2 4 1 120 1 minutes 

88 1 Digital Output #N Active State Configuration Lvl 2 0 Setpoint Value List 
94 1 SCADA Data Link Baud Rate Lvl 2 0 Setpoint Value List 
  2 SCADA Data Link Parity Lvl 2 0 Setpoint Value List 
  3 SCADA Data Link Slave Address Lvl 2 0 1 247 1 N/A 
  4 SCADA Data Link Access Password Lvl 2 0 0 0xffffffff 1 N/A 
  5 SCADA Data Link Connection Timeout Interval Lvl 2 4 0.1 3600.0 0.1 seconds 
  6 RS-485 Bias Resistor Enable Status Lvl 2 0 Setpoint Value List 

96 1 Engine Cylinder Temperature Sensor Installation 
Status Lvl 2 0 Setpoint Value List 

  2 Number of Engine Cylinders Lvl 2 0 1 20 1 N/A 
97 1 Event Output Function #1 Trigger Condition Lvl 2 0 Setpoint Value List 

  2 Event Output Function #1 Suspect Parameter 
Number Lvl 2 0 Setpoint Value List 

98 1 Customer Password Security Level to Reset 
Generator Energy Meters Lvl 3 0 0 3 1 N/A 

100 1 Service Maintenance Interval Hours Svc Tool 0 0 2000 1 hours 
  2 Service Maintenance Interval Days Svc Tool 0 0 365 1 days 

  3 Customer Password Security Level to Reset 
Service Maintenance Interval Lvl 3 0 0 4 1 N/A 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-

LUTION UNITS 

102 1 Maximum Engine Speed Bias Lvl 2 12 0 400 1 rpm 
  2 Generator Nominal Output Frequency Lvl 2 12 40 500 0.1 Hz 

104 1 Digital Selector #NN Source Configuration Lvl 2 0 Setpoint Value List 

105 1 Event Input Function #NN Active State 
Configuration Lvl 2 0 Setpoint Value List 

  2 Event Input Function #NN Event Notification Delay 
Time Lvl 2 4 0 250 1 seconds 

  3 Event Input Function #NN Suspect Parameter 
Number Lvl 2 0 Setpoint Value List 

  4 Event Input Function #NN Failure Mode Identifier Lvl 2 0 Setpoint Value List 
106 1 Spare Analog Input Enable Status Lvl 2 0 Setpoint Value List 

  2 Spare Analog Input Type Configuration read-only 0 Setpoint Value List 
  3 Spare Analog Input Suspect Parameter Number Lvl 2 0 Setpoint Value List 

  4 Spare Analog Input High Percentage Warning 
Event Threshold Lvl 2 16 0 100 1 % 

  5 Spare Analog Input High Temperature Warning 
Event Threshold Lvl 2 12 -273 1735 1 deg. C 

  6 Spare Analog Input High Pressure Warning Event 
Threshold Lvl 2 12 -250 10000 1 kPa 

  7 Spare Analog Input  High Warning Event 
Notification Delay Time Lvl 2 4 0 60 1 seconds 

  8 Spare Analog Input High Percentage Shutdown 
Event Threshold Lvl 2 16 0 100 1 % 

  9 Spare Analog Input High Temperature Shutdown 
Event Threshold Lvl 2 12 -273 1735 1 deg. C 

  10 Spare Analog Input High Pressure Shutdown Event 
Threshold Lvl 2 12 -250 10000 1 kPa 

  11 Spare Analog Input High Shutdown Event 
Notification Delay Time Lvl 2 4 0 60 1 seconds 

  12 Spare Analog Input Low Percentage Warning Event 
Threshold Lvl 2 16 0 100 1 % 

  13 Spare Analog Input Low Temperature Warning 
Event Threshold Lvl 2 12 -273 1735 1 deg. C 

  14 Spare Analog Input Low Pressure Warning Event 
Threshold Lvl 2 12 -250 10000 1 kPa 

  15 Spare Analog Input Low Warning Event Notification 
Delay Time Lvl 2 4 0 60 1 seconds 

  16 Spare Analog Input Low Percentage Shutdown 
Event Threshold Lvl 2 16 0 100 1 % 

  17 Spare Analog Input Low Temperature Shutdown 
Event Threshold Lvl 2 12 -273 1735 1 deg. C 

  18 Spare Analog Input Low Pressure Shutdown Event 
Threshold Lvl 2 12 -250 10000 1 kPa 

  19 Spare Analog Input Low Shutdown Event 
Notification Delay Time Lvl 2 4 0 60 1 seconds 

  20 Spare Analog Input Map Selection Number Lvl 3 0 1 10 1 N/A 
107 1 Generator/Utility Automatic Transfer Enable Status Lvl 1 0 Setpoint Value List 

  2 Loss of Utility Event Notification Delay Time Lvl 2 4 0 60 0.1 seconds 
  3 Utility to Generator Transfer Delay Time Lvl 1 4 0 60 0.1 seconds 
  4 Generator to Utility Transfer Delay Time Lvl 1 4 30 3600 1 seconds 
  5 Generator to Utility Fast Transfer Delay Time Lvl 1 4 0 60 1 seconds 

  6 Utility to Generator Transfer Failure Warning Event 
Threshold Lvl 2 4 1 240 1 seconds 

  7 Utility to Generator Transfer Failure Shutdown 
Event Threshold Lvl 2 4 1 240 1 seconds 

  8 Generator to Utility Transfer Failure Warning Event 
Threshold Lvl 2 4 1 240 1 seconds 

  9 Generator/Utility Automatic Transfer Minimum Un-
powered Load Time Lvl 2 4 0 30 1 seconds 

  10 Generator Ready to Accept Load Threshold Lvl 2 16 60 100 1 % 
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BLK # SP # SETPOINT NAME SECURITY 
LEVEL SCALE MIN MAX RESO-
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Percentage 
  11 Generator Ready to Accept Load Delay Time Lvl 2 4 0 60 0.1 seconds 
  12 Generator to Utility Transfer Mode Lvl 2 0 Setpoint Value List 

108 1 Maximum Generator Voltage Output Bias 
Percentage Lvl 2 16 0 100 1 % 

  2 Generator Nominal Output Voltage Lvl 2 12 100 50000 1 V 

109 1 Generator Winding Temperature Sensor Installation 
Status Lvl 2 0 Setpoint Value List 

  2 Generator Bearing Temperature Sensor Installation 
Configuration Lvl 2 0 Setpoint Value List 
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APPENDIX E    SETPOINT VALUE LISTS 
 

Some setpoints in APPENDIX C refer to Setpoint Value Lists.  Those setpoints are programmed 
with integer values with each integer having a specific definition.  These integer values and 
representations are given here. 

 

TABLE 27: SETPOINT VALUE LISTS 

SETPOINT VALUE LISTS 
BLK # SP # SETPOINT NAME VALUE DEFINITION 

1 1 0 Sensor 
    

Engine Oil Pressure Sensor Configuration 
1 Data Link 

2 4 0 Inactive 
    

Programmable Cycle Timer #1 Output #1 Activation 
Configuration 1 Active 

  5 0 Inactive 
    

Programmable Cycle Timer #1 Output #2 Activation 
Configuration 1 Active 

4 1 0 Sensor 
    

Engine Coolant Temperature Sensor Configuration 
1 Data Link 

6 7 0 Sensor 
    

Engine Speed Sensor Configuration 
1 Data Link 

18 10 0 Diesel 
    

Engine Fuel Type Configuration 
1 Natural Gas 

  11 0 Energized to Run 
    

Fuel Shutoff Solenoid Type Configuration 
1 Energized to Stop 

  12 0 Mechanical 
    

Engine Type Configuration 
1 Electronic 

  13 0 No J1939 Support 
    1 Basic J1939 Support 
    

Engine Controller J1939 Data Link Support Configuration 

2 Enhanced J1939 Support 
  14 0 Rated Speed 
    

Engine Cooldown Speed Configuration 
1 Low Idle 

  15 0 Hard Wired Input 
    

Engine Operating State Input Configuration 
1 CAN Input 

  17 0 Disabled 
    

Engine Fuel Priming Feature Enable Status 
1 Enabled 

19 1 0 Wye (or Star) 
    1 Delta (3-Wire) 
    2 Delta (4-Wire) 
    3 Single Phase (2-Wire) 
    

Generator Connection Configuration 

4 Single Phase (3-Wire) 
  7 0 50 Hz 
    1 60 Hz 
    

Generator Rated Frequency 

2 400 Hz 
26 1 0 Disabled 
    1 Trip Above Threshold 
    

Programmable Trip Point Function #NN Trigger Condition 

2 Trip Below Threshold 
34 5 0 Not Locked Out 
    

Utility Breaker Lockout Configuration 
1 Locked Out 

  6 0 Not Installed 
    1 Manual 
    

Utility Breaker Type Configuration 

2 Automatic 
  7 0 Genset Controlled 
    

Automatic Utility Breaker Control Source Configuration 
1 Externally Controlled 

35 5 Generator Breaker Lockout Configuration 0 Not Locked Out 
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    1 Locked Out 
  6 0 Manual 
    

Generator Breaker Type Configuration 
1 Automatic 

  7 0 Genset Controlled 
    

Automatic Generator Breaker Control Source 
Configuration 1 Externally Controlled 

53 1 0 Low 
    

Digital Input #NN Active State Configuration 
1 High 

56 1 0 Low 
    

Relay Output #N Active State Configuration 
1 High 

72 1 713 Custom Event #13 
    

Event Warning Condition Response Auto Reset Enable 
Status 714 Custom Event #14 

  2 715 Custom Event #15 
    

Event Audible Alert Response Auto Reset Enable Status 
716 Custom Event #16 

  3 0 Disabled 
    

Event Loss of Utility Response Auto Reset Enable Status 
1 Enabled 

  4 0 Disabled 
    

Event Breaker #1 Trip Response Auto Reset Enable 
Status 1 Enabled 

  5 0 Disabled 
    

Event Breaker #2 Trip Response Auto Reset Enable 
Status 1 Enabled 

75 1 0 Disabled 
    

Electronic Control Module Reduced Power Mode Enable 
Status 1 Enabled 

88 1 0 Low 
    

Digital Output #N Active State Configuration 
1 High 

94 1 0 2400 baud 
    1 4800 baud 
    2 9600 baud 
    3 14400 baud 
    4 19200 baud 
    5 28800 baud 
    6 38400 baud 
    7 57600 baud 
    

SCADA Data Link Baud Rate 

8 115200 baud 
  2 0 None 
    1 Odd 
    

SCADA Data Link Parity 

2 Even 
  6 0 Disabled 
    

RS-485 Bias Resistor Enable Status 
1 Enabled 

96 1 0 Not Installed 
    

Engine Cylinder Temperature Sensor Installation Status 
1 Installed 

97 1 0 High Shutdown 
    0 Disabled 
    1 Low Shutdown 
    17 Low Warning 
    31 Status 

    8320 General Event - High or Low 
Warning 

    8352 General Event - High or Low 
Shutdown 

    8448
General Event - High or Low 
Warning or High or Low 
Shutdown 

    8480
General Event - High or Low 
Warning or High or Low 
Shutdown or Diagnostic 

    8512 General Diagnostic 
    16384 Specific Event - Low Warning 
    16416 Specific Event - Low Shutdown 
    

Event Output Function #NN Trigger Condition 

16448 Specific Event - High Warning 
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    16480 Specific Event - High Shutdown 

    16512 Specific Event - High or Low 
Warning 

    16544 Specific Event - High or Low 
Shutdown 

    16576 Specific Event - Low Warning or 
Low Shutdown 

    16608 Specific Event - High Warning or 
High Shutdown 

    16640
Specific Event - High or Low 
Warning or High or Low 
Shutdown 

    16672
Specific Event - High or Low 
Warning or High or Low 
Shutdown or Diagnostic 

    16738 Specific Diagnostic - Data Erratic, 
Intermittent, or Incorrect 

    16739
Specific Diagnostic - Voltage 
Above Normal, or Shorted to High 
Source 

    16740
Specific Diagnostic - Voltage 
Below Normal, or Shorted to Low 
Source 

    16741 Specific Diagnostic - Current 
Below Normal or Open Circuit 

    16742
Specific Diagnostic - Current 
Above Normal or Grounded 
Circuit 

    16743
Specific Diagnostic - Mechanical 
System Not Responding or Out of 
Adjustment 

    16744
Specific Diagnostic - Abnormal 
Frequency or Pulse Width or 
Period 

    16745 Specific Diagnostic - Abnormal 
Update Rate 

    16746 Specific Diagnostic - Abnormal 
Rate of Change 

    16747 Specific Diagnostic - Root Cause 
Not Known 

    16768 Specific Event - Condition Exists 
  2 38 External Tank Fuel Level 
    82 Starting Air Pressure 
    95 Fuel Filter Differential Pressure 
    96 Fuel Level 
    98 Engine Oil Level 

    99 Engine Oil Filter Differential 
Pressure 

    100 Engine Oil Pressure 
    107 Air Filter Differential Pressure 
    110 Engine Coolant Temperature 
    111 Engine Coolant Level 
    137 Fire Extinguisher Pressure 
    167 Battery Charging System Voltage 
    168 Battery Voltage 
    171 Ambient Air Temperature 
    173 Exhaust Temperature 
    175 Engine Oil Temperature 
    190 Engine Speed 
    625 SCADA Data Link 
    

Event Output Function #NN Suspect Parameter Number 

639 Primary Data Link 
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    701 Custom Event #1 
    702 Custom Event #2 
    703 Custom Event #3 
    704 Custom Event #4 
    705 Custom Event #5 
    706 Custom Event #6 
    707 Custom Event #7 
    708 Custom Event #8 
    709 Custom Event #9 
    710 Custom Event #10 
    711 Custom Event #11 
    712 Custom Event #12 
    924 Digital Output #1 
    925 Digital Output #2 
    926 Digital Output #3 
    970 Auxiliary Engine Shutdown Switch

    1122 Generator Rear Bearing 
Temperature 

    1124 Generator Winding #1 
Temperature 

    1125 Generator Winding #2 
Temperature 

    1126 Generator Winding #3 
Temperature 

    1231 Accessory Data Link 

    1237 Emergency Shutdown Override 
Switch 

    1239 Fuel Leak 
    1383 Unexpected Engine Shutdown 
    1390 Gas Pressure 
    1664 Engine Failure to Start 
    2433 Right Exhaust Temperature 
    2434 Left Exhaust Temperature 
    2436 Generator Output Frequency 
    2440 Generator Output Voltage 
    2448 Generator Current (Amp) 
    2452 Generator Output Power 
    2646 Digital Output #4 
    2648 Maintenance Lamp 
    3543 Engine Controller 
    4000 Air Damper Closed 
    4001 ATS in Normal Position 
    4002 ATS in Emergency Position 
    4003 Battery Charger Failiure 
    4004 Generator Circuit Breaker Closed 
    4005 Utility Breaker Closed 
    4006 Engine in Cooldown 

    4007 Generator Control Not in 
Automatic 

    4009 Generator Circuit Breaker Failure 
to Open 

    4010 Utility Breaker Failure to Open 

    4011 Generator Circuit Breaker Failure 
to Close 

    4012 Utility Breaker Failure to Close 
    4013 Generator Circuit Breaker Open 
    4014 Utility Breaker Open 

    4015 Utility to Generator Transfer 
Failure 
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SETPOINT VALUE LISTS 
BLK # SP # SETPOINT NAME VALUE DEFINITION 

    4016 Generator to Utility Transfer 
Failure 

    4017 Loss of Utility 

    4018 Generator Circuit Breaker Locked 
Out 

    4019 Utility Breaker Locked Out 
    4028 Earth Fault 
    4029 Earth Leakage 

    16748 Specific Diagnostic - Bad 
Intelligent Device or Component 

    16749 Specific Diagnostic - Out of 
Calibration 

    16750 Specific Diagnostic - Special 
Instructions 

    16755 Specific Diagnostic - Received 
Network Data In Error 

104 1 0 Disabled 
    1 Use Input #1 
    2 Use Input #2 
    3 Use Input #3 
    4 Use Input #4 
    5 Use Input #5 
    6 Use Input #6 
    7 Use Input #7 
    8 Use Input #8 
    9 Use Input #9 
    10 Use Input #10 
    

Digital Selector #NN Source Configuration 

11 Data Link 
105 1 0 Low 

    
Event Input Function #NN Active State Configuration 

1 High 
  3 38 External Tank Fuel Level 
    82 Starting Air Pressure 
    95 Fuel Filter Differential Pressure 
    96 Fuel Level 
    98 Engine Oil Level 

    99 Engine Oil Filter Differential 
Pressure 

    100 Engine Oil Pressure 
    107 Air Filter Differential Pressure 
    110 Engine Coolant Temperature 
    111 Engine Coolant Level 
    137 Fire Extinguisher Pressure 
    167 Battery Charging System Voltage 
    168 Battery Voltage 
    171 Ambient Air Temperature 
    173 Exhaust Temperature 
    175 Engine Oil Temperature 
    701 Custom Event (Instance #1) 
    702 Custom Event (Instance #2) 
    703 Custom Event (Instance #3) 
    704 Custom Event (Instance #4) 
    705 Custom Event (Instance #5) 
    706 Custom Event (Instance #6) 
    707 Custom Event (Instance #7) 
    708 Custom Event (Instance #8) 
    709 Custom Event (Instance #9) 
    710 Custom Event (Instance #10) 
    711 Custom Event (Instance #11) 
    

Event Input Function #NN Suspect Parameter Number 

712 Custom Event (Instance #12) 



244 

APPENDIX E  Setpoint Value Lists 

SETPOINT VALUE LISTS 
BLK # SP # SETPOINT NAME VALUE DEFINITION 

    1122 Generator Rear Bearing 
Temperature 

    1124 Generator Winding #1 
Temperature 

    1125 Generator Winding #2 
Temperature 

    1126 Generator Winding #3 
Temperature 

    1239 Fuel Leak 
    1390 Gas Pressure 
    2433 Right Exhaust Temperature 
    2434 Left Exhaust Temperature 
    2436 Generator Frequency 
    2440 Generator Voltage 
    2448 Generator Current 
    2452 Generator Power 

    3783 Engine Inlet Manifold Charge 
Combustion 

    3829 EPS Supplying Load 
    4000 Air Damper Closed 
    4001 ATS in Normal Position 
    4002 ATS in Emergency Position 
    4003 Battery Charger Failure 
    4004 Generator Circuit Breaker Closed 
    4005 Utility Circuit Breaker Closed 
    4013 Generator Circuit Breaker Open 
    4014 Utility Circuit Breaker Open 

    4015 Utility to Generator Transfer 
Failure 

    4016 Generator to Utility Transfer 
Failure 

    4017 Loss of Utility 
    4028 Earth Fault 
    4029 Earth Leakage 
  4 15 High Warning 
    713 Custom Event (Instance #13) 
    714 Custom Event (Instance #14) 
    715 Custom Event (Instance #15) 
    

Event Input Function #NN Failure Mode Identifier 

716 Custom Event (Instance #16) 
106 1 0 Disabled 

    
Spare Analog Input Enable Status 

1 Enabled 
  2 0 Pressure 
    1 Temperature 
    

Spare Analog Input Type Configuration 

2 Level 
  3 38 External Tank Fuel Level 
    82 Starting Air Pressure 
    95 Fuel Filter Differential Pressure 
    96 Fuel Level 
    98 Engine Oil Level 
    99 Oil Filter Differential Pressure 
    107 Air Filter Differential Pressure 
    111 Engine Coolant Level 
    137 Fire Extinguisher Pressure 
    171 Ambient Air Temperature 
    173 Exhaust Temperature 
    175 Engine Oil Temperature 

    

Spare Analog Input Suspect Parameter Number 

1122 Generator Rear Bearing 
Temperature 
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SETPOINT VALUE LISTS 
BLK # SP # SETPOINT NAME VALUE DEFINITION 

    2433 Right Exhaust Temperature 
    2434 Left Exhaust Temperature 

107 1 0 Disabled 
    

Generator/Utility Automatic Transfer Enable Status 
1 Enabled 

  12 0 Manual 
    

Generator to Utility Transfer Mode 
1 Automatic 

109 1 0 Not Installed 
    

Generator Winding Temperature Sensor Installation Status
1 Installed 

  2 0 Not Installed 
    1 Rear 
    

Generator Bearing Temperature Sensor Installation 
Configuration 

2 Front & Rear 
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APPENDIX F   BITMASK VALUE LISTS 
 

Some setpoints in APPENDIX C can take on multiple values simultaneously.  This is particularly 
true for event response configurations, where an event can trigger multiple responses, such as 
a shutdown as well as a breaker tripping.  In these cases, the setpoints are assigned bit-mask 
values, where different factors of two represent different optional responses.  This guarantees 
that every combination of possible event responses will have a unique value.  These possible 
values are given here. 

In order to decode a BitMask value, simply mask it with the value in question and compare it to 
zero, to determine whether the value is present in the setpoint.  For example, in APPENDIX D, 
Setpoint Information For Configuration, the setpoint Air Damper Closed Event Response 
Configuration setpoint shows units as BitMask.  It has a minimum of zero, meaning all of the 
responses shown here in Table 28 may be disabled.  It has a maximum of 266, which is 256 
(Active Only) + 8 (Hard Shutdown) + 2 (Audible Alert).  This means that the Air Damper Closed 
event can be configured to have these three responses. 

TABLE 28  BITMASK VALUE LISTS 

VALUE VALUE NAME 
1 Warning 
2 Audible Alert 
4 Soft Shutdown 
8 Hard Shutdown 
16 Utility Failure 
32 Breaker #1 Trip 
64 Breaker #2 Trip 

128 Fault Protection Timer Enabled 
256 Active Only 
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APPENDIX G   MENU STRUCTURES 
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APPENDIX H  EMCP 3 GSC WIRING DIAGRAMS 
 

 
FIGURE  APPENDIX H   EMCP 3.2 WIRING DIAGRAM 
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FIGURE  APPENDIX H   EMCP 3.2 WIRING DIAGRAM 
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FIGURE  APPENDIX H    EMCP 3.3 SCHEMATIC 
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APPENDIX I   EMCP 3 GSC  FRONT VIEW & NAVIGATION KEYS 
 

 
APPENDIX I  EMCP 3.3 FRONT PANEL VIEW 

Navigation Keys 

AC OVERVIEW 
The AC Overview Key (2) will navigate the display the first screen of AC 
information. The AC Overview Key information contains various AC 
parameters that summarize the electrical operation of the generator set. 

ENGINE 
OVERVIEW 

The Engine Overview Key (3) will navigate the display to the first screen of 
engine information. The Engine Overview information contains various 
engine parameters that summarize the operation of the generator set. 

ALARM 
ACKNOWLEDGE 
/ SILENCE 

Pressing the Alarm Acknowledge/Silence Key (6) will cause the horn relay 
output to turn off and silence the horn. Pressing the key will also cause any 
yellow or red flashing lights to turn off or to become solid depending on the 
active status of the alarms. The Alarm Acknowledge/Silence Key may also 
be configured to send out a global alarm silence on the J1939 Data Link 
which will silence horns on Annunciators. 
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(1) Display Screen  (9) Auto Key  
(2) AC Overview Key  (10) Stop Key  
(3) Engine Overview Key  (11) Scroll Up Key  
(4) Yellow Warning Lamp  (12) Escape Key 
(5) Red Shutdown Lamp  (13) Scroll Right Key  
(6) Alarm Acknowledge/Silence Key (14) Enter Key 
(7) Lamp Test Key  (15) Scroll Down Key 
(8) Run Key  (16) Scroll Left Key 
   

LAMP TEST 
Pressing and holding the Lamp Test Key (7) will cause all of the LED’s and 
the display screen pixels to turn on solid until the Key is released.  

RUN 
Pressing the RUN Key (8) will cause the engine to enter the RUN mode. 

AUTO 
Pressing the AUTO Key (9) will cause the engine to enter the AUTO mode. 

SCROLL UP 
The Scroll Up Key (11) is used to navigate up through the various menus or 
monitoring screens. The Scroll Up Key is also used during setpoint entry. 
During numeric data entry the Scroll Up Key is used in order to increment 
the digits (0-9). If the setpoint requires selection from a list, the Scroll Up 
Key is used to navigate through the list. 

ESCAPE 
The Escape Key (12) is used during menu navigation in order to navigate 
up through the menu/sub-menu structure. Each key press causes the user 
to move backwards/upwards through the navigation menus. The Escape 
Key is also used to cancel out of data entry screens during setpoint 
programming. If the Escape Key is pressed during setpoint programming, 
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none of the changes made on screen will be saved to memory. 

SCROLL RIGHT 
The Scroll Right Key (13) is used during setpoint adjustment. During 
numeric data entry, the Scroll Right Key is used to choose which digit is 
being edited. The Scroll Right Key is also used during certain setpoint 
adjustments to select or deselect a check box. If a box has a check mark 
inside the box, pressing the Scroll Right Key will cause the check mark to 
disappear, disabling the function. If the box does not have a check mark 
inside the box, pressing the Scroll Right Key will cause a check mark to 
appear, Enabling the function. 

ENTER 
The Enter Key (14) is used during menu navigation to select menu items in 
order to navigate forward/downward in the menu/sub-menu structure. The 
Enter Key is also used during setpoint programming in order to save 
setpoints changes. Pressing the Enter Key during setpoint programming 
causes setpoint changes to be saved to memory 

DOWN 
The Down Key (15) is used to navigate down through the various menus or 
monitoring screens. The Down Key is also used during setpoint entry. 
During numeric data entry the Down Key is used in order to decrement the 
digits (0-9). If the setpoint requires selection from a list, the Down Key is 
used to navigate down through the list. 

SCROLL LEFT 
The Scroll Left Key (16) is used during setpoint adjustment. During numeric 
data entry, the Scroll Left Key is used to choose which digit is being edited. 
The Scroll Left Key is also used during certain setpoint adjustments to 
select or deselect a check box. If a box has a check mark inside the box, 
pressing the Scroll Left Key will cause the check mark to disappear, 
disabling the function. If the box does not have a check mark inside the 
box, pressing the Scroll Left Key will cause a check mark to appear, 
enabling the function. 

ALARM INDICATORS 

YELLOW 
WARNING 
LIGHT 

A flashing yellow light indicates that there are unacknowledged active 
warnings. A solid yellow light indicates that there are acknowledged 
warnings active. If there are any active warnings, the yellow light will 
change from flashing yellow to solid yellow after the Alarm 
Acknowledge/Silence Key (6 )is pressed. If there are no longer any active 
warnings, the yellow light will turn off after the Alarm Acknowledge/Silence 
Key (6 ) is pressed. 

RED 
SHUTDOWN 
LIGHT 

A flashing red light indicates that there are unacknowledged active 
shutdown events. A solid red light indicates that there are acknowledged 
shutdown events active. If there are any active shutdown events the red 
light will change from flashing red to solid red after the Alarm 
Acknowledge/Silence Key (6 ) is pressed. Any condition that has caused a 
shutdown event must be manually reset. If there are no longer any active 
shutdown events, the red light will turn off. 
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Glossary of Terms 
 

CRC Cyclic Redundancy Check. This is an algorithm used to catch transmission 
errors.  The CRC is generated and transmitted at the source, then re-generated 
and compared at the target.  The EMCP 3 GSC performs a 16-bit CRC check, 
which is often called a CRC16 algorithm. 

EMCP 3 Electronic Modular Control Panel 3.  This is the new generation Caterpillar 
generator set control panel, consisting of a generator set control (GSC), and 
may have several other modules such as an engine electronic control module 
(ECM), voltage regulator module, and input/output modules. 

ECM Electronic Control Module.  This is a general term and can refer to any 
microprocessor-based module that is part of a control system.  The engine 
ECM is an ECM dedicated to the task of engine timing and air/fuel control. 

FID Fault Identifier. This is a term for a range of data that represents an application-
level fault.  For example, this may communicate that the requested operation is 
not currently applicable, or that a value requested is out of range. 

FMI Failure Mode Indicator. The J1939 term for a failure code associated with a 
particular Suspect Parameter Number. For a complete list of FMI codes, refer to 
the Systems Operation Troubleshooting Testing and Adjusting guide. 

GSC Generator Set Controller.  This is the module responsible for the overall 
generator protection and control functions.  It is the master module on the 
generator set, interfacing with the user as well as the engine ECM and any 
other accessory modules. 

J1939 A communication protocol with widespread use in the transportation and power 
generation industry.  The EMCP 3.1 supports a J1939 data link, termed the 
Primary Data Link.  The EMCP 3.2 and 3.3 support the Primary Data Link, and 
a second J1939 data link, termed the Accessory Data Link. 

NULL 
CHARACTER 

The name for the ASCII character represented by $00 (1 byte of binary zeroes).  
This character is commonly used to mark the termination of an ASCII string. 

RMS A mathematical approach of representing a useful average for varying 
quantities; this is useful to indicate AC quantities. 

RS-232 RETMA Standard 232, maintained by the Electronics Industries Alliance (EIA).  
Also known as EIA-232. 

RS-485 RETMA Standard 485, maintained by the Electronics Industries Alliance (EIA).  
Also known as EIA-485. 

RTU Remote Transmitter Unit. This term refers to a Slave device in a MODBUS 
network, that merely responds to requests from the Master. The EMCP 3 GSC 
can function as an RTU on a SCADA system. 

SCADA Supervisory Control And Data Acquisition. This term represents any computing 
system designed to perform high-level control and monitoring over various 
subsystems.  On the EMCP 3 GSC, we provide a MODBUS interface to allow 
any SCADA systems to connect and collect data about the operations of the 
control and the generator set(s). 
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Glossary of Terms 
 

SPN Suspect Parameter Number. The J1939 term for any parameter whose data is 
transmitted over a J1939 network, such as the EMCP 3 GSC primary or 
accessory data link. For a complete list of SPNs supported by the EMCP 3 
GSC, refer to the Diagnostic Trouble Code List in the Systems Operation 
Troubleshooting Testing and Adjusting guide. 
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